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 Sample projects

 Limitations of the current version
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How to use this Help? 

TIPS

 If you do not see the Table of Contents on the left, enlarge the Help window 
or zoom out the characters (Ctrl+mouse wheel, or Ctrl+-).

 To search for two or more adjacent words, use quotes, for example “Action 
Unit”.

 To go back to the search results after visiting one of the result pages, click 
again on the magnifying glass icon in the Search field.
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An introduction to FaceReader
Six basic expressions

FaceReader is a program for facial expression analysis. It can detect emotional 
expressions in the face. It can identify six basic expressions: 

 Happy 

 Sad 

 Angry 

 Surprised 

 Scared 

 Disgusted 

 A Neutral state 

Contempt

In addition to the six basic expressions, FaceReader can detect contempt. Contempt 
is an expression in which one corner of the lips is tightened and slightly raised. 

Baby FaceReader

Baby FaceReader is a special version of FaceReader. It has been developed for 
babies and infants from 6-24 months old. Please note that Baby FaceReader 
analyzes Action Units, Valence and Arousal, it cannot detect the basic facial 
expressions. Baby FaceReader is based on the Baby FACS developed by Oster. 
Valence calculation in Baby FaceReader is based on Action Unit 6, 12 and 25 for 
positive valence. It takes the average intensity of these Action Units. Activity of 
Action Unit 1, 4, 7, 20, 25 and 43 results in a negative valence value.

Your Baby FaceReader license can be extended with the Vital Signs Module. Baby 
FaceReader cannot be combined with other modules. The Voice Analysis Module, 
the Advanced Research Module and the Consumption Behavior Module are not 
available with Baby FaceReader.

References

Messinger, D.S., Mahoor, M.H., Chow, S.M. & Cohn, J.F. (2009). Automated 
measurement of facial expression in infant-mother interaction: A pilot study. Infancy 
14(3): 285-305.

Oster, H. 2003. Baby FACS: Facial Action Coding System for Infants and Young 
Children. Unpublished monograph and coding manual. New York University.
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Oster, H. 2012. The repertoire of infant facial expressions: An ontogenetic 
perspective. DOI: 10.1093/acprof:oso/9780198528845.003.0010.

Rosenstein, D. & Oster, H. (1988). Differential facial responses to four basic tastes in 
newborns. Child development 59(6): 1555-1568.

Webb, R., Ayers, S. & Endress, A. (2018). The City Infant Faces Database: A validated 
set of infant facial expressions. Behavior Research Methods 50: 151-159.

Additional classifications

FaceReader can also analyze:

 Facial states — Left and right eye open or closed, mouth open or closed 
and eyebrows raised, neutral or lowered 

 Global gaze direction — The gaze direction of the eyes, to the left, left-up 
and left-down, to the right, right-up and right-down and straight forward, 
up and down. 

 Gaze Type — Fixation or saccade.

 Gaze angles — Horizontal and vertical gaze angle (in degrees).

 Gaze location — The participant’s gaze location on the screen/stimulus. 
This option is available with the Advanced Research Module. 

 Head orientation — The orientation of the head (pitch, yaw and roll, in 
degrees deviating from looking straight forward). 

 Head position — Horizontal, vertical and depth position relative to the 
camera.

 Valence — Which indicates whether the person’s emotional status is 
positive, negative or neutral.

 Arousal — Which indicates how active the person is. 

 Subject characteristics — The estimation of the test participant’s gender 
and age, and whether the person is wearing glasses or not. Subject 
characteristics are not available in Baby FaceReader.

 Action Units — FaceReader can analyze the 20 most common Action Units 
in the face. In addition, there are a number of Action Units available as 
Custom Expressions. FaceReader analyzes Action Units in the left and right 
part of the face. Action Units are available with the Action Unit Module. For 
Baby FaceReader you do not need the Action Unit Module as extra module. 
Action Unit analysis is an integral part of Baby FaceReader.

See The Action Unit Module
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 Custom expressions — FaceReader comes with a library of expressions like 
Interest, Attention, Confusion and Boredom. It is also possible to define 
your own Custom Expressions, based on Action Units, facial expressions, 
valence, arousal, and other parameters. Custom Expressions are available 
with the Action Unit Module. 

 Vital signs — This option is available with the Vital Signs Module. 
FaceReader can estimate the test participant’s heart rate and heart rate 
variability and respiratory (breathing) rate from the camera or video images 
of their face. 

See The Vital Signs Module 

 Expressions in the voice — This option is available with the Voice Analysis 
Module. FaceReader can detect Neutral, Happy, Sad and Angry in the 
participant’s voice.

 Consumption Behavior — This option is available with the Consumption 
Behavior Module. FaceReader can analyze chewing behavior and count the 
number of intake events (bites/sips). Consumption Behavior analysis is not 
available in Baby FaceReader.

See The Consumption Behavior Module

FaceReader and The Observer XT

FaceReader data can be imported into The Observer XT, the leading software 
package for the collection, analysis and presentation of observational data. This 
enables you to integrate FaceReader data with other data, such as manually logged 
events, physiological data and eye tracker data and to analyze the full context. For 
instance, what is the test participant watching on the screen and what emotion 
does that trigger. 

FaceReader can be used in a wide range of research areas:

 Psychology — How do people respond to particular stimuli, e.g. in 
cognitive research.

 Education — Observing students' facial expressions can support the 
development of educational tools.

 Human-computer interaction — Facial expressions can provide valuable 
information about user experience.

 Usability testing — Emotional expressions can indicate the ease of use and 
efficiency of user interfaces.

 Market research — How do people respond to a new commercial's design?

 Consumer behavior — How do participants in a sensory panel react to a 
new product?
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How does FaceReader work?
FaceReader classifies facial expressions in several steps which is explained in the 
figure below. Please see [1] - [3] and the references mentioned in the text below for 
more information. FaceReader 10 uses new methods that are different from the 
ones used in previous versions of the software. We recommend using the same 
FaceReader version within one project.

1. Face finding — The position of the face in an image is found using a deep 
learning based face finding algorithm [1], which searches for areas in the 
image having the appearance of a face.

2. Face modeling — FaceReader uses a facial modeling technique based on 
deep neural networks [2]. It synthesizes an artificial face model, which 
describes the location of almost 500 key points in the face. The predicted 
key points of such a model are learned from a database of annotated 
images. It is a single pass quick method to directly estimate the full 
collection of landmarks in the face. After the initial estimation, the key 
points are compressed using Principal Component Analysis. This leads to a 
highly compressed vector representation describing the state of the face.

3. Facial expression classification — Classification of the facial expressions is 
done by a trained deep artificial neural network to recognize patterns in the 
face [3]. FaceReader directly classifies the facial expressions from image 
pixels. Over 100,000 images of people faces from all over the world, that 
were manually annotated, were used to train the artificial neural network. 
The network was trained to classify the six basic or universal emotions 
described by Ekman [4]: happy, sad, angry, surprised, scared, disgusted and 
a neutral state. Additionally, the network was trained to classify the set of 
facial Action Units available in FaceReader, as well as to estimate other facial 
attributes such as age, gender, and the presence of glasses.

Validation

Facial expression analysis of FaceReader 10 is validated using the Amsterdam 
Dynamic Facial Expression Set (ADFES) [5] and the Warsaw Set of Emotional Facial 
Expression Pictures (WSEFEP) [6], wherein expressions are manually scored by FACS 
certified annotators. In addition, relevant validation was also performed on other 
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datasets including Baby FACS manual dataset [7] and Taiwanese Facial Expression 
Image Database (TFEID) [8].

1. For facial expression classification on ADFES and WSEFEP FaceReader 10 
has an accuracy of 98.7% and 97.2%, respectively. For FaceReader 9 these 
values were 99.3% and 95.7%, resp. That means that facial expression esti-
mation under ideal conditions is improved in FaceReader 10. For Action 
Unit classification on ADFES and WSEFEP FaceReader 10 has an F1 score* of 
0.83 and 0.80, resp. For FaceReader 9 these values were ~0.78 and ~0.76, 
resp. That means that facial expression estimation under ideal conditions is  
improved in FaceReader 10.

2. For Action Unit estimation using the baby model, FaceReader 10 has an F1 
score of 0.69 on the Baby FACS Manual dataset [7]. FaceReader 9 also had a 
score of 0.63. This means that the baby model in FaceReader 10 performs 
even better on baby faces compared to FaceReader 9.

3. The East Asian model on average performed approximately 10% better on 
Asian faces of our internal test data set (1200 East Asian faces) than the 
General model. The East Asian model and General model had an accuracy 
of 93% and 91%, resp. when the Taiwanese Facial Expression Image 
Database (TFEID, 268 images, [7]) was tested.

4. Gender classification in FaceReader 10 achieves and accuracy of 94% on an 
internal test set.

5. The detection of (eye) glasses on faces achieves an accuracy of 99.2% on an 
internal test set.

* The F1 score is the weighted average of precision and recall. This score takes both 
false positives and false negatives into account.
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1. Zafeiriou, S.; Zhang, C.; Zhang, Z. (2015) A survey on face detection in the 
wild: Past, present and future. Computer Vision and Image Understanding, 
138: 1-24.

2. Bulat, A.; Tzimiropoulos, G. (2017) How far are we from solving the 2D & 3D 
face alignment problem? (and a dataset of 230,000 3D facial landmarks). 
Proceedings of the IEEE International Conference on Computer Vision, pp. 
1021-1030.

3. Gudi, A.; Tasli, H.E.; den Uyl, T.M.; Maroulis, A. (2015) Deep learning based 
FACS action unit occurrence and intensity estimation. International 
Conference and Workshops on automatic face and gesture recognition 
(FG), 6: 1-5.

4. P. Ekman. Universal facial expressions of emotion. California Mental Health 
Research Digest, 8: 151-158, 1970.
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5. Van der Schalk, J., Hawk, S. T., Fischer, A. H., & Doosje, B. J. (2011). Moving 
faces, looking places: The Amsterdam Dynamic Facial Expressions Set 
(ADFES), Emotion, 11, 907-920. DOI: 10.1037/a0023853

6. Olszanowski, M.; Pochwatko, G.; Kuklinski, K.; Scibor-Rylski, M.; Lewinski, P.; 
Ohme, R.K. (2014) Warsaw Set of Emotional Facial Expression Pictures: A 
validation study of facial display photographs. Frontiers in Psychology 5, 
DOI: 10.3389/fpsyg.2014.01516.

7. Oster, H. (2016). Baby FACS: Facial Action Coding System for infants and 
young children. Unpublished monograph and coding manual. New York 
University.

8. Chen, L.F.; Yen, Y.S. (2007) Taiwanese facial expression image database. Ph.D. 
dissertation, Brain Mapping Lab, Inst. Brain Sci., Nat. Yang-Ming Univ., 
Taipei, Taiwan.

To cite the use of FaceReader in publications you can use the following reference:

Noldus (2021). FaceReader: Tool for automatic analysis of facial expressions: Version 
10 [Software]. Wageningen, The Netherlands: Noldus Information Technology B.V.

It is important to include the version number of the software in the reference since 
FaceReader’s algorithms are improved with every upgrade.
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Sample projects
You can download two example projects from your MyNoldus account: https://
my.noldus.com

Sample Project - Two stimuli

Five test participants watch two videos, one with baby twins that feed each other 
and one in which strange food is being prepared. Compare the facial expressions of 
the test participants while watching the two videos. 
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Sample Project - Infrared recording
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In this sample project we filmed a driver in a car driving in the near-dark to illustrate 
that FaceReader can analyze infrared recordings. In this project you can see what 
head rotations FaceReader can deal with. You can visualize Head orientation, Head 
position and Gaze angle.

Read the PDF file Description of FaceReader 10 sample projects, to see all the 
features that you can view in the projects. You can download this PDF file from the 
MyNoldus portal on the Noldus website (my.noldus.com). 
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Limitations of the current version
The current FaceReader version has a number of limitations. It is good to keep these 
in mind when you start working with FaceReader.

 Glasses may hinder classification. Especially thick and dark frames can 
reduce performance significantly. It may be useful to have a number of 
rimless reading glasses available in a few strengths when you carry out a 
test. A polarization filter on the camera can help to avoid reflections in the 
glasses.

 Pose, movement and rotation of the test person are limited. The test person 
should stand or sit and look frontally into the camera (angle < 30°). That 
means that you should sit opposite of the test participant and not next to 
him/her if you want to ask questions during the test. In a social interaction 
setting (medical student - patient or consultant-client interaction) you 
would ideally position the camera on the conversation partner’s shoulder. 
With this set-up people look almost straight into the camera when they talk 
to their partner. In practice this may not be possible but if you put the 
camera a short distance away, at the same height, with direct sight line to 
the participant’s face, you have a working solution.

In a consumer study you can use a cup or bowl holder so the dish is closer 
to the face and the test participant does not need to tilt his/her head 
downwards.

If your test participants need to read instructions or fill in a questionnaire, 
you can present this information on a screen and attach the camera to the 
screen.

 FaceReader requires strict light conditions. See Lighting setup

You can use (near) infrared light with a camera that is sensitive for this type 
of light. FaceReader 10 supports (near) infrared recordings. Please note that 
it is not possible to measure heart rate, heart rate variability and respiratory 
rate with infrared recordings.

 Factors that partially hide the face, like a hat, hair that covers the forehead, 
or very heavy facial hair may hinder the analysis.

Hands in front of the face should also be avoided. You may normally offer 
your test participants something to eat or drink during the test to make 
them feel more comfortable. However, when eating or drinking the test 
participant blocks part of the face with his/her hand and the cup/glass/
cutlery. Make sure the test participant finishes his/her cup of coffee before 
you start the test unless, of course, the purpose of the test is to see the 
reaction to a new food product or beverage. 
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Some people have the natural tendency to touch their face without 
realizing is. You may want to warn your test participant to keep their arms 
on the table throughout the test in order to get the best possible results.

 With the base functionality of FaceReader can analyze one face at once. If 
there are more faces in an image, you can select one of the faces by 
dragging the borders in the preview window and analyze that face. Then do 
the same with the other faces. Of course, the positions of the faces must 
not change significantly. See also the notes in Analyze facial expressions.

If your FaceReader license included the Advanced Research Module you can 
analyze up to eight faces in a video simultaneously. See The Advanced 
Research Module.

 For FaceReader to analyze facial expressions, emotions must be visible in 
the face. “All my test participants looked neutral throughout the test” is an 
often heard complaint. It may help to test people in their natural 
environment, at home or in another familiar environment (restaurant, 
school, office, etc.). Running your tests in the test facilities in your office has 
the obvious advantage that you can control the test conditions much better 
than out in the field. The downside, however, is that people may react 
differently to your stimuli or not at all. 

 Please contact us if any of the limitations above impede your research.

Improving FaceReader’s performance

The following tips to improve FaceReader’s performance apply to all analyses done 
in FaceReader and are especially important when using batch analysis of videos.

 Length of videos - Although there are no built-in limitations regarding the 
length of videos, it is good to keep in mind that the longer the video, the 
more data needs to be saved in the computer’s internal memory. Data is 
only saved to the hard disk after every analysis. We recommend to use 
videos that have a maximum duration of two hours (if 15 fps) or one hour (if 
30 fps).

 Resolution of videos - Higher resolution does not mean better facial 
expression analysis with FaceReader. High resolutions are scaled down to a 
maximum of 1280x1280 pixels while keeping the original video aspect ratio. 
Keep in mind that the scaling costs processing power and other resources 
which do have an influence on the performance. The minimum video 
resolution is 640x480.

 Analysis options - In the FaceReader Settings you can select what optional 
classifications you want to analyze. Select only those options that you need. 
Selecting more options requires more processor capacity.
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 Visualizations - Graphical presentations cost a huge amount of processing 
power and other resources (e.g. memory). For best performance you can 
best close the visualizations during analysis. 

 Processing unit - A powerful processor and sufficient internal memory is a 
prerequisite. Please see the System requirements.

 Applications running in the background - Make sure that no other 
applications are running.

 Test real products - You can show test participants pictures of your product, 
videos/commercials featuring your product, or you can give them the real 
product. Generally real products elicit greater responses. While having the 
real product to view is preferable to seeing a photo, real-life use is even 
more preferred. So, if you want to know whether your test participants like 
your new healthy flour mix, for example, you can ask them to bake 
pancakes in a test kitchen, and observe the displayed reactions during the 
baking process and the consumption phase.

 Present more than one stimulus - If you want to test your new product 
(commercial, beverage, etc.) it is best to embed it in a series of other 
products. In this way the test participants do not concentrate fully on the 
focus product and will respond in a more natural way. This also allows the 
participants to compare your product with similar ones. Be sure to 
randomize the order in which you present the products.

Mouse control

Some features of FaceReader are controlled with mouse clicks. If you do not have a 
mouse, you can use a mouse-emulator like NeatMouse to use those FaceReader 
functions. You can download NeatMouse for free.

http://neatdecisions.com/products/neatmouse/
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Modules
You can extend the base functionality of FaceReader with modules. Your license 
determines which modules you can use. For Baby FaceReader only the Vital Signs 
Module is available. You can check what modules have been enabled on your 
license. From the Help menu select About and in the window that opens under 
Modules click Enabled modules.

Action Unit Module

With the Action Unit Module you can analyze the intensity of a number of Action 
Units from the Facial Action Coding System (FACS). FaceReader can analyze 20 
Action Units, that are most common in facial expressions. With the Action Unit 
Module you can also define your own expressions (Custom Expressions). You can, 
for instance, combine ‘Happy’ and ‘Arousal’ to assess what commercial makes your 
test participants happily aroused. Interest, Boredom and Confusion which were 
called Affective Attitudes in FaceReader 7.1, are now available as Custom 
Expressions.

See The Action Unit Module

Vital Signs Module

With the Vital Signs Module you can analyze the heart rate and heart rate variability 
of the test participant by means of remote photoplethysmography. In FaceReader 
10 you can also analyze the participant’s respiratory (breathing) rate.

See The Vital Signs Module 

Voice Analysis Module

With the Voice Analysis Module FaceReader can recognize emotions in the voice 
(Neutral, Happy, Sad and Angry) and Valence and Arousal. In addition, the software 
can assess the Loudness and Speech rate.

See The Voice Analysis Module

Advanced Research Module

This module allows you to analyze multiple faces in a video. With this module and 
the Stimulus Presentation Tool you can also track the gaze of the test participant to 
assess what he/she is looking at when you present stimuli.

See The Advanced Research Module and Stimulus Presentation Tool.
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Consumption Behavior Module

With the Consumption Behavior Module you can determine whether your test 
participants show chewing behavior, take a bite when testing a food item or take a 
sip when testing drinks. Bites and sips are called ‘intake events’ in FaceReader.

See The Consumption Behavior Module.
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What is new in FaceReader 10
Customers that upgrade FaceReader from a previous version should read this 
section carefully to get an impression of the new features in FaceReader 10 9.1. 

If you upgraded from FaceReader 9.1

Voice Analysis Module

FaceReader 10 comes with the Voice Analysis Module which allows you to detect 
emotions in the voice (Neutral, Happy, Sad and Angry), Valence and Arousal in the 
voice, Loudness and Speech rate.

New vital sign: breathing rate

FaceReader 10 allows you to measure three vital signs. The RPPG Module in 
previous FaceReader versions made it possible to measure heart rate and heart rate 
variability. In FaceReader 10 it is possible to measure respiratory (breathing) rate as 
well. The RPPG Module has, therefore, been renamed and is now called the Vital 
Signs Module. 

Advanced Research Module

This module allows you to analyze multiple faces in a video. With this module and 
the Stimulus Presentation Tool you can also track the gaze of the test participant to 
assess what he/she is looking at when you present stimuli.

See The Advanced Research Module and Stimulus Presentation Tool

Project Analysis Module

The Project Analysis Module is now part of the basic FaceReader functionality.

Improved accuracy

The accuracy of basic facial expression analysis, analysis of Action Units, baby Action 
Units and the subject characteristics estimation has improved, including a relatively 
better estimation of contempt. In addition, there are significant improvements in 
facial state estimations (mouth and eyes open/close) and in left/right unilateral 
Action Unit activations.

If you upgraded from FaceReader 9.0 

Improved Action Unit classification

In FaceReader 9.1.8 and higher the classification of Action Units gives slightly lower 
intensities than in older versions of the software. In older versions non-active Action 
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Units could be classified with intensity level A, A-level Action Unit activations with 
level B, etc. The values of Contempt, Arousal, facial states (except Gaze direction), 
most custom expressions and Valence in Baby FaceReader are also affected as these 
parameters are based on Action Units. For the most accurate Action Unit estimation 
it is important to use the latest version of the software. See Introduction to Action 
Unit classification for more information.

Improved face modeling

In FaceReader 10 the face modeling has been improved. The new model is just as 
fast as the model in FaceReader 9.0 but the modeling of the mouth, the eyes and 
the eyebrows is much better. This is important in situations in which the test 
participant talks (for instance, when using a think aloud protocol in a usability test) 
or eats. 

Improved Project Analysis functionality

The Project Analysis now shows a default layout upon opening. The data selection 
window has been re-arranged to make it easier to use. Charts and tables have more 
extensive headers which can be adjusted.

New custom expressions

New custom expressions have been added to FaceReader 10, including 
‘Spontaneous laughter’, ‘Talking’, Frowning and ‘Raising Eyebrows’. FaceReader 10 
also has extra processors to define custom expressions.

If you upgraded from FaceReader 8.1

New face finding and modeling technique

FaceReader 10 uses a new and improved face finding and face modeling technique. 
It is more accurate and much faster and can better deal with rotations. See How 
does FaceReader work? for more information. As a result there are only three face 
models available now (the ‘General’ model, ‘East-Asian’ model and if you have Baby 
FaceReader, the ‘Baby’ model). The ‘Children’ model and the ‘Elderly’ model have 
become obsolete.

Renewed Project Analysis design

The Project Analysis section has been re-designed. In addition to the basic facial 
expressions you can now also analyze Action Units, Custom Expressions, Heart rate, 
Heart rate variability, Respiration rate, and Expressions in the voice. See Project 
Analysis for more information. Please note that you need the Action Unit Module to 
measure Action Units and Custom Expressions, the Vital Signs Module to measure 
heart rate, heart rate variability, Respiration rate, and the Voice Analysis Module to 
measure expressions in the voice.
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Project Analysis is now also available for Baby FaceReader.

Improved East Asian model

The East Asian face model has been improved. A validation set of images of East 
Asian faces has been created and a study has been carried out to validate the 
enhancements and to further improve the East Asian model.

Improved gaze direction measurement

Previous versions of FaceReader could track the test participant’s gaze in three 
directions (Left, Right and Forward). In FaceReader the gaze direction can be 
tracked more accurately, in nine directions (Left, Left-Up, Left_Down, Right, Right-
Up, Right-Down, Up, Down and Forward). FaceReader can also determine the gaze 
angle now (Horizontal gaze angle and Vertical gaze angle).

New custom expressions

FaceReader 10 comes with a number of new custom expressions, including: 
Attention, Laughing, Smiling, Spontaneous laughter, Talking, Blinking, Frowning, 
and Raising Eyebrows. See Custom Expressions for more information.

More functionality in Stimulus Presentation Tool

A new version of the Stimulus Presentation Tool allows you to display your stimuli 
full-screen. It is also possible now to define the length of the pause between stimuli 
and to track the test participant’s gaze. See The Stimulus Presentation Tool for more 
information.

Software activation code instead of hardware key

FaceReader 10 comes with a software activation code as the license which makes it 
easier to work with the software. For existing customers it is still possible to 
upgrade their hardware key.

If you upgraded from FaceReader 8.0

Reporting display

FaceReader now has a a fully customizable visualization of its analysis output. You 
can use it on a second monitor, or to create visuals in a report or presentation. The 
Reporting Client has been removed, its Valence Monitor and Smiley windows are 
available in the Reporting Display. 

See Reporting Display in FaceReader’s output
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Consumption Behavior Module

The Consumption Behavior Module lets you determine whether your test 
participant shows chewing behavior, takes a bite of the food item you are testing or 
takes a sip of the drinks you offer. 

See The Consumption Behavior Module

If you upgraded from FaceReader 7

Baby FaceReader

Depending on your FaceReader license you have the regular version of FaceReader, 
Baby FaceReader or both. With Baby FaceReader you can analyze faces of babies 
from the age of 6 months and infants up to the age of 2 years. Baby FaceReader can 
analyze 20 Action Units, Valence and Arousal. You can extend Baby FaceReader with 
the Vital Signs Module.

Custom Expressions

FaceReader 10 lets you define your own expressions based on the default facial 
expressions, Valence, Arousal, Action Units and other parameters. The Affective 
Attitudes Boredom, Confusion and Interest are now part of the Custom Expressions 
and a large number of other custom expressions are available in FaceReader’s 
Custom Expression Library . To define Custom Expressions you need the Action Unit 
Module. For more information see Custom Expressions.

Audio recording

If you use FaceReader with a webcam, you can now record audio with your videos. 
This is important in focus group tests, interviews and usability tests.

Left and right Action Units

The Action Unit Module now tells you not only whether Action Units are active in 
the face but also whether they are active on the left side or right side of the face. 11 
out of the 20 Action Units that FaceReader can analyze, are unilateral. This 
functionality is especially useful if you work with patients that are semi-paralyzed, 
subjects that have had a stroke or people suffering from Parkinson’s disease. For 
more information see Unilateral Action Units.

Infrared recordings

If you want to film your test participants in the (near) dark, for instance, when 
analyzing people’s facial expressions in a cinema, you can use (near) infrared light 
with a camera that is sensitive for this type of light. FaceReader 10 supports (near) 
infrared recordings. Please note that it is not possible to measure heart rate, heart 
rate variability, and breathing rate with infrared recordings.
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Export improvements

You now have more options to choose from when you export your data. This way it 
is easier to adjust the format of the export file to the requirements of analysis 
programs like SPSS. 

New camera

Besides the Microsoft LifeCam Studio that was already supported in previous 
versions, FaceReader 10 now also supports the Logitech BRIO webcam. 
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Privacy
Privacy-by-design

FaceReader is installed on-site and adheres to strict privacy-by-design protocols. 
For example, the software offers the option not to record the test participant’s face 
during the analysis. In this case only meta data are acquired that cannot be related 
to an identifiable person. Examples of meta data are facial expressions, head pose, 
age and gender. 

FaceReader is a software tool for scientific research. FaceReader is not capable of 
recognizing or identifying faces or people, and therefore unsuitable for surveillance 
purposes. For more details about applications please refer to our ethics statement 
on the following web page:

https://www.noldus.com/about-noldus/ethics-face-reading

GDPR and HIPAA compliance

FaceReader analyzes your participant's face while interacting with the digital 
content on their screen. When you analyze or record the participant’s face, please 
be aware of requirements for storing personal data. Video and audio of the 
participant are personally identifiable information and are, therefore, subject to 
GDPR regulations in Europe and HIPAA regulations in the USA. Facial expressions, 
video recordings with the test participant’s voice, heart rate, breathing rate data are 
sensitive data. With the correct procedure you can make sure that you comply with 
privacy regulations. 

To comply with GDPR or HIPAA regulations, take notice of the following:

When you record the participant, or share these recordings, make sure you ask the 
participant consent for video recording and let him or her sign a consent form. This 
informed consent form should include:

 The purpose of the recordings. If there is a possibility that the recordings 
will be reused for other studies, describe this explicitly. 

 Which personally identifiable information is stored. 

When you do a camera analysis, by default the video is stored, which is 
personally identifiable information. To switch off video recording, deselect 
the Record option in the window in which you select your camera. 

If you enter participant details like their name, age or gender this is also 
personally identifiable information. We recommend to use generic names, 
like participant 1, and to use age classes instead of specific ages. 

Facial expressions, video recordings with the test participant’s voice, heart 
rate, and breathing rate data are sensitive data. 
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Export files may also contain personally identifiable information or sensitive 
data. 

 Who will have access to the personally identifiable information. Think of 
authorized staff directly involved in the study, but also of Noldus support 
staff in case support is needed.

 The retention policy, when the personally identifiable information will be 
deleted.

 The right of subjects to withdraw permission for the use of the personally 
identifiable information and instructions for the participant to withdraw 
permission.

 The right to data portability and instructions for the participant how to 
receive their data. 

 Security and privacy measures taken. 

In FaceReader, video and data are stored locally on the computer. Take 
security measurements for the stored videos and describe this in the 
consent form.  

For information about Noldus’ Privacy Policy with regard to your data, see: 

https://www.noldus.com/legal/privacy-policy
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Installation

Main topics

 System requirements

 Software license key or hardware key

 The steps to install FaceReader

 Upgrade to FaceReader 10

 FaceReader trial version

 Camera and accessories
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System requirements

Operating system

FaceReader has been thoroughly tested using a US English version of Windows 11 
(64 bit Professional edition).

To check which version you have, type System information in the App window. 
Note the information in the OS Name, Version, and System Type fields. 
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Language support

Like any software package, it remains possible that minor differences in the 
operating systems of certain local language versions may affect how well the 
program runs. If you encounter a problem of this sort, please contact Noldus 
Technical Support.

Computer

If you order a complete solution from Noldus Information Technology, you will 
obtain a Dell Precision™ T3680 Workstation (or its successor), or a Dell Precision™ 
3591 mobile workstation (or its successor) with the FaceReader software installed 
and ready to use.

Technical specifications Dell Precision T3680

 Processor: Intel Core i7 14700

 Internal memory: 32 GB or more

 Hard disk: 1 TB 

 Graphics card: 8 GB NVIDIA Quadro T1000 or better

Technical specifications Dell Precision 3591 mobile workstation:

 Processor Intel Core Ultra 7 155H

 Memory: 16 GB

 1st Hard-disk: M.2 512 GB PCIe
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 Graphics card: RTX 1000 Ada

Other computers

If you choose to order a PC from another supplier, you can use the above 
specifications as a guideline. 

We recommend that you use a professional workstation. It is possible to buy 
consumer-range computers with a high processor speed and plenty of memory, but 
in order to remain competitive regarding price, the manufacturers often economize 
on the underlying system architecture. That means those computers are suitable for 
home use, but not for running professional scientific software. You should select a 
computer which is intended for professional use or labeled by the manufacturer as 
a workstation. We, therefore, recommend to use the specifications of the Dell 
Precision 3591 mobile workstation that are mentioned above if you prefer to use 
FaceReader on a notebook.

A CPU with AVX is required when using the Consumption Behavior Module. 

Camera

Supported cameras

We tested FaceReader with the following cameras:

 Logitech BRIO (USB3)

 Microsoft LifeCam Studio (USB2) 

 Axis M1065-L (IP-camera)

 Logitech C920, C922, C925e, C930e

See also Camera and accessories

The Logitech BRIO is not suitable for measuring heart rate and heart rate variability. 
Use a Logitech C920, C922, C925e or C930e with the Vital Signs module.

Internet connection

If you are using an IP camera, you need a fast Internet connection for this set-up to 
work.
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Software license key or hardware key
A license for FaceReader comes with either a software license key or a hardware key. 
The license determines which options are available to you. 

See Modules

Software license key

Your software license key makes either one or multiple activations of the software 
possible, depending on the number of licenses that you purchased and the type of 
activation that you choose. For information on how to activate your license see 
Activate FaceReader with a software license key.

Hardware key

A hardware key is a very important piece of equipment, as it represents the full 
value of your license and cannot be replaced if lost. You can install FaceReader on 
more than one computer. However, to work with the program you need to insert 
the hardware key into one of the computer’s USB ports. 

IMPORTANT  Please make sure that you do not lose the key! You will need to pay for 
a new license if so. Also be careful with it, because it is sensitive and can be easily 
damaged.

The drivers for the hardware key are installed together with FaceReader. First install 
FaceReader with the drivers for the hardware key, then connect the hardware key to 
the computer. If you connect the hardware key first, other drivers are automatically 
installed which may lead to incorrect functioning of the hardware key. When the 
hardware key is installed and connected properly, a red light glows inside it. 
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The steps to install FaceReader
Aim

To set up the computer to work with FaceReader. 

Prerequisites.

 You have a license for FaceReader. This can be a software license key or a 
hardware key. 

See Start FaceReader

 You downloaded the FaceReader installation file from the MyNoldus portal 
(my.noldus.com). 

 You did not order a computer with FaceReader from Noldus IT. If you did, all 
your software and any internal hardware is already installed and tested and 
you can skip this topic. 

 You have administrator rights on the computer for FaceReader. This means 
you either are the system administrator or a member of the Windows group 
Administrators and have been assigned administrator rights.

 You checked the packing list to make sure all the components are present. 
If any of the components listed is missing or damaged, please report this to 
Noldus IT immediately.

 Your computer meets the System requirements needed for FaceReader 10.

Procedure

Carry out the following steps:

 Turn off automatic device driver installation and automatic updates

 Select correct power options in Windows 10

 Install FaceReader
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Turn off automatic device driver 
installation and automatic updates
Aim

To make sure the cameras use the drivers that were tested with FaceReader and to 
prevent automatic system restarts that cannot be controlled.

Background information

The general recommendation from Microsoft to use automatic updates is good, 
especially for security updates. However, automatic updates of hardware device 
drives can sometimes give problems. FaceReader is tested with the device drivers 
that are available at the moment of the release. If device drivers are updated 
afterwards, we cannot guarantee that they work properly with FaceReader. 
Therefore we recommend to switch off automatic updates of device drivers. 

If you ordered a computer with FaceReader from Noldus IT, the automatic device 
driver installation and automatic updates have already been turned off and you can 
skip this topic. 

 Procedure for Windows 11 and Windows 10 from version 1809 onwards

 Procedure for Windows 10 up till version 1803

Procedure for Windows 11 and Windows 10 from version 1809 
onwards

As of Windows 10 version 1809 please use the Group Policy Settings to prevent 
automatic device driver installation:

1. Click on the Windows icon in the taskbar and then type Edit group policy. 
The Local Group Policy Editor window opens.

2. Under Computer Configuration select Administrative Templates, 
System, Device Installation and then Device Installation Restrictions.

3. Check whether the appropriate settings are configured.

Tip: Click on a setting to get additional information. If you are unsure what 
settings should be configured, ask your system administrator for help.

Also check that your computer has the appropriate settings to prevent automatic 
updates:
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1. Click on the Windows icon in the taskbar and then type Edit group policy. 
The Local Group Policy Editor window opens.

2. Under Computer Configuration select Administrative Templates, 
Windows Components and then Windows Update.

Manage updates offered from Windows Server Update Service

Manage updates offered from Windows Update

3. Check whether the appropriate settings are configured.

Tip: Click on a setting to get additional information. If you are unsure what 
settings should be configured, ask your system administrator for help.

Procedure for Windows 10 up till version 1803

1. Click the Windows icon on your desktop and type Change device. 

2. Click Change Device Installation Settings. 

3. In the window that appears, select No (your devices might not work as 
expected). Then click Save Changes.
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Select correct power options in Windows 
10
Aim

To make sure the computer shuts down properly. This step is needed for Windows 
10 computers only.

Background information

On computers with Windows 10, by default the computer resumes rather than 
restarts after shutdown. This can cause problems with FaceReader and associated 
software like MediaRecorder, and The Observer XT. Therefore, we recommend to 
make sure that the computer really shuts down. 

Procedure

1. Click the Windows icon on your desktop or keyboard and type Control 
Panel. Then click Power options. 

2. Click Choose what the power buttons do.

3. Click Change settings that are currently unavailable. 

4. Select the following options (both for On battery and Plugged in):

- When I press the power button – Shut down.

- When I close the lid – Shut down. 

- Under Shutdown settings deselect the checkboxes Sleep, Hibernate, and 
Turn on fast startup (recommended).
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Install FaceReader
IMPORTANT  If your FaceReader license comes with a hardware key, first install 
FaceReader and then connect the hardware key to your computer, not the other 
way around.

Procedure

1. Download the installation file (FaceReader 10 Setup.exe) from the MyNol-
dus portal of the Noldus website (my.noldus.com).
If you do not have a MyNoldus account yet, you can create one.

2. Double-click the file. If a security message appears, click Run. 

3. We recommend to choose Standard as Installation type. Choose Custom if 
you want to change the folder into which FaceReader is installed, or if you 
do not want shortcuts on the desktop to the program and the FaceReader 
Help.

4. Click Next, read the End-User License Agreement carefully, Select I agree, 
and click Install and then Yes. The installation of FaceReader starts.

5. When the installation of FaceReader is finished, a message appears 
informing you that installation is complete. Click Launch to start 
FaceReader, or Close to exit.

Notes

 IMPORTANT  Projects saved in FaceReader 10 cannot be opened in earlier 
versions anymore.

 FaceReader is installed in C:\Program Files\Noldus\FaceReader 10\

 You can install FaceReader 10 next to older versions of FaceReader but we 
advise to not combine data from projects made in different versions.

 A number of sample images and video files is installed in 
C:\Users\Public\Public Documents\Noldus\FaceReader 10\Examples.

 To install the Stimulus Presentation Tool, see To install the Stimulus 
Presentation Tool

 It is not possible to install FaceReader on one computer and access it from 
another across a network. The program must be installed on the computer 
where it will be used.
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End-user license agreement
IMPORTANT – READ CAREFULLY. Please read this End­User License Agreement 
(“EULA” or “Agreement”) carefully before checking the “accept” checkbox, 
downloading or using the Software (as defined below). By checking the “accept” 
checkbox, downloading, installing or otherwise using the Software, End-User agrees 
to be bound by the terms and conditions in this EULA. If you do not agree to the 
terms and conditions of this EULA, do not check the “accept” checkbox and do not 
download, install or use the Software.

The Software is protected by copyright laws and international copyright treaties, as 
well as other intellectual property laws and treaties. The Software is licensed, not 
sold.

1. DEFINITIONS

Terms used in this EULA but not otherwise defined shall have the meaning assigned 
to them below: 

1.1. Authorized Partner: the individual or legal entity that has been granted 
permission by Noldus to promote, sell or otherwise distribute the Software on 
behalf of Noldus.

1.2. End-User: the individual or legal entity that has acquired or uses the Software 
under the terms and conditions of this EULA. 

1.3. EULA: this End-User License Agreement.

1.4. Indirect Losses: any indirect loss, claim, damage, liability, or expenses 
(including reasonable attorney's fees), including lost profits, and damage due to the 
stagnation of business operations.

1.5. Network License: a licensing mechanism comprising a license file and 
accompanying software managing the number of concurrent users of the Software.

1.6. Noldus: Noldus Information Technology BV, with registered office at Nieuwe 
Kanaal 5, 6709 PA Wageningen, The Netherlands, listed in the Trade Register under 
Chamber of Commerce number 09094422, or its subsidiaries listed in the document 

https://www.noldus.com/legal/noldus_corporate.pdf

1.7. Security System: a system of software protection to limit installation and use of 
the Software to the authorized End-Users and computers.

1.8. Security Device: a device that forms part of or is attached to the computer, and 
is used as part of the Security System to control access to the Software.

1.9. Software: the software (including, but not limited to, any updates, upgrades 
and associated media, printed or electronic documentation and online services) 
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provided to the End-User by Noldus or an Authorized Partner together with this 
EULA, that is not covered by third party terms and conditions and is included in the 
list under “Noldus software” in the Annex to the General Terms and Conditions

(https://www.noldus.com/legal/noldus_gtc.pdf).

2. LICENSE

2.1. Upon payment by the End-User of the license fees for the Software, Noldus 
grants End-User a revocable, non-exclusive license to download, install and use the 
Software in accordance with the terms and conditions of this EULA. This EULA does 
not grant any rights to obtaining future upgrades, updates or supplements of the 
Software. If upgrades, updates or supplements of the Software are obtained, 
however, the use of such upgrades or updates is governed by this EULA and the 
amendments that may accompany them and may be subject to additional 
payments and conditions.

2.2. The End-User may download, install and use the Software on as many 
computers as is reasonably necessary, however the Software may not be shared or 
used concurrently on more computers than for which EULA’s are granted. End-User 
shall take all reasonably required steps to ensure that this number is not exceeded.

2.3. End-User is allowed to store or install a copy of the Software for back-up or 
archival purposes.

2.4. End-User shall not (i) modify, alter, adapt, merge, decompile or reverse-
engineer the Software or any part thereof nor create any derivative works based on 
all or any part of the Software, or (ii) remove or obscure any copyright, trademark or 
other ownership notices from the Software, or (iii) sub-license, sell, rent, lease, hire, 
loan, assign or otherwise transfer the Software or your rights in the Software or any 
part thereof, except as provided for in this EULA.

2.5. The Software may be protected by a Security System, including but not limited 
to the use of expiry dates, time-limited or feature-limited licenses, authorization 
codes, Security Devices and Network Licensing. End-User is prohibited to (attempt 
to) remove, alter or circumvent in any way any part of such Security System.

2.6. End-User is responsible for regular, frequent and effective backups of all files 
produced or modified while working with the Software. 

3. INTELLECTUAL PROPERTY

3.1. All title, copyright and other industrial, intellectual or proprietary rights in and 
to the Software (including but not limited to any images, photographs, animations, 
video, audio, music, and text incorporated into the Software), the accompanying 
printed materials, and any copies of the Software are owned by Noldus or its 
Authorized Partners. All rights not expressly granted are reserved by Noldus.
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3.2. The Software may include or make use of third party software, including open 
source software. Such third party software may be subject to the third party’s terms 
and conditions provided in the documentation accompanying the Software and 
may contain copyright or other industrial, intellectual or proprietary rights of such 
third party software. End-User hereby agrees to the terms and conditions for such 
third party software. In the absence of any third party terms and conditions, this 
EULA will govern the third party software in the Software. 

3.3. End-User may, from time to time, provide Noldus with comments, suggestions, 
data, information or feedback (“Feedback”) on the Software. End-User 
acknowledges and agrees that such Feedback may be freely used by Noldus, at its 
sole discretion, for the design, development, improvement, marketing and 
commercialization of its products and services, without any restrictions based on 
confidentiality or intellectual property rights.

4. TRANSFER

4.1. End-User is entitled to make a one-time, permanent transfer of this EULA and 
Software only directly to one other End-User. This transfer must include all of the 
Software (including all component parts, the media and printed materials, any 
upgrades and this EULA). Such transfer may not be by way of consignment or any 
other indirect transfer and shall be subject to the following provisions:

a. End-User will provide to Noldus prior to any such transfer the full name 
and address details of the new End-User and the expected date of transfer 
in writing;

b. The new End-User understands and agrees to all the terms and 
conditions of this EULA in the same way as if the new End-User had 
obtained the Software from Noldus or an Authorized Partner;

c. End-User will destroy all (partial) copies of the Software and all 
accompanying materials, including but not limited to installed copies and 
any backup copies on data storage devices and guarantee to Noldus in 
writing that this has been done. If the Software is an upgrade, any transfer 
must include all prior versions of the Software;

d. Noldus reserves the right to levy an administrative charge upon the End-
User and/or the new End-User in relation to transfer of the Software to an 
End-User.

4.2. Any attempted transfer without prior written permission from Noldus shall 
constitute a material breach of this Agreement and shall be deemed null and void.

5. TERM; TERMINATION

5.1. The EULA shall enter into force on the date of acceptance by the End-User and 
continue until terminated in accordance with this Section 5.
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5.2. If the Software is licensed on a subscription basis, the EULA shall continue until 
the end of the current subscription period.

5.3. Noldus is entitled to terminate the EULA immediately upon prior written notice 
upon:

a. the breach of any material provision of this Agreement by the End-User if 
(i) such breach is not curable or (ii) if curable, the End-User has not cured 
such breach within 30 (thirty) day period following receipt of a written 
notice by Noldus substantiating such breach ("ingebrekestelling"); 

b. the filing or institution of bankruptcy, liquidation or receivership 
proceedings of the End-User or in the event a receiver or custodian is 
appointed for the End-User’s business, or if its business is discontinued or if 
it has a petition presented by a creditor for its winding up or if the End-User 
enters into any liquidation (other than for purpose of reconstruction or 
amalgamation).

5.4. Upon termination of the EULA, the End-User shall immediately discontinue the 
use of the Software and remove the software of all computers, destroy all (partial) 
copies of the Software from all storage media and return the documentation and 
materials relating to the Software to Noldus or its Authorized Partner.  

5.5. Termination of this Agreement does not remove or reduce End-User’s 
obligation to pay any outstanding license fees or other monies, all of which shall be 
due for payment immediately on termination of the EULA.

5.6. The following provisions shall survive termination of this EULA: Sections 3, 7, 9, 
10 and this Section 5.6. In addition, any other provisions which are required to 
interpret and enforce the Parties' rights and obligations under the EULA shall also 
survive any termination or expiration of this EULA, but only to the extent required 
for the full observation and performance of the EULA. 

 6. WARRANTY

6.1. Noldus warrants that the Software as of the date of delivery to the End-User by 
Noldus or its Authorized Partner, the Software will, for a period of 90 days 
(“Warranty Period”) materially conform to the specifications set out in the user 
documentation accompanying the Software (“Specifications”), provided that:

a. the Software is properly installed on a supported computer platform (as 
defined in documents that can be accessed on 

https://my.noldus.com)

and used in accordance with the provisions of the accompanying user 
documentation and/or any Noldus-approved training course;
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b. Noldus is notified in writing within 14 days after any non-conformity of 
the Software was known or should reasonably have been known to End-
User and the End-User has made available all the information that might 
reasonably be required to allow Noldus to investigate, recreate and where 
possible remedy a non-conformity;

c. the Software has not been (a) altered, repaired or modified by any party 
other than Noldus or a third party provider approved by Noldus; or (b) used 
with software or a computer platform other than set out in the documents 
that can be accessed on

https://my.noldus.com

or have been subjected to negligence, or computer or electrical 
malfunction; or (c) were used, adjusted, or installed other than in 
accordance with instructions by Noldus. 

6.2. Other than set out in Section 6.1, no warranties are expressed or implied with 
respect to Software or any element thereof, including without limitation its quality, 
performance, accuracy, merchantability or suitability or fitness for any purpose, 
whether or not that purpose has been communicated by End-User to Noldus. The 
Software is a general product developed by Noldus for a wide range of solutions, 
requirements and situations and End-User is responsible for purchasing the 
Software required for his needs. Noldus explicitly does not warrant that the 
Software shall be entirely without error or fault nor that it will operate without 
interruption. End-User agrees that such errors, faults or interruptions shall not be 
deemed material and cause to terminate this EULA.

6.3. The warranty by Noldus set out in Section 6.1 applies only to the first 
installation of the Software and will not apply, resume or renew upon delivery or 
installation of any subsequent update or upgrade to the Software, alteration in the 
number of EULA’s granted for use of the Software, or any other extensions, 
upgrades or alterations to the Software where the Software has previously been 
delivered to or installed by the End-User.

6.4. The warranty by Noldus set out in Section 6.1 shall further not apply to 
Software that is licensed or otherwise made available at no cost, or Software that is 
designated as ‘prototype’, ‘alpha’ or ‘beta’ code, all of which are provided ‘as is’ and 
without warranty, representation or liability.

6.5. Upon receipt of an End-User’s written notice of the Software not conforming to 
the Specifications during the Warranty Period, Noldus shall at its option and in its 
sole discretion (i) assist the Customer in correcting or replacing the non-conforming 
Software or, (ii) terminate the EULA immediately and refund the purchase price paid 
by the End-User. The remedies described above shall be End-User’s sole and 
exclusive remedies. Upon expiration of the Warranty Period, Noldus shall have no 
obligation to provide such remedies.
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6.6. Noldus and Authorized Partners, are not responsible for maintaining or 
supporting use of the Software or obligated to provide any updates, fixes or 
support to the Software unless otherwise expressly agreed in writing between End-
User and Noldus or the Authorized Partners.

7. USE LIMITATIONS; LIABILITY; INDEMNIFICATION

7.1. End-User acknowledges that the Software is intended for research or training 
purposes only and agrees not to use the Software for diagnosis or treatment of 
disease in human subjects. End-User agrees not to use the Software in any 
application where the failure, malfunction or inaccuracy of the Software carries the 
risk of death or bodily injury.

7.2. Noldus Software shall not be used for collection of biometric data from human 
subjects without prior informed consent from the person whose data is being 
captured.

7.3. Noldus does not allow the use of its Software for the following applications:

a. Active defense, i.e. embedding Noldus Software in a weapon system.

b. Biometric data collection in a judicial context with the aim to use such 
data as evidence in court. Noldus Software cannot and shall not be used as 
a lie detector.

c. Surveillance of people in public spaces for security purposes.

d. Any other use that may potentially violate fundamental human rights.

7.4 If Noldus notices that its Software is used for applications that it does not 
approve, this may lead to discontinuation of customer support and termination of 
the EULA.

7.5. To the fullest extent permitted by law, and not withstanding any other provision 
of this EULA to the contrary: 

In no event will Noldus or the Authorized Partners be liable to the End-User for 
Indirect Losses or for special, incidental, consequential, exemplary, enhanced, or 
punitive damages, including without limitation, any damages resulting from 
interruption of business, loss of use, loss of profits or revenue, or loss of business, 
arising out of or in connection with this EULA, the Software, or the performance of 
Noldus, the Authorized Partners, or third parties engaged by Noldus in the 
performance of this EULA, regardless of whether Noldus, the Authorized Partners, 
End-User, or any other person or entity has been advised of (or could have 
reasonably foreseen) the possibility of such damages or Indirect Losses. If, despite 
the provisions in this EULA, liability exists anyway, only direct damage will be 
eligible for reimbursement.
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7.6. Noldus’ and Authorized Partners’ liability shall also be excluded, and Noldus 
and the Authorized Partners shall not have any liability under this EULA in the event 
of: 

a. End-User’s use of the Software other than in accordance with Section 7.1;

b. in the event of direct and indirect consequences of the End-User’s failing 
to adhere strictly to the user documentation provided or made available by 
Noldus or the Authorized Partner; or

c. any loss of or damage to files or data howsoever caused.

7.7. A liability claim will be unenforceable and lapse unless Noldus or the 
Authorized Partner receives a written notice thereof no later than 6 months after 
the discovery of an event or circumstance that gives or may give rise to that claim.

7.8. Noldus will hold harmless, defend, and indemnify End-User from and against all 
losses, damages, claims, liabilities, and expenses incurred by End-User that arise out 
of, relate to, or are caused by any third party claim that End-User’s use of the 
Software, pursuant to the terms of this EULA, infringes the intellectual property 
rights of such third party. If such a claim is made or appears likely to be made, 
Noldus, at its option, will have the right to either (i) procure for the End-User the 
right to continue to use the Software, (ii) modify or replace the Software so that it is 
no longer infringing (in a manner that substantially retains its functionality and 
quality), or (iii) require End-User to terminate the use of and return the Software 
and refund a pro rata portion, if any, of the amount paid by End-User to Noldus for 
the infringing Software. Notwithstanding the foregoing, Noldus will have no liability 
to End-User if the infringement results from use of the Software in combination 
with software not provided by Noldus or from modifications made by Noldus to 
conform to specifications provided by End-User. The indemnification obligations in 
this section are subject to: (i) End-User giving Noldus prompt written notice of any 
claim (provided that End-User's failure to provide prompt written notice will only 
relieve Noldus of its obligations under this Section to the extent such failure 
materially limits or prejudices Noldus’ ability to defend or settle such claim); (ii) the 
transfer of sole control of the defense and any related settlement negotiations to 
Noldus; and (iii) End-User's cooperation, at Noldus’ expense, in the defense of such 
claim. THIS SECTION STATES END-USER'S SOLE AND EXCLUSIVE REMEDIES FOR 
THIRD PARTY INTELLECTUAL PROPERTY INFRINGEMENT CLAIMS.

7.9. End-User shall indemnify and hold harmless Noldus, the Authorized Partners, 
and the third parties engaged by Noldus from and against any and all losses 
(including Indirect Losses and special, incidental, consequential, exemplary, 
enhanced, or punitive damages) arising out of or caused by (i) any failure in the 
performance of the obligations of the End-User under the law, this EULA, or Noldus’ 
General Terms and Conditions, or (ii) any and all third party claims on any grounds 
whatsoever, directly or indirectly related to the End-User’s use of the Software, the 
contents thereof, or any results or materials generated by the Software.
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7.10. THE LIMITATION OF LIABILITY PROVISIONS SET FORTH IN THIS SECTION 7 
SHALL APPLY EVEN IF END-USER’S REMEDIES UNDER THIS EULA FAIL OF THEIR 
ESSENTIAL PURPOSE.

7.11. Noldus and End-User acknowledge and agree that the parties entered into 
this EULA in reliance upon the limitations of liability set forth in this Section 7, that 
the same reflect an allocation of risk between the parties (including the risk that a 
contract remedy may fail of its essential purpose and cause consequential loss), and 
that the same form an essential basis of the bargain between the parties.

8. MISCELLANEOUS 

8.1. Parties may communicate with each other by electronic mail. Parties recognize 
the risks associated with electronic mail and declare that they shall not hold each 
other liable for any damage incurred by either of them as a result of the use of 
electronic mail. If a Party is in doubt as to the content of an electronic message 
received, the content of the message originating with the sender shall be decisive.

8.2. The invalidity or unenforceability of any provision this EULA shall not affect or 
limit the validity or enforceability of any other provisions thereof. Any such invalid 
or unenforceable provision shall be deemed to be substituted by a provision that is 
considered to be valid and enforceable. The interpretation of the substituting 
provision shall be as close as possible to the economic, legal and commercial 
objectives of the severed provision.

8.3. Failure by Noldus or the Authorized Partner to enforce any of its rights under 
the EULA shall not constitute a waiver of such rights thereunder and shall not 
relieve End-User of its obligation to comply with such provisions. No waiver or 
amendment of any provisions therein shall be effective unless signed in writing by a 
Noldus representative. Any such written waiver shall only be applicable to the 
specific instance to which it relates and shall not be deemed to be a continuing or 
future waiver. 

8.4. Amendments or changes to this EULA can only be agreed upon in writing 
between the Parties.

8.5. The EULA shall be binding upon the Parties thereto, their legal representatives, 
successors and assigns. End-User shall not assign any right or obligation arising out 
of this EULA without the prior written consent of Noldus. Any attempt by End-User 
to assign or delegate any obligation hereunder shall be deemed null and void.

9. GOVERNING LAW: END-USERS USA OR CANADA

9.1. If End-User is a legal entity and its principal place of business is located in the 
United States of America or Canada, or if End-User is an individual whose primary 
residence is located in the United States of America or Canada:

a. This EULA is exclusively governed by the laws of the Commonwealth of 
Virginia and the applicable federal laws of the United States of America, 
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without regard to the conflicts of law provisions of any jurisdiction. Without 
limiting the previous sentence, End-User and Noldus expressly agree: 
(i) that the Virginia Uniform Computer Information Transactions Act, 
Virginia Code §§ 59.1-501.1 et seq. (“UCITA”), and the United Nations 
Convention on Contracts for the International Sale of Goods (“CISG”) are 
expressly excluded from this EULA, (ii) that any and all terms contained in 
UCITA or CISG will have no force or effect on any portion of this EULA, and 
(iii) that UCITA and CISG do not apply to this EULA or the Software. 

b. Any and all claims and disputes arising out of or in connection with this 
EULA, the Software, or the performance or non-performance by either party 
of any of its obligations under this EULA, which End-User and Noldus 
cannot resolve amicably within a reasonable period of time, will be 
commenced and maintained only in a state or federal court of competent 
subject matter jurisdiction situated or located in the United States of 
America. Noldus and End-User consent to the exclusive personal 
jurisdiction of and venue in any such court.

c. To the extent permitted by law: End-User must commence or file any 
claim or action arising out of or relating to this EULA or the Software within 
six months after the cause of action accrues, otherwise, such claim or cause 
of action is permanently barred. To the extent permitted by law, End-User 
expressly waives the right to commence or file any such claim or action 
under any longer statute of limitations.

10. GOVERNING LAW: END-USERS OTHER COUNTRIES

10.1. If End-User is a legal entity and its principal place of business is located in any 
country other than the United States of America or Canada, or if End-User is an 
individual whose primary residence is located in any country other than the United 
States of America or Canada:

a. This EULA is exclusively governed by the laws of The Netherlands. The 
United National Convention for Contracts on the International Sale of 
Goods is expressly excluded. 

b. Any disputes arising out or in connection with this EULA that cannot be 
solved amicably within a reasonable period of time will be submitted to the 
competent court in Arnhem, The Netherlands, for any dispute with End-
Users having their principal place of business in the European Union. In the 
event that an End-User has its principal place of business outside the 
European Union, the United States of America or Canada, any dispute shall 
be finally settled in accordance with the Arbitration Rules of the 
Netherlands Arbitration Institute. Location shall be Arnhem, The 
Netherlands. The arbitration procedure shall be conducted by one (1) 
arbiter in the English language.
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REVISED JULY 21, 2022

NOTE A PDF copy of this End-User License Agreement can be found in the folder 
Documentation\Legal, located in your application folder (default: C:\Program 
Files\Noldus\FaceReader 10.
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Acknowledgments and copyright notices
FaceReader™ is a trademark of Vicarious Perception Technologies BV but the End-
user license agreement for products from Noldus Information Technology BV 
applies. FaceReader would not be what it is without the use of third-party software. 
This page lists software libraries and other software products used in FaceReader 
and where you can find license and compliance information and/or 
acknowledgments for that product.

For the complete terms and conditions in PDF format, see the PDF files in the folder 
Documentation\Legal\Acknowledgements, located in your application folder 
(default: C:\Program Files\Noldus\FaceReader 10).

Name Description Link/ License

Boost Open source (Boost 
community) software library, 
C++ templates

Boost software license

http://www.boost.org/users/
license.html

IPP, MKL, TBB Software library for signal, 
image, speech and audio 
processing (Intel Corporation)

Intel Composer XE

https://software.intel.com/en-
us/license/intel-simplified-
software-license

OpenCV Software library, collection of 
algorithms and sample code 
for various computer vision 
problems

OpenCV

http://www.intel.com/content/
www/us/en/research/intel-
research.html

3-clause BSD License

http://opencv.org/license.html
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HASP Library for software 
protection

Safenet EULA

https://safenet.gemalto.com/
DownloadNotice.aspx?dID=8589
947119

Sentinel Gemalto

https://sentinel.gemalto.com/

Wix Toolset Tools to author software 
installers

Wix Toolset

http://wixtoolset.org/

.NET Foundation

https://dotnetfoundation.org/

Microsoft Reciprocal License 
(MS-RL)

http://wixtoolset.org/about/
license/

Emgu CV .Net wrapper to Open Source 
Computer Vision Library

FaceReader contains Emgu CV 
components under a commercial 
license. 

http://www.emgu.com

FFmpeg Video file decoding and 
encoding

GNU Lesser General Public 
License 

http://www.gnu.org/licenses/
lgpl-3.0.txt

Source code is available at 

https://ffmpeg.org/
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NAudio NAudio is used for audio 
playback of stimulus videos

Microsoft Public License (Ms-PL) 

http://naudio.codeplex.com/
license

Source code is available at

http://naudio.codeplex.com/

Caffe Caffe is a deep learning 
framework

BSD 2-Clause license

https://github.com/BVLC/caffe/
blob/master/LICENSE

Source code is available at 

https://github.com/BVLC/caffe

Tensorflow 
Lite

Tensorflow Lite is used for 
multiple deep learning 
models within FaceReader

Apache License Version 2.0

https://github.com/tensorflow/
tensorflow/blob/master/LICENSE

Source code available at:

https://github.com/tensorflow/
tensorflow

OpenVino OpenVino is used for multiple 
deep learning models within 
FaceReader

Apache License Version 2.0

https://github.com/
openvinotoolkit/openvino/blob/
master/LICENSE

Source code available at:

https://github.com/
openvinotoolkit/openvino
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MediaPipe MediaPipe offers open source 
cross-platform, customizable ML 
solutions

Apache License Version 2.0

https://github.com/google/
mediapipe/blob/master/
LICENSE

Source code available at:

https://github.com/google/
mediapipe
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Upgrade to FaceReader 10
To upgrade a previous FaceReader version to version 10, carry out the following 
steps:

 Install FaceReader. 

Carry out all steps in The steps to install FaceReader.

 Upgrade the license

See Upgrade the license

 Upgrade the Stimulus Presentation Tool. 

See To upgrade the Stimulus Presentation Tool in Project Analysis

Notes

 You can install FaceReader 10 9 next to older versions of the software. 

 If you open a project that was created in an older version, it is converted to 
a FaceReader 10 project and cannot be opened in the older FaceReader 
version anymore. To work with that project in older versions first create a 
backup in an older version. 

See Back up a project

 We recommend to use the same FaceReader version within one project. 

Upgrade the license 

If you have a software license key

Start FaceReader and activate your new license with your software license key 
following the procedure in Activate FaceReader with a software license key.

If you have a hardware key

1. Insert the hardware key into your computer and start FaceReader. 

2. The system automatically detects the old license on the hardware key and 
the Enter Upgrade Key window appears. Enter the key code that was 
supplied to you by Noldus IT. These numbers are normally sent by e-mail or 
are written in your welcome letter. 
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If you bought an extra module

When you already have FaceReader and bought an extra module, for example the 
Action Unit Module, you also need to upgrade your license. Open FaceReader and 
choose Help > Upgrade. Then enter the upgrade key that was supplied to you by 
Noldus IT.

Opening an analysis made in a previous version of FaceReader

When you open an analysis in a project that has been made in version 8 or lower of 
FaceReader, a message will appear in the Analysis Visualization window that, for 
instance, the mesh and the gaze cannot be shown. You will have to re-analyze the 
video to see these visualizations.

If the analysis was done with the Children model or the Elderly face model that 
have become obsolete in FaceReader 10, then a message will pop up asking you 
whether you would like to switch to the General model. If you select ‘Yes’ you will 
see ‘General’ as the face model in the current settings. The analysis results remain 
intact.
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FaceReader trial version
Aim

To try FaceReader for free for a limited period. 

Restrictions

 Valid for 14 days (from the day of activation).

Prerequisite

 You received a link to download the setup file. 

 You received a software license key.

 Your computer meets the System requirements

Procedure 

1. Open the FaceReader trial download page and download the setup file.

2. Double-click the setup file that you downloaded and follow the instructions 
on your screen.

3. Start FaceReader.

4. A window opens, choose Activate software license key.

5. In the following window select either Floating or Fixed. See What is the 
difference between a Floating and a Fixed activation?

6. In the window that appears, enter the software license key. 

7. Click OK.

Notes

 To see how many days are left in your trial, choose Help > About.

 When the trial period expires, a message is shown at start up.

 The Action Unit Module, The Vital Signs Module, The Advanced Research 
Module, and The Consumption Behavior Module are enabled in the trial 
version. With the Trial version you can use the regular FaceReader 
functionality and Baby FaceReader.
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Camera and accessories
Supported cameras 

FaceReader can only classify facial expressions correctly if it gets a good image. 
Both the placement of the camera and the lighting of the subject's face are of 
crucial importance in obtaining reliable classification results. Also the quality of the 
camera is crucial. The following cameras are supported.

USB cameras

FaceReader is supported with current generation CCD webcams with a resolution of 
at least 640 x 480 pixels. FaceReader and all its modules has been tested with the 
following USB cameras:

 Logitech C920, C922, C925e, C930e

 Logitech Brio

 Microsoft Lifecam Studio

Do note that the Logitech Brio and Microsoft LifeCam Studio are not suitable for the 
Vital Signs Module due to internal image processing (see Introduction to Vital 
Signs).

You can purchase these cameras from us or use another current generation high 
quality webcam with a resolution of at least 640 x 480 pixels.

IP cameras

An IP camera is connected with the FaceReader PC via Internet, and enables you to 
do tests with test participants at another location or at the test participant’s home. 

FaceReader works with IP camera that support MJPEG or JPEG output. FaceReader 
cannot import RTSP output of IP cameras. 

Compared to webcams such as the Microsoft LifeCam Studio, IP camera signals are 
processed slower. This is caused by the fact that IP cameras need time to encode 
video. Also sending videos over a network takes time. This means that the IP 
camera video signals received by FaceReader are analyzed with a delay. This effect is 
also seen when The Stimulus Presentation Tool is used. The delay is in the order of 
magnitude of 0.1 - 0.3 seconds if you use the FaceReader setup in a company 
network. If you use a dedicated local network for the FaceReader setup, which is 
recommended, the delay is less and in the order of magnitude of 0.1-0.2 seconds. 

If this delay is too large for your experiment's accuracy, record with a USB camera 
instead.
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Infrared cameras

You can also use a camera that is sensitive to (near) infrared light, in combination 
with lights of this type, for instance, if you want to analyze people’s facial 
expressions in a cinema or other (near)-dark environments. Please note that such 
cameras are not suitable for vital signs measurements and it is not possible to 
measure heart rate, heart rate variability, and breathing rate with infrared 
recordings.

To get started with the Microsoft LifeCam Studio

Download the drivers (Microsoft LifeCam 5.20.msi) from the MyNoldus portal 
(my.noldus.com). 

IMPORTANT  If you upgrade an older version of the Microsoft LifeCam Studio driver 
to the driver that comes with FaceReader 10, you cannot downgrade it to the old 
driver anymore. 

To get started with the Logitech BRIO, C920, C922, C925e and C930e

The Logitech BRIO, C920, C922, C925ed and C930e do not require driver 
installation. 

See also 

 Camera frame rate and samples in FaceReader

 Camera resolution and analysis in FaceReader

Camera position

It is important to place the camera at a location that will give the most steady 
frontal view of the subject's face throughout the experiment. The ideal position for 
the camera is directly in front of the test participant. If the subject faces a computer 
screen, the camera can be placed either directly above or directly below the screen. 
When placing the camera on top of the monitor, try to position it slightly below eye 
level, either by raising the chair and/or by lowering the monitor. When placing the 
camera below the monitor, lower the chair to position the camera slightly below eye 
level. The classification output may have a small bias towards 'angry' when the 
camera is placed on top of the monitor and a small bias towards 'surprised' when 
the camera is placed below the monitor. This is due to the fact that people tend to 
tilt their head when showing these emotions. If that is a problem, you can 
compensate for it by calibration. 

See Calibrate FaceReader
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Image brightness and contrast

It is important to adjust your camera to provide images with a good contrast and 
brightness. You can adjust the contrast and brightness by adjusting the hardware 
settings using the software provided by the manufacturer of your camera. When 
adjusting your hardware settings, do not pay attention to the lighting of the 
background. Focus only on the face area of the image and ignore a very light or 
very dark background. 

Do note that for the Vital Signs Module, slightly different camera capture settings 
apply. See Introduction to Vital Signs for more information.
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The picture above is an example of a face image showing a good contrast and 
lighting. Dark areas of the face (such as the eyebrows and the pupils) are near-black 
and the lightest part of the face (the eye whites) are nearly white. The intensity 
histogram (made of the face area only) shows how the intensity values fill the whole 
spectrum.

The face area of the image below is overexposed. The forehead and cheekbones are 
nearly white and show very little texture. 
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The histogram shows how only the high intensity part of the spectrum is filled. 
Decrease the brightness by adjusting the hardware settings of your digital camera 
or decrease the aperture size of your analog camera to correct this problem.

A very common problem is that the image has too little contrast.
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Especially when the background is very dark or very light and the camera is set to 
'automatic', the face area of the image will have a very low variability in intensity (a 
low contrast). The contrast is too low when the face area of the image contains no 
bright white and no deep black pixels. The intensity histogram shows that only the 
middle section of the spectrum is filled. Correct this problem by adjusting your 
camera (increase the contrast).

When working with a person with a dark or very pale skin color, you may need to 
make some extra adjustments. The default settings will often yield an image as 
shown below. Although there are both dark areas and white areas (the eyes) in the 
face, the skin itself shows too little variations in intensity. By increasing the 
brightness (to make the face lighter) and increasing the contrast (to increase the 
variation in skin tones) you can correct this problem. For people with a very pale 
skin, decrease the brightness and contrast.

The corrected image should look similar to the image below. Pay special attention 
to the skin tones.
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Notes

 IMPORTANT Changing the brightness and/or contrast of an already recorded 
video or an image will have little or no effect on the quality of the analysis. 
The procedure above can only improve FaceReader's performance when 
applied at the moment the video is made.

 It is not possible to view intensity histograms in FaceReader. To view such 
plots, use graphics software like Paint.NET or Photoshop. To analyze video 
images, first make a screenshot of the image of interest.

 To assess the quality of your (video) image, view FaceReader's model quality 
bar.

See one of the following:

- Step 3 in Manual procedure image analysis in Analyze facial expressions

- Step 3 in Manual procedure video and camera analysis in Analyze facial 
expressions

See also

 Camera frame rate and samples in FaceReader

 Camera resolution and analysis in FaceReader

Lighting setup

A good lighting setup is vital to get a good image. Diffuse frontal and natural 
lighting is desirable. The light intensity or color is less relevant. Strong shadows or 
reflections should be avoided. If possible, place the FaceReader setup in front of a 
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window. Make sure that any windows to the sides of the subject are blinded. Lights 
from the ceiling, common in most buildings, will produce shadows below the 
eyebrows and nose. In situations where interior lighting cannot be controlled, 
stronger lights (e.g., professional photo lights) can be used to negate the effect of 
other, undesirable, light sources. You can purchase such lights from Noldus IT. You 
can also use (near) infrared light, in combination with a camera that is sensitive to 
this type of light.
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Set up your project

Main topics

 Start FaceReader

 Project management

 Add your test participants

 Add analysis input

 Project wizard
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Start FaceReader
Aim

To start working with FaceReader. 

Procedure

The procedure depends on your license type. You may either have:

 A software license key.

 One or more hardware keys.

Activate FaceReader with a software license key 

1. Start FaceReader, select the option Activate software license key and click 
OK.

2. Select either Floating or Fixed and click OK.

What is the difference between a Floating and a Fixed activation?

When you have a software license key you can choose between a Floating and a 
Fixed activation.
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 Floating activation — Choose this option if you want to be flexible on 
which computer you use FaceReader. If you bought, for instance, a software 
key with two licenses, you can simultaneously use the software on, for 
instance, the FaceReader computer in your lab and on the computer in your 
office. If your student wants to use FaceReader as well (on his/her personal 
laptop) then this is possible. You can install and activate FaceReader on as 
many computers as you want but with two licenses you can use the 
software only on two PCs at a time. If you want to use FaceReader on a third 
PC the software should not be running on one of the other two PCs. Please 
note that a computer must have an internet connection to activate and 
work with a Floating license.

 Fixed activation — A Fixed activation is linked to one computer. The 
advantage of having a Fixed activation is that you do not need an internet 
connection to work with the software. If you bought a software key with, for 
instance, two licenses, you can activate FaceReader on two computers (if 
you choose ‘Fixed’ for both licenses). If you want to use FaceReader on a 
third computer, you have to deactivate one of the licenses and activate it on 
the new computer (either as Fixed or as Floating). See Deactivate your 
FaceReader license for more information. Please note that a computer must 
have an internet connection to activate/deactivate a Fixed license. After you 
have activated the license you can use FaceReader without internet. 
Alternatively, you can activate/deactivate your license using your 
smartphone.

Activate your floating license

Enter your Activation key and click OK. The software now opens.
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Activate your fixed license in an online mode

Activate your fixed license in an offline mode
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Enter the Activation key that you received with the software and select

 Activate Online if the PC is connected to the internet. When you click OK 
the FaceReader software opens.

 Activate Offline if the PC does not have an internet connection. Scan the 
QR code with your smartphone and click WEB. Copy the Computer key 
shown on your smartphone to the Computer key field on the FaceReader 
PC and click OK. The FaceReader software opens.

If you have a hardware key

1. Plug the key into a USB port on your computer. If the hardware key is cor-
rectly connected, a red light is visible inside the key. 

2. Now start FaceReader. Keep the key inserted in your computer while you 
work with FaceReader.
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IMPORTANT  The hardware key is your FaceReader license. This is an important piece 
of equipment. It is sensitive and can be easily damaged. Please be careful with the 
hardware key and make sure you do not lose it. You will need to pay for a new 
license if you do so. 
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Deactivate your FaceReader license
Aim

 To use your Fixed FaceReader license on another computer. 

 To change a Fixed FaceReader license into a Floating license.

 To make sure that FaceReader cannot be used on a certain computer.

IMPORTANT If you want to uninstall FaceReader, first deactivate the license 
otherwise you will lose it. Please contact Noldus Technical Support if this happened.

Procedure

Deactivate your floating license

1. From the Help menu select License and then Deactivate.

2. You will get a message that your license key was successfully removed and 
that FaceReader will exit. Click OK to close the software.

Deactivate your fixed license

From the Help menu select License and then Deactivate and select 

 Deactivate Online if the computer is connected to the internet. You will get 
a message that your license key was successfully removed and that 
FaceReader will exit. Click OK to close the software.

 Deactivate offline if the computer does not have internet connection. Scan 
the QR code with your smartphone. Click OK to deactivate the license on 
the PC. You will get a message that your license key was successfully 
removed and that FaceReader will exit. Click OK to close the software. 
Follow the QR code link on your smartphone within 24 hours to deactivate 
your license on the Noldus server.You can also first deactivate your license 
on the Noldus server and then select the checkbox in the window on your 
PC to deactivate the license on your PC.
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Project management
What do you want to do?

 Read about Projects

 Create a project

 Save a project

 Back up a project

 Read about The Project Explorer

Projects

A project groups all the data belonging to one experimental set-up. Your project 
contains the persons who participated in the experiment, their personal details 
(name, gender and age and other characteristics that are important for your 
research), the videos, and the analysis results. 

The project may also contain Stimuli, Event Markers, Tests and Independent 
Variables. 

Create a project

1. Do one of the following:
- Choose File > New > Project. 
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- In the startup window, under Create a new project, choose New project. 

2. Give the project a name and select a location to store it, or accept the 
default location.

3. Continue with Add your test participants

Save a project

 To save a project, choose File > Save or press Ctrl+S.

 To save a copy of the project with a different name, choose File > Save As 
or press Ctrl+Shift+S.

IMPORTANT  This does not make a copy of the video files and the saved log 
files. To create a copy of the project with all the videos and log files, see 
Back up a project

Note

IMPORTANT  Never shut down the computer by pressing the power button, or 
cutting off the electricity. Your project data may become lost, even after you saved 
your project. Always use the Windows shut down feature to close your computer. 

Back up a project

IMPORTANT  If you use the Save As option, the video files and the saved log files are 
not copied. To create a copy of the project with all the videos and log files:

1. Choose File > Project Backup > Copy Media to Project Folder.
This makes all the paths in the project relative, so you can copy the entire 
project to another location. 

Copy the Stimulus videos to the project folder as well. Choose File > 
Project Backup > Copy Stimuli to Project Folder. 

2. Choose File > Open Project Folder. This opens the project folder in 
Windows Explorer. 

3. Select the contents of this folder and copy it. 

4. Paste this to the backup location, for example a network drive or an 
external harddisk. 

Notes

 Please be aware that video files are generally very large, so make sure the 
computer with the project folder has enough disk space.
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 Create a backup of your project at least once a day and store it in a safe 
location, for example on a network, or an external hard drive in another 
building. If you record videos from the test participants’ faces, create 
backups of these videos as well.

The Project Explorer

The Project Explorer is present on the left side of your screen. It displays the test 
participants and analyses currently in the project. Expand or double-click elements 
to view more details. The Multi-Subject Sources tab is only visible if your license 
includes the Advanced Research Module.
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Show/hide the Project Explorer

To create more space on your screen for the analysis, you may want to hide the 
Project Explorer. To do so, click the Hide button in the top-right corner of the 
Project Explorer. 

To restore the Project Explorer, click the Project Explorer button. 

The Project Explorer has a window with four tabs at the bottom of your screen: 

 Stimuli – See Define Stimuli in Project Analysis

 Event Markers – See Define Event markers in Project Analysis

 Independent variables – See Define Independent Variables in Project 
Analysis

 Tests – See Define a test in Project Analysis
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Add your test participants
Aim

To define the test participants in your study. FaceReader organizes the data per test 
participant. You can enter participants automatically, or manually. 

Add participants automatically

With a basic FaceReader license

If you know before you create your project how many participants and analyses per 
participant your project will contain, you do not need to enter them manually. Use 
the Project wizard instead. 

With the Stimulus Presentation Tool

With Project Analysis and The Stimulus Presentation Tool, each participant is added 
automatically to the project when he/she starts a test. You do not have to add 
participants manually.

See Carry out a test with the Stimulus Presentation Tool

Add participants manually

1. Do one of the following for each test participant in your study:
- Choose Participant > Add Participant.

- Click the Add Participant button on the toolbar.
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2. In the Name field, enter the participant’s name or, for example, a number.

3. Two Independent Variables, Age and Gender, are present by default. 
FaceReader automatically estimates the age and gender of the participant 
from the video, camera input or image. 

To set the age or gender manually, click the pencil button and enter the 
correct value. Enter integer values for age, for example 40, not 40.5. 

Notes

 To edit a participant, double-click its name and edit the details.

 To delete a participant, make sure all its analyses are closed. To close an 
open analysis, click the button next to it. 

Right-click the participant’s name and select Delete Participant. 
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 You can define extra Independent Variables. If you do so, also enter the 
values for these variables in step 3. 

See Define Independent Variables

 If you set the participant’s gender or age manually, these are fixed with 
these values in the Circumplex Model of Affect and are not estimated by 
FaceReader.
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Add analysis input
Aim

To define the videos, camera output, or images that FaceReader must analyze for 
each participant. 

Prerequisite

You added at least one participant. 

See Add your test participants

Before you start

If you want to use Settings other than the default ones for your analyses, choose 
them before you add all analyses. If you, for example, work with Asian test 
participants, change the default face model to EastAsian before you add the 
analyses. 

See Choose settings

Add analysis input

With the Project Wizard

If you know before you create your project how many participants and analyses per 
participant your project will contain, you do not need to enter them manually. Use 
the Project wizard instead. See Project wizard for more information. 

With the Stimulus Presentation Tool

With The Stimulus Presentation Tool, the analysis is added automatically to the 
project when a participant starts a test.

See Carry out a test with the Stimulus Presentation Tool

Add analysis input manually

1. Do one of the following:
- Right-click a participant name and choose Add Analysis > Video, 
Camera, or Image. 
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- Select the participant for which you want to add an analysis. Click the 
Video, Camera or Image button on the toolbar to add a video file, a live 
video source or images.

 

2. Select and open the input source. 

If you carry out camera analysis, select the Resolution and the Frame rate. 

See also:

- More information on camera analysis

- Camera resolution and analysis in FaceReader

Select the Use as Default Camera check box if you want FaceReader to 
automatically select the current camera for future camera analysis sessions. 

A new analysis is added to the Project Explorer. The video, camera or 
images icon indicates what type of analysis it is. 

3. Repeat steps 1 and 2 to add more video files, images or live video sources.

You are now ready to start an analysis. 

See Analyze facial expressions

See also More information on camera analysis
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Notes

 To edit an analysis, right-click the analysis and select Edit Analysis and 
make your choice. 

 To delete an analysis, make sure it is closed. To close an analysis, click the 
button next to it. 

Right-click the analysis and choose Delete analysis. 

 To add multiple video files to your project, right-click the participant name 
in the Project Explorer and select Add Multiple Video Analyses.

 If your project contains image analyses you cannot add video or camera 
analyses and if your project contains video or camera analyses you cannot 
add an image analysis.

 If you carry out a camera analysis, or video analysis, do not carry out very 
long analyses/use long recordings. Especially if you export many different 
data, like facial states, Action Units, Stimuli and Event markers, these files 
get very large, which may cause performance problems. FaceReader has 
been tested and works well with camera analyses of two hours and video 
analyses of two hours with 15 fps and one hour with 30 fps. When you open 
a video that is longer than one hour, FaceReader shows a warning.
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More information on camera analysis
What information are you looking for?

 Supported cameras

 Default camera

 Camera frame rate and samples in FaceReader

 Camera resolution and analysis in FaceReader

 Video format

 Camera analysis with an IP camera

Supported cameras

See Camera and accessories in Installation 

Please also read the sections below about video frame rate and resolution. 

Default camera

If you always use the same camera for camera analysis, set this camera as the 
default one. 

1. Choose File > Set Default Camera. 

2. Select your camera. This camera will be automatically selected in future 
analyses. 

Camera frame rate and samples in FaceReader

When you record video from a live camera image, the resulting frame rate of the 
video file is the chosen camera frame rate. See step 2 in Add analysis input 
manually.
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Camera resolution and analysis in FaceReader

FaceReader analyzes (video/camera) images with a maximum resolution of 1280 x 
1280. If the resolution of your video file, camera, or images is higher than 1280 x 
1280, FaceReader scales it down while maintaining the aspect ratio. Using a higher 
resolution than 1280 x 1280, therefore, does not improve analysis. Also, using a 
higher resolution slows down the analysis. 

Video format

The video file format of the recorded video is DivX/MP4V. This format is compatible 
with The Observer XT. 

To play back a DivX video on a computer without FaceReader or The Observer XT, it 
may be necessary to install a DivX player. 

Camera analysis with an IP camera

IMPORTANT  FaceReader works with IP cameras that create MJPEG or JPEG output. 
FaceReader does not work with RTSP output of IP cameras. 

To select an IP camera, follow the steps below:

1. In the Select Camera window, under Select Camera, choose IP Camera. 

2. Under Source URL, enter the source URL of your camera. 

Check the documentation of your camera or contact the service 
department of your camera brand for the correct URL. 

For Axis IP cameras, enter one of the following:

- http://IP address camera/mjpg/video.mjpg

- http://IP address camera/axis-cgi/mjpg/video.cgi

3. Under Frame rate, select the frame rate (default: 5 fps).

4. If your camera is password-protected, select Secured and enter the 
Username and the Password.

For Axis IP cameras supplied by Noldus, enter root and Noldus, respectively.

5. Select either JPEG or MJPEG.

Check in the documentation of the camera what type of stream the camera 
produces (JPEG or MJPEG).

Choose MJPEG for Axis IP cameras.
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6. Select Use as Default Camera if you want FaceReader to automatically 
select the current camera for future camera analyses.

The camera view appears in the Preview image window.
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Project wizard
Why a project wizard?

If you know before you create your project how many participants and analyses per 
participant your project will contain, you can automate adding them. 

Also use the project wizard if you created many videos, or images and stored them 
in a structured way. For example, you created a folder per participant and each 
participant folder contains a number of folders and subfolders that contain the 
videos or images to analyze. You can use this folder and file structure to make a 
template and create the participants and analyses automatically. 

With a project wizard template it is also possible to read the age and gender from 
the file names and enter these values as independent variables for the participants. 

See Video and image formats which file formats can be used with the project 
wizard.

See:

 Define Project Wizard manually

 Define project wizard with the folder structure of the video or image files
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Define Project Wizard manually
Aim

To automate adding a large number of participants or analyses. You define how 
analyses are organized in the Project Explorer. To assign videos to analyses 
automatically, follow the topic Define project wizard with the folder structure of the 
video or image files instead. 

Prerequisite

You have a large number of participants, or analyses.

Procedure

1. Choose File > New > Project Wizard.

2. Give the project a name, select the location to store it, and select whether 
you want to carry out video, camera or image analysis from the Source 
type list. 

3. Select Manual.

4. Select the No. of participants and the No. of Analyses per participant. 

5. If you have chosen Camera as Source type, also select the camera under 
Default camera. 

The Project Preview on the right displays the project structure.
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6. Click OK. 

7. Open each analysis to browse to the video, or image, or select the camera 
and carry out analysis. 
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Define project wizard with the folder 
structure of the video or image files
Aim

To automate adding a large number of participants or analyses. The videos or 
images are automatically assigned to analyses. 

Prerequisites

 You have a large number of participants, or analyses.

 You want to analyze videos or images.

 The videos or images of the test participants are stored in a structured way. 
For example, the videos of the different participants are stored in separate 
folders. 

Procedure

1. Choose File > New > Project Wizard.

2. Give the project a name, select the location to store it and select Video, or 
Images from the Source type list. 

3. Select From file structure. 

The Project Preview window displays the project structure with the 
selected options.

4. Under Path, select the root of the folders where your videos or images are 
stored.

5. Under Predefined Templates, select one of the following:

- one of the Predefined templates

- Custom template — Use the building blocks under Choose File 
Template Parts to create your custom structure. See Custom template

6. Click OK when ready.
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Predefined templates

The File template field shows the building blocks used for this template. For an 
explanation of the building blocks, see Custom template.

Add all videos to a unique participant 

File template <WildCard>.<WildCard>

Each video found in the folders and subfolders will be added as analysis to a 
separate participant. Participants will be named Participant 1, Participant 2, etc. The 
analyses will be named Analysis 1. Video location plays no role here.

Example: 
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Folder equals participant name

File template <ParticipantName>\<WildCard>.<WildCard>

Each video found in the folders and subfolders will be assigned as analysis to a 
separate participant. Each participant will get the name of the folder where the 
video was found. Note that this results in the same person being represented by 
several “participants” in FaceReader. All analyses will be named Analysis 1.

Example
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Folder equals unique participant name

File template <UniqueParticipantName>\<WildCard>.<WildCard>

Each participant will get the name of the folders found in the root folder. Each 
participant name will only be used once.

If more videos are found in the same folder, these will be added as analyses to the 
same participant. The analyses will be named Analysis 1, Analysis 2, ....etc.

Example (different colors represent different levels of organization): 
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Folder equals participant index

File template<ParticipantIndex>\<WildCard>.<WildCard>

In case your folders have numbers instead of letters. Each participant will get the 
folder number and the videos in this folder or subfolders are assigned as analyses 
to this participant. The analyses will be named Analysis 1, Analysis 2, ....etc

Example (different colors represent different levels of organization):
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Folder equals participant index, subfolders equal analysis index

File template <ParticipantIndex>\<AnalysisIndex>\<WildCard>.<WildCard>

Use this template when your folders and subfolders have numbers instead of 
letters. Each subfolder may contain only one video file. Each participant will get the 
number of the folder directly under the root folder specified in the Path field. Each 
analysis will get the number of the subfolder and the name of the file.

Example (different colors represent different levels of organization):



91

Custom template
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To create your structure, click one or more items under Choose File Template 
Parts.

 Use a slash (\) to indicate a new folder.

 Use a dot (.) to separate the filename from the extension. 

ParticipantIndex

For folders and files with numerical names. Uses the folder numbers for the 
participants numbers.

UniqueParticipantName 

Uses the folder or file names for the participant names. Each participant name will 
be used once. 

ParticipantName 

Uses the folder or file names for the participant names. Different participants can 
have the same name. 

ParticipantAge

Reads the participant age from the file name and enters this as category for the 
independent variable Age. 

Example: file name is 32_male_commercial 1.avi 

Use building blocks <ParticipantAge>_<Wildcard>.<Wildcard>

ParticipantGender 

Reads the gender from the file name and enters this as category for the 
independent variable Gender. 

Example: file name is 32_male_commercial 1.avi

Use building blocks: <Wildcard>_<ParticipantGender>_<Wildcard>.<Wildcard>

You can also combine ParticipantAge and ParticipantGender in the following way:

 <ParticipantAge>_<ParticipantGender>_<Wildcard>.<Wildcard>

AnalysisIndex

For subfolders or files with numerical names. Each subfolder may contain only one 
video file. Uses the folder numbers for the analysis names.

Wildcard 

Allows any character.
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Analyze facial expressions

Main topics

 Choose settings

 Analyze facial expressions

 Calibrate FaceReader

 Additional options
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Choose settings
Aim

 To choose settings that are valid for all future analyses, for example to 
choose the Video frame rate — See Settings for all future analyses

 To adjust some settings for the analysis that is open on your screen, for 
example to choose the Active Face Model — See Settings for the current 
analysis

Set default or current analysis settings for the following:

 Face model – see Active Face Model

 Calibration – see Calibrate FaceReader

 Smoothen classifications – see Classification

 Image rotation – see Rotation

 Video sample rate – see Video

Settings for all future analyses

1. Choose File > Settings >Default Analysis Settings. 

2. Specify the settings. 

See Default Analysis Settings for an explanation of the options. 
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Note

The Default Analysis Settings do not apply to already existing analyses. To apply the 
new settings to an existing analysis, select Settings for the current analysis and redo 
the analysis.

Settings for the current analysis

1. Open the analysis by double-clicking it in the Project Explorer or clicking 
the magnifying glass button next to it. 

2. Select the Analysis Settings by clicking the Settings button on the bottom 
of your screen. 

3. Click the pencil next to a setting to edit it. 

See Default Analysis Settings for an explanation of the options. 

Note

You can only select Continuous calibration if you first set the Selected calibration 
to None. 
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Analyze facial expressions
Aim

To carry out the FaceReader analyses.

Prerequisite

You checked the Analysis settings by clicking the Settings button on the bottom 
of your screen. Make sure you selected the correct Face Model. See Active Face 
Model

See Choose settings

Which procedure are you looking for? 

 Automatic analysis procedure

 Manual procedure image analysis

 Manual procedure video and camera analysis

 Optional classifications

With the Advanced Research Module you can analyze multiple faces in a video 
simultaneously. See Analyze multiple subjects per video.
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Automatic analysis procedure
With the Project Analysis and The Stimulus Presentation Tool, analysis is carried out 
automatically when the participant starts a test. You do not have to start and stop 
analysis manually. 

See Carry out a test with the Stimulus Presentation Tool in Project Analysis
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Manual procedure image analysis
Aim

To analyze facial expressions from images.

Prerequisites

 You created a participant for each person. 

See Add your test participants

 You created at least one image analysis for every participant. 

See Add analysis input 

Procedure

1. Optionally, select more than one image in an analysis and select Analyse all 
images to analyze all images of the participant at once. 

2. Click the Start analysis button. 

The track bar shows a dot in the color of the dominant expression for each 
image. When you hover with your mouse over the dot, the filename of the 
image and the dominant facial expression are shown.
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Check the Model quality bar for the analysis quality. The green bar should 
cross the dashed line. 

3. To export analysis results, choose File > Export and select to export the 
results of the analysis, participant, or the entire project. 

See Export analysis results
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Manual procedure video and camera 
analysis
Aim

To analyze facial expressions from video, or live from camera images. 

Prerequisites

 You do not carry out analysis with The Stimulus Presentation Tool. When 
you use the Stimulus Presentation Tool, the analysis starts when the 
participants starts a test. 

 You created at least one participant.

See Add your test participants

 You created at least one video or camera analysis for every participant. 

See Add analysis input 

Procedure 

1. For Video analysis – Position the video to where you want to start the 
analysis. 

2. Click the Start analysis button at the bottom of your screen. 

The track bar shows the progress of the analysis, the analysis speed (in fps), 
the running end time of the analysis, the end time of the video and whether 
the video has audio.
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3. During analysis, check the Model quality bar in the Analysis Visualization 
window. It should look like the one below, the colored bar must cross the 
dashed line.

You can adjust the model quality, see Minimum model quality

If the quality of your camera image is not good enough, the text Could not 
find a face or Could not classify the face (FaceReader cannot model the 
face) will appear in the Analysis Visualization window. Probably either the 
lighting of the test person's face or the position of the camera is not 
optimal. 

See Camera and accessories how to improve your setup.

4. Click the Stop Analysis button to stop the analysis. 

5. Video analysis – to analyze more episodes, move the video to a new 
position and click the Start analysis button again. The analyzed episodes 
are shown on the track bar.
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IMPORTANT  The data of all the analysis intervals are saved in one log file. 
The text Not Analyzed will appear in the log file for the time points that 
were not analyzed. This can result in very big files.

6. To export analysis results, choose File > Export and select to export the 
results of the analysis, participant, or the entire project. 

See Export analysis results

Notes

 By default, videos are processed frame-by-frame. To speed up the analysis, 
change the sample rate. 

See Video

 To carry out all video analyses at once, press the Start batch analysis 
button on the toolbar of the project explorer. Please see the tips on 
Improving FaceReader’s performance which are especially important when 
using batch analysis.

 To redo an analysis, click the Clear results button and start the analysis 
again. 

Exported log files will not be deleted.
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 When you run a camera analysis, a new video frame is analyzed when the 
analysis of the previous frame is finished. If detection is demanding, the 
number of frames being analyzed per second may be lower than the 
camera frame rate. In this case FaceReader skips a frame to keep up with 
the camera frame rate. After the analysis is finished, FaceReader 
interpolates the results in the skipped frames to the frame rate of the 
recorded video.

See also Camera frame rate and samples in FaceReader in Set up your 
project

 When you run a video analysis, the average frame rate may be lower than 
that expected from the frame rate of the video file. For example 27 fps 
when the video frame rate is 30 fps and you set to analyze every frame. In 
that case video plays slower than 1x during analysis, but all frames are 
analyzed.

See also: 

- Speed up analysis

- Video in Settings

- Sample rate in Settings

 To analyze part of the video image, for example because your video 
contains multiple faces and you only want to analyze one of them, click the 
Select area of interest button.

The Draw the selected area window opens. Drag a window around the 
face that you want to analyze.
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Either click the Apply button to start analyzing the selected face or the 
Reset selected area button to delete the selected area and draw a new one.

 You can analyze multiple faces in a video with the Advanced Research 
Module.

 To increase the speed and the accuracy of analysis, FaceReader uses 
information from previous frames to analyze the current frame. For 
instance, if in the previous frame FaceReader could correctly model the 
face, a re-detection is not required, because FaceReader already knows the 
location of the face. Information about previous frames is also used to 
smooth the output of FaceReader. These enhancements lead to much faster 
analysis, and it also allows the face modeling algorithm to better fit the face 
in the image. A side effect of this is that results depend on the start position 
used.

 If you re-analyze the video of a camera analysis and notice that the video is 
not analyzed.
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Optional classifications
Aim

To select other analyses in addition to facial expressions.

FaceReader can, optionally, analyze the following:

 Contempt

 Facial states

 Gaze tracking 

 Action Units (if you have The Action Unit Module or you have Baby 
FaceReader)

 Custom Expressions (if you have the Action Unit Module or you have Baby 
FaceReader)

 Heart rate, heart rate variability (by means of Remote PPG), and breathing 
rate (if your license includes The Vital Signs Module)

 Consumption Behavior (if you have The Consumption Behavior Module, not 
available with Baby FaceReader)

 Expressions in the voice (if your license includes the Voice Analysis Module. 
Note this feature is not available with Baby FaceReader)

Note

Each optional classification decreases analysis speed, so only select the options you 
require. 

Procedure

To select these optional classifications, choose File > Settings. Click the Analysis 
Options tab, and make your selection under Optional Classifications. 



105

Contempt

Contempt is an expression in which one corner of the lips is tightened and slightly 
raised. It can be classified reliably in different cultures [1]. Some authors state that it 
should be added to the six basic emotions defined by Paul Ekman [2]. However, 
other authors disagree with this [3].

To add contempt to the expression states, select the option Treat contempt as an 
emotional state. This adds contempt to the State Log and Timeline and makes 
contempt mutually exclusive with the other emotions in the State Log and Timeline, 
meaning that only one emotional state can be active at any given time.
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Facial states

FaceReader can detect whether the left and right eye is open or closed, whether the 
mouth is open or closed and whether the eyebrows are raised, neutral or lowered. 
These states are shown in the Facial States window. They are also visualized in the 
Analysis visualization window, when the option Show facial states is selected. 

Gaze tracking

FaceReader can detect the test participant’s Gaze Direction, Gaze Type and Gaze 
angles. Gaze direction indicates whether the participant looks to the left, left-up, 
left-down, or to the right, right-up or right-down, Up, Down or Forward. Gaze Type 
indicates whether the test participant’s eyes fixate on something (that is, the eyes 
are still and looking at, for instance, the eyes in a face) or whether there is 
movement of the eyes when the test participant shifts his/her focus of vision (a 
saccade). In addition, FaceReader measures the horizontal and vertical Gaze angle 
over time. 

If your license includes the Advanced Research Module you can view the test 
participant’s gaze overlay on the stimuli that you present with the Stimulus 
Presentation Tool. See Run a test in Project Analysis.

Gaze direction, Gaze Type and Gaze angles are shown on the Timeline. Gaze 
Direction is also visualized in the Analysis Visualization window, when the option 
Show global gaze direction is selected.
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If the Show global gaze direction button is not active, select File > Settings > 
Analysis Options and under Optional Classifications select Gaze tracking.

Action Units

FaceReader can analyze Action Units from the Facial Action Coding System (FACS) 
published by Ekman and Friesen (1978), if you have The Action Unit Module or you 
have Baby FaceReader. The Affective Attitudes Interest, Boredom and Confusion 
that were called Affective Attitudes in FaceReader 7.1, are now available as Custom 
Expressions. You can also define your own Custom Expressions.

Heart rate, heart rate variability, and breathing rate

FaceReader can analyze the heart rate, heart rate variability and breathing rate of 
the test participants, if your license includes The Vital Signs Module.
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Consumption Behavior

With the Consumption Behavior Module you can determine whether your test 
participants are chewing or taking a bite or sip. This option is not available with 
Baby FaceReader.

See The Consumption Behavior Module

Expressions in the voice

With the Voice Analysis Module you can analyze emotions in the voice (Neutral, 
Happy, Sad and Angry), and Valence and Arousal from the voice. FaceReader can 
also assess the Loudness and Speech rate. Voice analysis is not available with Baby 
FaceReader.
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Calibrate FaceReader
Aim

To correct for person-specific biases in facial expressions, for example if someone 
looks angry or sad by nature. Instead of calibration you can also use a Stimulus to 
score an episode in which your test participants have a neutral expression and carry 
out relative analysis. See Select absolute or relative values for your parameters.

Prerequisites

 You have the regular version of FaceReader. Calibration is not available in 
Baby FaceReader.

 You notice a person-specific bias in facial expressions. If there is no such 
bias, we recommend not to use calibration since it may then decrease 
analysis accuracy. 

 You first checked whether changing the camera, or lighting conditions 
removes the bias.

Two calibration methods

FaceReader has two calibration methods

 Participant calibration — Use this method if you analyze videos or images. 
Also use this method if you do camera analysis and the experimental setup 
allows capturing a neutral phase before the experiment starts. 

See Participant calibration

 Continuous calibration — Use this method if you carry out camera analysis 
and the experimental setup does not allow capturing a neutral phase 
before the experiment starts. This is for example the case if you start 
FaceReader automatically with another program. 

See Continuous calibration
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Participant calibration
Aim

To correct for person-specific biases in facial expressions. 

Prerequisite

You have a video fragment, or images in which the expression of the test participant 
was neutral. Alternatively, if you carry out camera analysis, you are able to record a 
scene during which the test participant looks neutral. Please note that you need at 
least 100 images for the calibration.

See also How participant calibration works

Procedure

1. Create a participant calibration

2. Select a participant calibration

Create a participant calibration

1. Make sure all analyses of the participant are closed. To close an open 
analysis, click the button next to it. 

2. Do one of the following:

- Choose Participant > Calibrate Participant. 

- Right-click the participant and choose Calibrate Participant. 

3. Select the Face Model. 

See Active Face Model

4. Choose the calibration source:

Images – Select the files in which the participant looks neutral.

Video – Select the video file and scroll to the part where the test participant 
looks neutral.
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Camera – Ask the test participant to look neutral. 

5. Click the Start analysis button. When the calibration is created, the 
Calibration Effect field shows the facial expressions before and after 
calibration. 

6. When you are satisfied with the calibration, give it a name and click OK. 
FaceReader asks whether you want to use this calibration for all future 
analyses of this participant. Choose Yes if you want this. 

If you are not satisfied with the calibration, click the Retry with same 
source button and repeat step 5.

Notes

 If you chose to use the calibration for all new analyses of this participant in 
step 6, the calibration is selected automatically in all new analyses of that 
participant. For the already created analyses you must select the calibration 
manually and redo the analysis. 

 To change a calibration for a participant, select the new one, choose 
Participant > Set calibration as default. 

 To delete a participant calibration do one of the following:

- Choose Participant > Delete calibration. 

- Unfold the participant item in the Project Explorer. Then right-click the 
calibration and choose Delete calibration. 
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Select a participant calibration

IMPORTANT  Use the same Face model (see Active Face Model) in the analysis, as was 
used to create the calibration. To use another face model, first create a new 
calibration with this model. Then do one of the following: 

 Select the calibration for a specific analysis

 Select the calibration automatically for all future analyses of a participant

Select the calibration for a specific analysis 

1. Make sure that continuous calibration is set to No in the Analysis settings 
window on the bottom-left of the analysis part on your screen.

2. Click the pencil button next to Selected calibration and select the 
calibration from the list.

Select the calibration automatically for all future analyses of a participant

1. Open the Participant item and then the Calibrations item in the Project 
Explorer. 

2. Right-click the calibration and select Set Calibration as Default.
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How participant calibration works
If you use images for calibration, FaceReader searches for the image with the lowest 
model error. If you use camera or video analysis, FaceReader analyzes two seconds 
and uses the image with the lowest model error for calibration. 

Correcting expression intensities

FaceReader corrects each expression other than neutral in the following way:

Corrected Expression intensity = max (0, (Ia - Ic))/ (1-Ic)

Where Ia is the intensity of that expression in the analysis and Ic is the intensity of 
that expression found in the calibration. If (Ia - Ic)/ (1-Ic) is lower than zero, the 
calculated expression intensity will be zero.

You can find the Ic values in the header of the Detailed log file.

Correcting the intensity of Neutral

The intensity of Neutral is calculated in the following way:

Corrected Intensity Neutral = (Na + (1- Imax)))/2

Where Na is the intensity of Neutral classified by FaceReader and Imax is the 
intensity of the expression with the highest intensity, excluding Neutral and 
Contempt. 

Example

Consider the following expression intensities:

 Neutral = 0.6

 Happy = 0.9

 Sad = 0.1

 Angry = 0

 Surprised = 0

 Scared = 0

 Disgusted = 0

This gives an lmax of 0.9

And a corrected intensity of Neutral of: 
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Corrected Intensity Neutral = (0.6 + (1 - 0.9)) / 2 = 0.35
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Continuous calibration 
Aim

To correct for person-specific biases in facial expressions if you do not have images 
during which the test participant looks neutral. 

Procedure

1. Open the analysis for which you want to use continuous calibration. To 
open an analysis, double-click it in the Project Explorer, or click the 
magnifying glass button next to it.

2. Click the Analysis settings button at the bottom of your screen to open 
the Analysis settings window.

3. Click the pencil button next to Selected calibration and select None. 

4. In the same window, click the pencil button next to Continuous calibration 
and select Yes. This sets the Selected calibration field to Disabled.
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How continuous calibration works
FaceReader continuously averages the facial expression intensities in the analysis. 

Correcting expression intensities

With Continuous calibration, Facereader corrects each expression intensity other 
than neutral in the following way:

Corrected expression intensity = max (0, (Ia - Im))/ (1-Im).

Where Ia is the intensity of that expression in the current frame and Im is the 
average intensity of that expression over all frames before the current frame. If (Ia - 
Im)/ (1-Im) is lower than zero, the calculated expression intensity will be zero. 

Correcting intensity of Neutral

The intensity of Neutral is calculated in the following way:

Corrected Intensity Neutral = (Na + (1- Imaxm))/2

Where Na is the intensity of Neutral classified by FaceReader in the current frame 
and Imaxm is the average intensity of the expression with the highest average 
intensity in all the frames before the current one, excluding Neutral and Contempt. 

Example

Consider the following average expression intensities:

 Neutral = 0.6

 Happy = 0.9

 Sad = 0.1

 Angry = 0

 Surprised = 0

 Scared = 0

 Disgusted = 0

This gives an lmaxm of 0.9

And a corrected intensity of Neutral of: 

Corrected Intensity Neutral = (0.6 + (1 - 0.9)) / 2 = 0.35
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Additional options
What do you want to do? 

 Look for analysis information

 Recover analyses after an interrupted batch analysis

 Speed up analysis

 Move an analysis to another participant

Look for analysis information

Open the analysis.

Settings

Click the Analysis settings button to view the settings for the current analysis. 
Most fields are editable. 

See Settings for the current analysis

Source Details

Click the Source details button to view information on the source of analysis, that 
is, the video file name, its location, duration, number of frames, frame rate, 
resolution and bitrate or in case of a camera analysis the camera name, its frame 
rate and resolution.
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Track bar

The Track bar at the bottom of the screen shows the following information:

 Video analysis — Progress of the analysis, the analysis speed (in fps), the 
running end time of the analysis, the end time of the video and whether the 
video has audio.

 Camera analysis — The analysis speed (in fps), the recording time left and 
whether audio is recorded. The maximum camera analysis duration is one 
hour. Please note that it is possible to run a camera analysis without 
recording video/audio.
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Recover analyses after an interrupted batch analysis 

An autosave file is created after each analysis. This is particularly important during 
batch analysis. If, for any reason, batch analysis is interrupted (for example after a 
power failure), you can recover the autosave file by renaming it to the original 
project file name. To do so:

1. Make sure FaceReader is closed.

2. Browse to the project folder and locate the file ~[project name]_Autosave 
(with no extension).

3. Rename the original project file to [project name]_backup.frx.

4. Rename the autosave file to the original project name.

5. Open the project again in FaceReader. There you should find all analyses 
completed before the interruption.

Speed up analysis

Carry out one or more options below to increase analysis speed.

 Select only the option Framing in the Analysis visualization window, or 
close the entire Analysis Visualization window. 

 Close all visualization windows that you are not looking at. Each 
visualization slows down the analysis.

 Analyze every 2nd or 3rd frame instead of every frame. To do so, choose 
File > Settings > Default Analysis Settings. Choose one of the options 
under Video. 

 Carry out only the analyses you require. Selecting Optional classifications 
decreases analysis speed. 

 Do not keep other programs running in the background. 

Move an analysis to another participant

If you have multiple videos of the same participant and you accidentally added 
another participant to the project and added the second, third etc. analysis to the 
new participant, you can combine all the analyses of one participant. Right-click the 
appropriate analysis in the Project Explorer, click Analysis and then Move Analysis 
To Other Participant. Select the target participant and then Yes to confirm the 
move.



122

FaceReader’s output

Main topics

 Manage analysis windows

 Reporting Display

 Export analysis results
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Manage analysis windows
Aim

To change the windows displayed on your screen. 

Prerequisite

You opened an analysis. To do so, click the magnifying glass button next to it. 

What do you want to do?

 Select analysis windows

 Add more analysis windows

 Merge analysis windows

 Reset the analysis window layout

 Read about Common options

 Create a custom visualization with the Reporting Display

Select analysis windows

1. Click the Select window button in the right-corner of one of the analysis 
windows.

2. Select one of the options.
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Face Analysis

You can choose between:

 Action Unit Intensity*

 Circumplex Model of AffectΔΔ

 Expression IntensityΔΔ

 Expression Line ChartΔΔ

 Expression SummaryΔΔ

 Facial States

 Gaze Angles Line Chart

 Head Orientation Line Chart 

 Head Position Line Chart

 Subject CharacteristicsΔΔ

 Valence and Arousal Line Chart
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 Consumption Behavior

 Consumption Behavior Statistics**ΔΔ

Vital Signs

 Heart Beat Chart***

 Vital Signs***

 Vital Signs Line Chart***

Voice Analysis

 Voice Expression IntensityΔ

 Voice Expression Line ChartΔ

 Voice Valence and Arousal Line ChartΔ

 Voice ViewΔ

Analysis Visualization

Custom Expressions Table*

Custom Expressions Line Chart*

Stimulus View

Timeline

* This window is available if you have The Action Unit Module or Baby FaceReader

** This window is available if you have The Consumption Behavior Module

*** This window is available if you have The Vital Signs Module

Δ This window is available if you have The Voice Analysis Module

ΔΔ Not available with Baby FaceReader 

Notes

 When you choose a visualization that is already open in another window, 
the other window closes. 

 Each facial expression has a fixed color which is the same in all the charts. It 
is not possible to change the colors of the expressions.
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Add more analysis windows

1. Click one of the Split/Unsplit buttons in an analysis window. This will split 
the window either horizontally or vertically.

2. Click the Select window icon, select either Face, Consumer Behavior, Vital 
Signs, Voice or Timeline and then select a window from the list that 
appears.

Merge analysis windows

To merge the windows again, click the Close button in the window that you want to 
delete.

Reset the analysis window layout

To close any extra windows that you opened and to reset the position of your 
windows, choose Window > Reset Analysis Window Layout.

Common options

Most windows and charts can be exported or copied to the clipboard, and zoomed 
in/out.
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 Export the window/chart as a *.PNG, *.JPG, *.BMP, *.GIF, *.TIF or *.EMF 
image. An EMF image is a vector image and therefore scalable.

 Copy the window/chart to the clipboard, to paste it in another program like 
Word or PowerPoint.

 Use the Zoom In and Zoom Out buttons to change the level of detail.

Common options for line charts

If you analyzed multiple intervals in one video, the windows with data over time 
show gaps.
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Click Options and then select Auto Scale Y axis to adjust the Y axis to the 
maximum value.
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Analysis visualization window
To access this option 

Click one of the Select window buttons, select Face Analysis and then Analysis 
Visualization.

Analysis Visualization

The Analysis Visualization window shows how FaceReader analyzes your images. 
Click the icons on the left of this window to select one or more of the options.

In previous versions of FaceReader it was possible to view the texture model, the 
model constructed by the face modeling algorithm. In FaceReader 10 9 this option 
is no longer available.

Show image

Shows the face in the video or camera image. You may want to hide the face for 
privacy reasons.
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Show framing 

Draws a white box around the face at the location where the face was found.

Show Mesh

Shows the positions of the 468 key points used by the face modeling algorithm. The 
axes on the nose indicate the head orientation.
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Show Global Gaze Direction

Shows the gaze direction of both eyes. The button Show Global Gaze Direction is 
not available when in the Analysis Settings under Optional Classifications, Gaze 
tracking is deselected.
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Show Facial States

Shows the Facial States: whether the left and right eye is open or closed, whether 
the mouth is open or closed and whether the eyebrows are raised, neutral or 
lowered. 
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Zoom on face

Zooms in on the face (if the face can be modeled). The model quality does not 
change when you zoom in on the face.
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Notes

 After the analysis, you can play back the visualizations together with the 
video.

If you have The Action Unit Module, you can also display Action Units in the 
Analysis Visualization window. You can see what Action Units are active in the face 
and how active they are (Trace activation, Slight, Pronounced, Severe or Max). This 
option is available if you selected Action Units in the Settings (Settings -> 
Analysis Options -> Optional Classifications).

See Visualize Action Units
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Circumplex Model of Affect
The Circumplex Model of Affect describes emotions in a two-dimensional circular 
space, containing arousal on the vertical axis and valence on the horizontal axis. The 
center of the circle represents a neutral valence and a medium level of arousal. The 
Circumplex Model of Affect in FaceReader is based on the model described by 
Russel (1980).

Options

The following additional options can be selected with the Options button on the 
toolbar:

Show current position

Shows a circle around the affect, with the color of the current expression state. 

Show history

If you carried out video analysis or camera analysis, the affect found in previous 
images is shown when playing back the analysis. 
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Show expression label

Shows the expression state found in the image selected in the Analysis View 
window. This option is not available with Baby FaceReader.

Show heatmap

This option is only available for camera and video analyses. It displays a heatmap of 
the affect found in the analysis. 

 Based on absolute percentage – The color of the heatmap is based on the 
percentage of time a certain affect was found in a video or camera analysis. 
The maximum is 100%. 

 Based on maximum percentage – The color of the heatmap is based on the 
percentage of time the affect that was most present occurred. This 
percentage of time is set as the maximum and is colored red.

References 

Russell, James (1980). A circumplex model of affect. Journal of Personality and 
Social Psychology 39: 1161–1178.

http://en.wikipedia.org/wiki/Emotion_classification#Circumplex_model
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Expression intensity chart
This option is not available with Baby FaceReader.

To access this option

Click the Select window button in one of the visualization windows, select Face 
Analysis, and then Expression Intensity. 

Expression Intensity

The Expression Intensity chart displays the intensity of the six basic emotions, the 
neutral state and, optionally, Contempt. When your input is a live video stream or a 
video file, you will see the bars change over time, reflecting the changes in 
expressions on the face. 
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See Expression states explained when dominant expressions appear in the Timeline 
and State log. 
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Expression Line Chart
This option is not available with Baby FaceReader.

To access this option

Click the Select window button in one of the visualization windows, select Face 
Analysis, and then Expression Line Chart. 

Expression Line Chart

The Expression Line Chart displays facial expressions over time. Each expression is 
plotted in a different color. When you play back the video, a hairline shows the time 
in the video.
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Expressions

From the Expressions list choose the emotions you want to view.
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Expression Summary
This option is not available with Baby FaceReader.

To access this option

Click the Select window button in one of the visualization windows, select Face 
Analysis, and then Expression Summary. 

Expression summary

The chart shows the distribution of facial expressions for the complete analysis. If 
you analyzed multiple intervals in one video all the intervals are taken into account 
in the Expression Summary chart.
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Options

Click Settings and select Show Values to view the subdivision of emotions in 
percentages.

What does Other mean?

Expressions that make up less than 5% of the sum of all expression intensities are 
included in the category Other. The example below shows part of the detailed log 
of an analysis. For each expression, the total intensity is calculated. Angry, Surprised, 
Scared and Disgusted each have a total intensity of less than 5% of the sum of all 
intensities. The sum of these four expressions is displayed as Other in the Expression 
summary. 
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Facial States
To access this option

Click the Select window button in one of the visualization windows, select Face 
Analysis, and then Facial States. 

Facial States

The Facial States table gives a dynamic overview of the following states: 

 Gaze Direction (Left, Left-Up, Left-Down, Forward, Up, Down or Right, 
Right-Up, Right-Down) (only available if you selected Gaze tracking in the 
Settings > Analysis Options).

 Gaze Type (Fixation or Saccade) (only available if you selected Gaze 
tracking in the Settings > Analysis Options).

 Mouth (open or closed) 

 Eyes (open or closed) 

 Eyebrows (raised, neutral or lowered) 
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Note

If the table shows Disabled behind all the states and you want to view the Facial 
States, choose File > Settings. On the tab Analysis Options, under Optional 
Classifications select Facial States.



147

Gaze Angles Line Chart
To access this option

Click the Select window button in one of the visualization windows, select Face 
Analysis, and then Gaze Angles Line Chart. The Gaze Angles Line Chart is only 
available if you selected Gaze tracking in the Settings > Analysis Options.

Gaze Angles Line Chart

The Gaze Angles Line Chart displays the Horizontal and Vertical gaze angle over 
time (in degrees). When you play back the video, a hairline shows the time in the 
video.

Click Gaze Angles to select what gaze angle you want to view over time (Horizontal 
gaze angle and/or Vertical gaze angle).
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Head Orientation Line Chart
To access this option

Click the Select window button in one of the visualization windows, select Face 
Analysis, and then Head Orientation Line Chart. 

Head Orientation Line Chart

The Head Orientation Line Chart displays the head orientation as the Pitch, Yaw and 
Roll over time. It is displayed in degrees deviating from looking straight forward. 
When you play back the video, a hairline shows the time in the video.

Head orientations

Click Head Orientation to select whether you want to view the Pitch, Yaw or Roll.
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Head Position Line Chart
To access this option

Click the Select window button in one of the visualization windows, select Face, 
and then Head Position Line Chart. 

Head Position Line Chart

The Head Position Line Chart displays the head position relative to the camera over 
time (Horizontal, Vertical and Depth position, in millimeters). When you play back 
the video, a hairline shows the time in the video.

FaceReader’s face model is defined in millimeters. By a projection of the 3D model 
to the 2D image FaceReader can derive where in real world coordinates the face is 
in the 2D image (and an estimated camera projection matrix). FaceReader’s 3D 
coordinates are centered around the camera, the camera is at (0,0,0). Therefore, the 
3D coordinates of the fitted model will tell you where the face is relative to the 
camera. 

Head positions

Click Head Position to select what head position you want to view over time 
(Horizontal position, Vertical position and/or Depth position).
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Subject Characteristics
This option is not available with Baby FaceReader.

To access this option 

Click the Select window button in one of the visualization windows, select Face 
Analysis, and then Subject Characteristics. 

Subject Characteristics

The Subject Characteristics table displays the following:

 Gender – A range is given with a certainty value. If the gender is entered 
manually in the Independent Variables, the value is fixed and the certainty is 
100%.

 Age – A range is given with a certainty value. If the age is entered manually 
in the Independent Variables, the value is fixed and there is no certainty 
displayed in the table. 

 Presence of glasses – A certainty value is given.

Note

The Subject Characteristics table also gives you an indication of the quality of the 
image. If the quality of your image is poor, the information will not be correct. For 
instance, if FaceReader reports that a female test person is male, then the modeling 
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is not correct, most probably because the image is of poor quality or the lighting 
conditions are bad.
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Valence and Arousal Line Chart
To access this option

Click the Select window button in one of the lower visualization windows, and 
select Face Analysis and then Valence and Arousal Line Chart. 

Valence

Valence indicates whether the facial expressions display a positive or negative 
emotion. 

See the figure below for an example. When you play back the video, a hairline 
shows the time in the video. 

How valence is calculated

The valence indicates whether the emotional status of the subject is positive or 
negative. 'Happy' is the only positive emotion, 'Sad', 'Angry', 'Scared' and 
'Disgusted' are considered to be negative emotions. ‘Surprised’ can be either 
positive or negative and is, therefore, not included in the calculation of valence. 
Contempt is also not included in the calculation of Valence.
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Valence is calculated as the intensity of ‘Happy’ minus the intensity of the negative 
emotion with the highest intensity. 

If you have Baby FaceReader, Valence is based on Action Units.

Example 

Consider the following expression intensities:

 Happy – 0.8 

 Sad – 0.1

 Angry – 0.0

 Scared – 0.05

 Disgusted – 0.05 

In this case Valence is 0.8 - 0.1 = 0.7.

Arousal

Arousal indicates whether the test participant’s face is active (+1) or not active (0). 
Arousal is based on the activation of 20 Action Units (AUs) of the Facial Action 
Coding System (FACS).

See the figure above for an example. When you play back the video, a hairline 
shows the time in the video. 

How Arousal is calculated

1. The activation values (AV) of 20 AUs are taken as input. These are AU 1, 2, 4, 
5, 6, 7, 9, 10, 12, 14, 15, 17, 18, 20, 23, 24, 25, 26, 27, and the inverse of 43. 
The value of AU43 (eyes closed) is inverted because it indicates low arousal 
instead of high arousal like the other AUs.

2. The arousal is calculated by taking the mean of the three highest values.

Note

 Contempt is not included in the calculation of Arousal. 
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Stimulus View
To access this option

Click the Select window button in one of the visualization windows, select Face 
Analysis, and then Stimulus View. 

Stimulus View

FaceReader comes with the Stimulus Presentation tool which allows you to present 
stimuli to your test participants during the test. The Stimulus View window displays 
the stimulus video or image. In addition to the Stimulus View window you can, for 
instance, visualize the participant’s Expression Intensity chart, play back the 
analysis and assess what facial expressions the stimuli induced.

If your FaceReader license includes the Advanced Research Module and you 
selected Perform gaze calibration when you defined the test, the window also 
shows the participant’s gaze overlay.
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Timeline
To access this option

Click the Select window button in one of the visualization windows and select 
Timeline.

 

Timeline

The Timeline gives an overview of the Facial Expressions, Facial States, Stimuli, Event 
markers and Optional classifications on a timeline. 

 If your license includes The Action Unit Module, the Timeline also displays 
Action Units. 

 If you selected Gaze tracking in the Settings > Analysis Options, the 
Timeline also displays Gaze Direction and Gaze Type (saccades/fixations).

 If you have the Consumption Behavior Module, the Timeline also displays 
the behaviors ‘Intake event’, ‘Chewing’ and ‘Chew motion’ on a timeline. 

 If your license includes the Voice Analysis Module, the Timeline also 
displays the dominant emotions recognized in the participant’s voice.

 If you have Baby FaceReader, the Timeline only shows Action Units and 
Facial States. 

You can play back through the timeline together with playing back the analyzed/
recorded video.
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Unknown means that no face is found or the face cannot be modeled (for instance, 
because the quality of the video is poor or a hand partly hides the face). For video 
analysis, Not Analyzed indicates what part of the video has not yet been analyzed.

Expression states explained

An expression is dominant when its intensity is higher than that of all others. Each 
time the dominant facial expression changes and is active for at least 0.5 seconds, 
this expression is scored as a state. This state appears in the Timeline and is also 
scored with its time stamp in the State log.

Note that if the intensity, as displayed in the Head Orientation Line Chart, exceeds 
0.5, this does not necessarily mean that an expression state is scored. In the 
following example the Expression Intensity is compared with the Expression states. 
Sad and Disgusted exceed 0.5, but only Disgusted is scored at that time, because its 
intensity is higher than that of Sad and was dominant for at least 0.5 seconds. (see 
the blue bar on the timeline).
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Options

Expressions

Click Expressions and choose which expressions you want to view. By default all 
expressions are selected. 
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Events

The timeline also shows the Stimuli and Event Markers in your project. Optionally 
deselect either the Stimuli, Event Markers, or both using the Events button. 

Expressions

Deselect Expressions if you do not want to see them on the Timeline.

Facial States

With Facial States, choose whether you want to display the Facial States (Left Eye, 
Right Eye, Left Eyebrow, Right eyebrow, Mouth). By default, all these options are 
selected.

Gaze tracking

If you selected Gaze tracking in the Settings you can visualize the Gaze Direction 
and Gaze Type on the Timeline.

Action Units

If you have the The Action Unit Module, the timeline also shows the intensity of the 
Action Units. Optionally, deselect some Action Units, using the Action Units button.

Consumption Behavior

If you have The Consumption Behavior Module, the timeline also shows the 
behaviors ‘Intake event’, ‘Chewing’ and ‘Chew motion’. Optionally, deselect some 
from the Consumption Behavior drop-down list.
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Voice Expressions

If you have the Voice Analysis Module the Timeline also displays the dominant 
emotions recognized in the participant’s voice.

Notes

 For more information about the State log, see Export analysis results.

 If you want to use other criteria to define a state, for example when the 
intensity of an expression is above 0.5, export the detailed log. Then 
calculate the states in another program, like Excel. 

See Export analysis results
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Reporting Display
The reporting display is a fully customizable visualization of FaceReader’s output. 
You can use it on a second monitor, or to create visuals in a report or presentation.

To access this option

1. Choose View > Reporting Display. 

2. Click the plus sign and choose one of the available windows. 

For more information on the output in these windows see the links below.

 Analysis Visualization

Click on the Ellipsis button (...) for visualization options. The same options 
are available as in the regular output of Facereader. The additional option 
Show status displays the Model Quality Bar. 
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 Circumplex Model of Affect

Click on the Ellipsis button (...) for visualization options. The same options 
are available as in the regular output of Facereader.

 Custom expressions line chart 

See Visualize Custom Expressions in The Action Unit Module. This 
option is available when you have the Action Unit Module and added a 
Custom Expression to your project. 

Click on the Ellipsis button (...) to select which custom expression to display.

 Emoticon 

The emoticon dynamically visualizes the test participant’s facial expressions. 
Each expression has a number of features (except ‘scared’): 

Happy — Smiling mouth.

Sad — Corners of the mouth down and tears dropping from the eyes.

Angry — Red face, eyebrows lowered. 

Surprised — Big eyes, raised eyebrows.

Disgusted — Tongue sticking out.
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 Expression Intensity

 Expression Line Chart

Click on the Ellipsis button (...) to select the expressions to display in the 
chart. 

 Expression summary

Click on the Ellipsis button (...) and choose Show values to display 
percentages for the facial expressions. 

 Gaze Angles Line Chart

Click on the Ellipsis button (...) to select whether you want to view the 
changes in the Horizontal or Vertical gaze angle. 

 Head Orientation Line Chart

Click on the Ellipsis button (...) to select whether you want to view the 
changes in Pitch, Yaw or Roll.

 Head Position Line Chart

Click on the Ellipsis button (...) to select whether you want to view the 
changes in the Horizontal, Vertical or Depth position.

 Valence and Arousal Line Chart

Click on the Ellipsis button (...) to select whether you want to view the 
Valence or the Arousal or both parameters.

 Valence Monitor

The Valence Monitor is a three-light indicator. The light is 

Green — The valence of the analyzed frame is above 0.33.

Orange — The valence is between -0.33 and +0.33.
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Red — The valence is below -0.33.

 Vital signs

This option is available if you have the Vital Signs Module. See Vital Signs 
window in The Vital Signs Module. 

 Voice Expression Intensity

This option is available if your FaceReader license includes the Voice 
Analysis Module. See Voice Expression Intensity in The Voice Analysis 
Module.

 Voice Expression Line Chart

Click on the Ellipsis button (...) to select the expressions to display in the 
chart. This option is available if your FaceReader license includes the Voice 
Analysis Module. See Voice Expression Line Chart in The Voice Analysis 
Module. 

 Voice Valence and Arousal Line Chart

Click on the Ellipsis button (...) to select whether you want to view the 
Valence or the Arousal or both parameters. This option is available if your 
FaceReader license includes the Voice Analysis Module. See Voice Valence 
and Arousal Line Chart in The Voice Analysis Module. 

 Voice View

This option is available if your FaceReader license includes the Voice 
Analysis Module. See Voice View in The Voice Analysis Module.

General options

All charts

 To position a window in front of or behind another window, click on the 
Toggle Back/Front icon on the chart. 
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 To Maximize a window, click on the Maximize icon on the chart. 

 To scale a window, drag the border of the window. 

 

 To copy the presentation view, for example to paste it in a report or 
presentation, click on the Copy icon.

 

 To maximize the entire reporting display, click on the Toggle full screen 
icon in the upper-right corner of the window. 

 To remove all windows, click on the Reset icon. 
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Line charts

To adjust the Y axis to the maximum value, click on the Ellipsis button (...) and 
choose Auto scale Y axis. 

Note

The Reporting display is persistent. When you open a new project, the reporting 
display will open with the windows and layout that you selected in your last project. 
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Export analysis results
Aim 

To save your analysis results as text file, Excel file or The Observer XT format file 
(.odx) for further analysis in another program. 

Prerequisites

 You carried out analyses.

 The values of all independent variables have been scored for all 
participants. Analyses of participants with unscored independent variables 
cannot be exported. This is indicated with a warning icon in front of the 
participant name. Score the independent variable values for those 
participants. 

Procedure

Exporting analysis results consists of the following steps:

1. Choose what to export

2. Export the data

Choose what to export

1. Choose File > Settings > Data Export. 

2. Under Export (Detailed log, ODX, N-Linx and API) choose the data to 
export.

Export the data

1. Choose File > Export > and choose one of the following:
Export Analysis Results— To export the results of the analysis currently 
open.

Export Participant Analysis Results — To export the results of all analyses 
related to the participant currently selected.

Export Project Results — To export the results of the entire project.

2. Browse to the location on your computer where you want to store your log 
files and click OK. The default location is:
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C:\Users\<your username>\Documents\Noldus\FaceReader 10 
9\Projects\<Project Name>\Logs.

3. If you chose Export Analysis Result in step 1, give the export file a name. A 
suffix with the export type, like detailed or state, will be added to the export 
name. 

If you chose Export Participant Analysis Result or Export Project Result, 
the export files are named automatically. 

4. Choose one of the following:

 Export to text files or Excel files — There are four options to select from:

- Text files (tab delimited) - 1 file per participant/analysis

- Excel files - 1 file per participant/analysis)

- Combined Excel files (one sheet per analysis) - 1 file, analyses on sheets

- Combined Excel files (all analyses in one sheet) - 1 file, all data on 1 sheet

 Export to The Observer XT (.odx)

Export to text files or Excel files

Choose to export the State log, Detailed log or Heart beat log. The Heart beat log 
option is available if you have the Vital Signs Module. For more information see 
Export heart beat log.

State log

The State log shows the expression state the test person displays (see the figure 
below for an example). A record is added to the log each time the dominant 
expression changes and is active for at least 0.5 seconds. If no face is found or the 
face cannot be modeled, for instance because the quality of the video is poor, a 
record with Unknown is added to the State log.

You can export State logs as text files with the data separated by tabs or as Excel 
files.
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NOTE  To change the word ‘Unknown’ in the State log, see Export (Detailed log and 
API) in Settings

NOTE  If you want to use other criteria to define a state, for example when the 
intensity of an emotion is above 0.5, export the detailed log. Then calculate the 
states in another program, like Excel. 

Detailed log

The Detailed log (see the figure below for an example) contains all the expression 
classifier outputs and the other data you selected for export. Each expression has a 
value between 0 and 1, indicating the intensity of the expression. '0' means that the 
expression is not visible, '1' means that it is fully present. You can export the 
Detailed logs as text files with the data separated by tabs or as Excel files. 

When no face is found or the face cannot be modeled (e.g. because the quality of 
the video is poor), a record with FIND_FAILED or FIT_FAILED is added. If you work 
live (using a camera) and your computer cannot process the incoming images fast 
enough, frames will be skipped and a record with MISSING will be added to the 
Detailed log. 
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NOTE  To change the words FIND_FAILED, FIT_FAILED, or Unknown in the Detailed 
log, see Export (Detailed log and API) in Settings

If you analyze a video file and skip frames (that is, you set the Sample rate to Every 
2nd frame or Every 3rd frame), the logging frequency changes accordingly. 

For the Detailed log you have the following options:

 Adjust the export sample rate – To create a log file with a lower sample 
rate than the FaceReader analysis. You can choose a value between 1 and 
15 frames per second. FaceReader interpolates the analysis results if the 
chosen sample rate results in interpolated timestamps. 

You can also choose to adjust the export sample rate to a value between 1 
and 60 frames per minute. Note that this is averaging the results towards 
the new time base, centered at the time logged. So if you log 1 frame per 
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minute, the result at the 1th minute will be the average of 0.00.30.000 to 
0.01.30.000.

 Include file header – To include the following information as header in the 
export file: 

- Face Model

- Calibration – calibration name and calibration values (the average 
intensity values of Neutral, Happy, Sad, etc. that are found during the 
calibration, that is, Ic in the formula used to calculate the corrected 
expression intensities. See How participant calibration works).

- Start date and time

- Video filename

- Analysis frame rate

- Independent variables

 Include column header – To include column details in the export file. 

Note 

If you analyzed from video and your video was not recorded with exactly the frame 
rate you selected, for example 29.9 fps instead of 30 fps, the timestamps may be 
slightly different from what you may have expected.

Export to The Observer XT (.odx)

The Observer log contains the analysis results, in XML format. Select this output 
format if you want to import your data for further analysis in The Observer XT, our 
software package for collecting observational data. You have the following options:

 Include detailed values – To save both the Detailed log as the State log in 
the export file. Choose this option if your license for The Observer XT does 
not include the External Data Module. The Detailed log data will be 
imported as numerical modifiers. If you have the External Data Module, 
select Save Detailed log. The Detailed log data will then be imported as 
external (continuous) data into The Observer XT. See How FaceReader data 
are imported into The Observer XT.

 Save all analyses to a single The Observer XT log – This option is 
available when you export the results of a participant, or an entire project. 
This option allows you to import all analyses results at once into The 
Observer XT. The different participants and analyses are imported into 
separate observations. Since FaceReader export files can be very large, we 
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recommend to create a FaceReader export file for each analysis and import 
them one by one in The Observer XT.

Each observation in The Observer XT contains the name of the imported 
participant and analysis.

File name

The default name for the export log files is:

[Participant number]_[Participant name]_[Analysis name]_[Analysis type]_ 
YYYYMMDD_hhmmss_[Export file type] 

Where:

 [Participant number] is the number given automatically (Participant 1, 2 etc.)

 [Participant name] is the name entered under Name when adding that 
participant

 [Analysis name] the name of the selected analysis 

 [Analysis type] specifies whether an image, video, or camera analysis has 
been carried out.

 YYYYMMDD_hhmmss is the date/time code of the start of the analysis.

YYYY = year including the century.

MM = month with leading zero.

DD = day with leading zero.

hh = hours, 12-hour format with leading zero.

mm = minutes with leading zero.

ss = seconds with leading zero.

Note

If you want to import the detailed log as external data into The Observer XT, export 
the detailed log as text file and select the options Include file header and Include 
column header. Otherwise the import profile FaceReader 10 detailed log as 
external data does not work. 
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If you have additional modules and selected additional data when you exported the 
Detailed log data (like Action Units or Expressions from voice) you need to make a 
new import profile. See External Data in The Observer XT Help how to do so, or 
contact Noldus Support. 

See:

 Export to text files or Excel files

 Import the detailed logs as external data in FaceReader with The Observer 
XT
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The Action Unit Module

Main topics

 Introduction to Action Unit classification

 Analyze Action Units

 Visualize Action Units

 Action Units in the log files

 Custom Expressions
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Introduction to Action Unit classification
Action Units are muscles or muscle groups in the face that are responsible for facial 
expressions. The Action Units are described in the Facial Action Coding System 
(FACS) published by Ekman and Friesen (1978).

FaceReader can analyze Action Units with the Action Unit Module. The following 
Action Units are analyzed:

If you have Baby FaceReader, you can analyze the combined activation of Action 
Unit 3 and 4 (Brow Knitting and Knotting).

Action Unit FACS Name

1 Inner Brow Raiser

2 Outer Brow Raiser

4 Brow Lowerer

5 Upper Lid Raiser

6 Cheek Raiser

7 Lid Tightener

9 Nose Wrinkler

10 Upper Lid Raiser

12 Lip Corner Puller

14 Dimpler

15 Lip Corner Depressor

17 Chin Raiser

18 Lip Pucker

20 Lip Stretcher

23 Lip Tightener

24 Lip Pressor

25 Lips Part

26 Jaw Drop

27 Mouth Stretch

43 Eyes Closed
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Intensities are annotated by appending letters:

 A - trace. 

 B - slight. 

 C - pronounced. 

 D - severe. 

 E - max. 

These intensities follow the classification as described in Ekman et al. (2002).

In FaceReader 9.1.8 and higher the classification of Action Units gives slightly lower 
intensities than in older versions of the software. In older versions non-active Action 
Units could be classified with intensity level A, A-level Action Unit activations with 
level B, etc. The reason for this difference is an error in the conversion script of the 
underlying deep neural network that has been corrected in FaceReader 9.1.8. 

The values of Contempt, Arousal, facial states (except Gaze direction) and Valence in 
Baby FaceReader are also affected as these parameters are based on Action Units. 
Valence in the regular version of FaceReader is based on facial expressions only and 
is, therefore, not affected. The calculation of most custom expressions is also based 
on Action Units and the intensities of these custom expressions are, thus, also 
different. For the most accurate Action Unit estimation it is important to use the 
latest version of the software and re-analyze old videos if you want to compare the 
data with those obtained with the new FaceReader version.

References

 Ekman P. and W. V. Friesen (1978). Facial Action Coding System: A Technique 
for the Measurement of Facial Movement. Consulting Psychologists Press, 
Palo Alto.

 Ekman P., W. V. Friesen, and J. C. Hager (2002). The Facial Action Coding 
System. Second edition. Salt Lake City: Research Nexus eBook. London: 
Weidenfeld & Nicolson (world). 
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Analyze Action Units
Aim

To quantify activation of Action Units in the test participant’s face. 

Prerequisite

Your FaceReader license includes the Action Unit Module. 

Procedure

1. Choose File > Settings > Analysis options.

2. Under Optional Classifications, select Action units.

Action Unit Analysis is by default switched on if your FaceReader license includes 
the Action Unit Module.
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Visualize Action Units
Aim

To display Action Units during or after the analysis.

Prerequisites

 Your FaceReader license includes the Action Unit Module or you have Baby 
FaceReader.

 You are running an analysis, or viewing the analysis afterwards.

Action Units in the Analysis Visualization window 

Click the Show action units button on the left side of this window. Action Units 
appear in the Analysis Visualization when the activity is Trace or higher. The colors 
under the name represent the activity of this Action Unit.    
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Action Unit Intensity

Select the Action Unit Intensity window from one of the visualization windows 
(see Manage analysis windows). It shows the intensity of 20 Action Units, divided 
into the classes Trace, Slight, Pronounced, Severe, and Max. These intensities are 
shown by consecutive letters from A to E. From the Action Units list, choose which 
ones to display. 
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Unilateral Action Units

Most Action Units are unilateral, that is, they can be visible in the left and/or right 
part of the face. To assess the intensity of the left and right part independently, 
select Options and then Split unilateral action units.

Please note that the unilateral Action Units have been evaluated only qualitatively, 
but not validated quantitatively. This is mainly due to unavailability of data: images 
of unilateral AU activation examples are rare in current datasets and hard to 
produce in general.

Continuous value bars

Select Options and then Show continuous value bars to visualize the intensity of 
the Action Units on a continuous scale.

Action Unit states

The intensity of the Action Units is displayed on the Timeline. Select Timeline in 
one of the windows (see Manage analysis windows). Choose which Action Units to 
display from the Action Units list on the toolbar. By default all Action Units are 
selected. 

Note

To copy, save, or zoom in this window, see Common options in FaceReader’s output
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Action Units in the log files
Aim

To export the Action Units to a text file, Excel file or The Observer XT format file. 

Prerequisites

 Your FaceReader license includes the Action Unit Module.

 Action Unit analysis is switched on in the Settings.

See Analyze Action Units

 You carried out an analysis.

Export Action Units as States

1. Choose File > Settings and then click the Data Export tab. 

2. Under Export (Detailed log, ODX, N-Linx and API), select Action units. 
Do not select Export Action Units as continuous values. To export the 
unilateral Action Unit intensities, select the corresponding checkbox.

3. Choose File > Export and select one of the options. 

See Export the data in FaceReader’s output

The intensities are exported as letters to the detailed log.
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The letters correspond to the following Action Unit intensities:

 Not active – [0.00 - 0.100]

 A – [0.100 - 0.217]

 B – [0.217 - 0.334]

 C – [0.334 - 0.622]

 D – [0.622 - 0.910]

 E – [0.910 - 1.000]

If you selected to export the unilateral Action Unit intensities, the Detailed log 
contains three columns for each Action Unit (the intensity on the left side of the 
face, on the right side and combined). The combined value is the maximum of the 
two.

Export Action Units as continuous values

You can also export Action Unit intensities as continuous values. To do so:

1. Choose File > Settings > Data export 

2. Under Export (Detailed log, ODX, N-Linx and API) select Action Units 
and Export Action Units as continuous values.

3. Choose File > Export and select one of the options. 
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See Export the data in FaceReader’s output

If you selected to export the unilateral Action Unit intensities, the Detailed log 
contains three columns for each Action Unit (the intensity on the left side of the 
face, on the right side and combined). The combined value is the maximum of the 
two.

Action Unit intensities in The Observer XT

If you send FaceReader data to The Observer XT 13 or higher versions using the N-
Linx network communication protocol, Action Unit intensities are not transferred to 
The Observer XT as numerical values but as intensity classes. 

See FaceReader with The Observer XT
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If you want to import the intensities as continuous values:

1. Select to Export action units as continuous values

2. Export FaceReader log files, export the data as Detailed log 

3. Import the detailed logs as external data
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Custom Expressions

Custom Expressions are facial expressions/states that you can define yourself by 
combining the facial expressions and Action Units that FaceReader can recognize by 
default (Neutral, Happy, Sad, Angry, Surprised, Scared, Disgusted and Contempt 
and the 20 Action Units). You can, for instance, define ‘Duchenne smile’ as a Custom 
Expression by combining Action Unit 6 and 12. You can also use Valence, Arousal, 
Head Orientation, Head Position, Gaze Angles, Landmarks, Heart Rate, Heart Rate 
Variability, Expressions in the voice, and Model quality in your definition of a 
Custom Expression.

If you have Baby FaceReader you can base your Custom Expressions on Valence and 
Arousal, the 20 Actions Units that FaceReader can recognize in baby faces, Head 
Orientation, Head Position, Gaze Angles, Heart Rate and Heart Rate Variability.

If you have the regular version of FaceReader, you need the Action Unit Module to 
be able to define Custom Expressions. If you have Baby FaceReader you do not 
need an extra module.
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Types of Custom Expressions
There are three types of Custom Expressions:

 Project Custom Expressions - These Custom Expressions are available in 
the project that is currently open.

 My Custom Expressions - These Custom Expressions are available on your 
PC to be used in the project that is currently open and in all existing and 
future projects.

 Remote Custom Expression Library - These expressions come with your 
FaceReader license. You can copy and edit them and use them in your 
projects. They are stored in an online library and are curated by Noldus IT. 

Your FaceReader license comes with the following Custom Expressions in the 
Remote Custom Expression Library:

Additional Action Units

 Blink (AU45) — Eyes closing and opening (>0.5 difference in the intensity of 
AU43) within 200 milliseconds

 Head Turn Left (AU51) — This Custom Expression/Action Unit is based on 
the head orientation (Yaw).

 Head Turn Right (AU52) — This Custom Expression/Action Unit is based on 
the head orientation (Yaw).

 Head Up (AU53) — This Custom Expression/Action Unit is based on the 
head orientation (Pitch).

 Head Down (AU54) — This Custom Expression/Action Unit is based on the 
head orientation (Pitch).

 Eyes Turn Left (AU61) — Only for central head position.

 Eyes Turn Right (AU62) — Only for central head position.

 Eyes Up (AU63) — Only for central head position.

 Eyes Down (AU64) — Only for central head position.

Baby Expressions

 Baby Cry — This Custom Expression is based on Action Unit 12 (Lip Corner 
Puller), 20 (Lip Stretcher), 25 (Lips Part), 26 (Jaw Drop) and 27 (Mouth 
Stretch).

 Baby Smile — This Custom Expression is based on Action Unit 12 (Lip 
Corner Puller), 20 (Lip Stretcher), 25 (Lips Part), 26 (Jaw Drop) and 27 
(Mouth Stretch).
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Behavioral States

 Attention — Indicates whether the test participant is centrally focussed 
based on the head orientation (Pitch and Yaw) and head position (Depth 
position). This custom expression does not include emotion.

 Attention (binary) — Takes the head orientation into account (Pitch and 
Yaw). Attention is 1 if the pitch and yaw are 0, otherwise attention is 0. This 
Custom Expression is validated (median accuracy: 0.87). For more 
information see the ‘Validating FaceReader’s attention detection: a reliable 
measure using gaze and head pose’ blog post on the Noldus website.

 Blink Rate — Calculates the number of blinks per minute over a 10 second 
window.

 Leaning Backward

 Leaning Forward

 Talking — Talking is classified by looking at the rate of Action Unit 25 
(parting lips) over a typical frequency (e.g. two words per second). Action 
Unit 25 is also important in other expressions (e.g. smiling, spontaneous 
laughter). You may find false positive events when the lips part and close 
with a similar frequency in other expressions. The value of Talking can either 
be 1 (talking) or 0 (no talking). 

Complex Expressions

 Boredom — See below for more information.

 Confusion — See below for more information.

 Interest — See below for more information.

 Spontaneous Laughter — Laughing out loud. Takes into account Action 
Unit 6 and 12 and 25 and 26. Lower activation of spontaneous laughter can 
indicate regular laughing or in rare cases a strong smile.

Facial Gestures

 Frowning — AU4 is a frown but often people also tighten their eyelids 
(AU7). AU4 contributes most to this custom expression, AU7 only max 50%.

 Laughing — Laughing with mouth open. Takes into account Action Unit 6 
and 12 and 25, and 26.

 Mouth opening — Any form of mouth opening.

 Mouth tightening — Any Action Unit activity that puts tension on the 
mouth (Action Unit 10, 15, 18, 23, 24).

 Moving Eyes — General eye movement, away from the center. A higher 
value indicates more movement.
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 Moving head — General head movement, away from the center. A higher 
value indicates more movement.

 Raising eyebrows — Upward movement of the eyebrows irrespective of the 
inner and outer brow.

 Smiling — Mouth is closed. Takes into account Action Unit 6, 12, 25, and 26.

Baby Cry and Baby Smile come with Baby FaceReader.

Boredom, Confusion and Interest come with the regular version of FaceReader. 
These expressions were called Affective Attitudes in FaceReader 7. 

Boredom, Confusion and Interest are estimated using all frames in a time interval. 
Therefore, the analysis of these Custom Expressions can only be done with video 
and camera analyses. For each frame, the estimate of the Custom Expression is 
calculated using the current frame and all the previous frames in the time interval. 

To calculate Interest, Boredom and Confusion the following time intervals are used:

 Interest – 2 seconds.

 Boredom – 5 seconds.

 Confusion – 2 seconds.

At the start of the analysis, there is no time interval yet to analyze these Custom 
Expressions. Therefore the visualization will display no data. FaceReader starts the 
analysis when half the time interval has been reached. This means that the analysis 
of Interest and Confusion starts 1 second after the start of the analysis. The analysis 
of Boredom starts 2.5 seconds after start of the analysis.

The analysis of Interest, Boredom and Confusion is based on references 1, 2 and 3.

1. McDaniel, B., D'Mello, S., King, B., Chipman, P., Tapp, K., & Graesser, A. (2007, 
January). Facial features for affective state detection in learning environ-
ments. In Proceedings of the Cognitive Science Society (Vol. 29, No. 29).

2. Kapoor, A., Mota, S., & Picard, R. W. (2001, November). Towards a learning 
companion that recognizes affect. In AAAI Fall symposium (pp. 2-4).

3. Grafsgaard, J., Wiggins, J. B., Boyer, K. E., Wiebe, E. N., & Lester, J. (2013, July). 
Automatically recognizing facial expression: Predicting engagement and 
frustration. In Educational Data Mining 2013.

Please cite the original work in your studies when based on FaceReader’s analysis.

Please note that the custom expressions in FaceReader are not qualitatively 
validated (due to lack of available real-world data, except Attention (binary)). The 
idea with most of these custom expressions is that they are primarily theory-based 
(based on findings/observations in the literature). They can serve as a starting point, 
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and their formulas can be modified as needed. Regardless, the custom expressions 
are based on FaceReader's validated AU predictions, so the source of their input 
information is validated. The extra AU custom expressions are indirectly validated, 
e.g. Blink (AU45) is based on eye closure (AU43), which is validated; AU 51-53 are 
based on head pose angles, which are internally validated.

Some Custom Expressions have been updated in FaceReader 10. You can continue 
using the older versions (that were available in FaceReader 9) by clicking Show all 
versions. The screenshot below shows the two versions of Interest that are available 
in FaceReader 10.

Select one of the actions below to work with custom expressions:

 Add a Custom Expression to your project

 View a Custom Expression definition

 Copy a Custom Expression

 Import a Custom Expression

 Export a Custom Expression definition

 Delete a Custom Expression

 Define a new Custom Expression

 Custom Expression inputs in detail

 A Custom Expression block in detail

 Working with custom expression blocks

 Input simulator
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 Visualize Custom Expressions

 Export Custom Expressions

 Custom Expression intensities in The Observer XT
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Add a Custom Expression to your project
Aim

To analyze a Custom Expression, that is, to quantify the activation of the Custom 
Expression in the test participant’s face. 

Prerequisite

 You have the Action Unit Module or Baby FaceReader.

 Your FaceReader computer has a connection to the internet to access the 
Remote Custom Expression Library.

 All the analyses in the project are closed. To close an analysis, click the 
button next to it.

Procedure

1. From the File menu select Custom Expressions Browser or click the Add 
custom expression to project icon in the Custom Expressions pane. 

The Custom Expression browser opens with three tabs: Project Custom 
Expressions, My Custom Expressions and Remote Custom Expression 
Library. 

2. Click the Remote Custom Expression Library tab.

If you like you can sort the custom expressions, please see below.

3. Add a Custom Expression to the project that is currently open by clicking 
the Add to project icon and then click OK.
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View a Custom Expression definition
Aim

To view what elements have been used in a Custom Expression definition and how 
they are combined.

Prerequisite

 You have the Action Unit Module or Baby FaceReader.

 Your FaceReader computer has a connection to the internet to access the 
Remote Custom Expression Library.

Procedure

1. From the File menu select Custom Expressions Browser. 
The Custom Expression browser opens with three tabs: Project Custom 
Expressions, My Custom Expressions and Remote Custom Expression 
Library. 

If you like you can sort the custom expressions, please see below.

2. Add a Custom Expression to your project by clicking the Add to project 
icon.

3. Click the Edit Custom Expression icon.
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A new window opens with a detailed view of the blocks and processors that are part 
of the expression. In the screenshot below you can see part of the Custom 
Expression ‘Attention’.
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To sort custom expressions

Click the Sort by name or Sort by date modified button on the toolbar to sort 
your Project Custom Expressions, the expressions under My Custom Expressions 
or the expressions in the Remote Custom Expression Library in alphabetical order 
or by date last modified. Click the Revert sort order to change the order from A-Z 
into Z-A or from latest to earliest date or vice versa.

To zoom in and out

Use the Zoom out, Zoom in and Fit to screen icons on the toolbar to customize 
the window. You can also use Ctrl- and Ctrl+ or Ctrl + scroll wheel to zoom out or 
in.

To rename a Custom Expression or change its color

Click the Edit information icon on the toolbar to open a new pane with the Custom 
Expression’s name, author, description and color. If you like you can edit the 
information.

Each Custom Expression has its own unique color which is the same throughout the 
program.
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Copy a Custom Expression
Aim

To edit the Custom Expression and use it in your project.

Prerequisite

 You have the Action Unit Module or Baby FaceReader.

 Your FaceReader computer has a connection to the internet to access the 
Remote Custom Expression Library.

Procedure

Click the Copy to my custom expressions button to copy your Project Custom 
Expressions or custom expressions from your Remote Custom Expression Library 
to My Custom Expressions. 
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Import a Custom Expression
Aim

To use a Custom Expression made on another computer.

Prerequisite

 You have the Action Unit Module or Baby FaceReader.

 You have received a Custom Expression (*.FCX) file or you have exported a 
Custom Expression definition (see Export a Custom Expression definition). 

Procedure

Click the Import custom expression button on the toolbar and browse to the 
location where you stored your Custom Expression (*.FCX file). Select it and then 
click Open. The new Custom Expression is added to My Custom Expressions.
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Edit a Custom Expression
Aim

To change the Custom Expression definition before using it in your analyses.

Prerequisite

 You have the Action Unit Module or Baby FaceReader.

 You can edit either Project Custom Expressions or Custom Expressions 
under My Custom Expressions. It is not possible to edit Custom 
Expressions from the Remote Custom Expression Library. To use a 
Custom Expression from the Remote Custom Expression Library in your 
project, you can either add it to your project or copy it to the list under My 
Custom Expressions (and then edit it and add it to your project).

Procedure

Editing Project Custom Expressions

 Locate the Custom Expression under Project Custom Expressions and 
click the Edit custom expression button. The detailed view of the Custom 
Expression opens and you can now add blocks, edit the existing ones or 
edit the processors.

 Right-click the Custom Expression in the Custom Expressions pane and 
select Select/Adjust Project Custom Expressions. Locate the Custom 
Expression under Project Custom Expressions and click the Edit custom 
expression button (see above).
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Editing My Custom Expressions

Locate the Custom Expression in the list under My Custom expressions and click 
the Edit custom expression icon. The detailed view of the Custom Expression 
opens and you can now add blocks, edit the existing ones or edit the processors.
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Export a Custom Expression definition
Aim

To save the Custom Expression to a FCX file and use it on another computer, give it 
to a colleague or send it to Noldus Support.

Prerequisite

You have the Action Unit Module or Baby FaceReader.

Procedure

Click the Export button to save your Project Custom Expression or Custom 
Expression under My Custom Expressions as a FCX file.
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Delete a Custom Expression
Aim

To clean up your project and remove the Custom Expressions that you will not use 
anymore.

Prerequisite

 You have the Action Unit Module or Baby FaceReader.

 You can delete Project Custom Expressions and Custom Expressions 
under My Custom Expressions. It is not possible to delete the Custom 
Expressions under Remote Custom Expression Library.

Procedure

To delete a Project Custom Expression

Locate the Custom Expression in the Custom Expressions pane. Right-click on the 
expression and select Remove Custom Expression From Project.

To delete a Custom Expression in the list under My Custom Expressions

Locate the Custom Expression in the list under My Custom Expressions and click 
the Delete button.
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Define a new Custom Expression
Aim

To construct your own Custom Expression and use it to quantify its activation in the 
test participant’s face. 

Prerequisite

You have the Action Unit Module or Baby FaceReader.

Procedure

1. From the File menu select Custom Expressions Browser or click the Add 
custom expression to project icon in the Custom Expressions pane. 

2. Click New Custom Expression in the toolbar. The Custom Expression 
Information window opens. Enter a name and (optional) a description for 
the expression and choose a color. You can also enter the name of the 
author (optional).



292

A new window opens with a grid with an Output block.

3. Click the Add block button on the toolbar to add the blocks that define 
your Custom Expression. The block browser opens with the Inputs, 
Processors and Custom Expressions that you can use.

4. Click on an Input, Processor or Custom Expression and then click OK to add 
it to the grid.

 See Custom Expression inputs in detail

 See Custom Expression processors in detail

5. Repeat step 2 and 3 to add more blocks to the grid.

6. Connect the blocks with connectors in such a way that you get the correct 
definition of the Custom Expression.

Tip: You can check whether you defined your Custom Expression correctly by 
using the Input simulator.
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Custom Expression inputs in detail
You can choose one or more of the following building blocks:

Facial Expressions

The default facial expressions (Neutral, Happy, Sad, Angry, Surprised, Scared, 
Disgusted and Contempt). 

Please note that the default expressions are available as building blocks with Baby 
FaceReader but they do not generate an output as Baby FaceReader cannot detect 
the default facial expressions. 

1. Click the facial expression building block you need and then click OK to add 
it to the grid.

2. Click the Edit button to select one of the three Smoothing options and 
choose whether the smoothed or raw values are used:

 Based on analysis settings — FaceReader uses the option chosen in the 
Analysis Settings. See Classification in the Settings chapter.

 Always smoothed — FaceReader uses smoothed data.

 Always raw — FaceReader uses the raw, unsmoothed data.

Derived Expressions

Valence and Arousal
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Action Units

The 20 Action Units that are available in FaceReader, unilateral Action Units (left and 
right) and combined.

1. Click the Action Unit building block you need and then click OK to add it to 
the grid.

2. Click the Edit button to select one of the three Smoothing options and 
choose if the smoothed or raw values are used. See Facial Expressions.

3. Set the Intensity threshold. If the intensity of the Action Unit is lower than 
this threshold, the Action Unit will not be taken into account. The output of 
the building block will be zero.

Default value: 0.1 which is equal to the Not Active threshold (see Action 
Unit Intensity).

Head Orientation

Orientation of the head relative to the x, y and z-axis (Pitch, Yaw and Roll).
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Head Position

Horizontal position, Vertical position and Depth position relative to the camera.

Landmarks

Landmark X, Landmark Y, Landmark Z (respectively, the horizontal, vertical and 
depth translation of the landmark relative to the camera) and Landmarks Distance 
(the distance between two landmarks relative to the camera in millimeters).

1. Click one of the four building blocks and then click OK to add it to the grid.

2. Click the Edit button to set the Landmark index and in case of Landmarks 
Distance also the Dimensionality (either 2D or 3D).
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Gaze Angles

Horizontal gaze angle, Vertical gaze angle.

Heart Rate

Heart Rate, Heart Rate Variability (RMSSD) and Heart Rate Variability (SDNN).

Tip: Click on one of the blocks to read the information that comes with it. Each 
block comes with a description and information on what values it can have as 
output. The Action Units also come with an example video in which the Action 
Unit is demonstrated.

Voice Expressions

Neutral from Voice, Happy from Voice, Sad from Voice and Angry from Voice.

Voice secondary Expressions

Valence from Voice, Arousal from Voice, Loudness, Speech rate

Miscellaneous

Model quality — The model quality has a value between 0 and 1 and is represented 
by the Model quality bar in the analysis.
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Custom Expression processors in detail
To combine blocks you need processors. The following processors are available:

Mathematical processors

 Maximum — This processor compares two (or more) numerical input 
values. The output is the highest value. For instance, when calculating 
Valence, FaceReader compares the intensities values of Angry, Sad, Scared 
and Disgusted. The highest value of the four is subtracted from the 
intensity of Happy.

 Minimum — This processor compares two (or more) numerical input 
values. The output is the lowest value.

 Sum — This processor calculates the sum of all its numerical input values. 
The screen shot below is part of the Custom Expression ‘Interest’. The first 
step in the definition is to assess which of the Action Units 1, 2 or 12, has 
the highest value and sum this value and half of the intensity of Attention.

 Average — This processor calculates the average of all its numerical input 
values.

 Filtered Aggregate — With this processor FaceReader can, for instance, 
calculate the average of the three highest input elements. In the screen shot 
below FaceReader calculates the average intensity of the three Action Units 
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with the highest intensity (1, 17 and 20). In this example this means 
calculating the average of 0.6; 0.5 and 0.4. The output value is 0.5.

Click the pencil icon to edit the settings:

- Selection: either Top or Bottom.

- Number of elements: select how many inputs you want to take into 
account.

- Aggregation operation: select whether you want to calculate the 
Average, Sum, Standard Deviation, Maximum, Minimum or Median of the 
input values.
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 Scale — This processor multiplies its numerical input value with the value 
you enter as a parameter.

 Offset — This processor adds the value that you enter as a parameter to 
the numerical input value.

 Subtract — With this processor FaceReader subtracts numerical input value 
B (bottom connector) from numerical input value A (top connector). The 
screenshot below is part of the definition of the Custom Expression 
‘Attention’ in which the maximum of four input values is subtracted from 
the constant value 1. 
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 Divide — With this processor FaceReader divides numerical input value A 
(top connector) by numerical input value B (bottom connector). 

 Multiply — With this processor FaceReader multiplies input value A (top 
connector) by input value B (bottom connector).
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 Scale to range — Use this processor if you want the numerical input to fall 
within a new range. Enter the minimum and maximum values of the original 
range and the minimum and maximum value of the new range. The Custom 
Expression definition for ‘Confusion’ contains the ‘Scale to range’ processor 
in the screenshot below. In step x of the definition the output values can 
range from 0 to 4. With the ‘Scale to range’ processor, you scale the values 
from 0 to 1.
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 Power — With this processor the input value (0.2 in the example in the 
screenshot below) is raised to the power of n. In this example n=2 and the 
output is 0.04.
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 Exponent — This processor has two inputs (A and B). The Exponent block 
uses the formula: B to the power of A (0.3 to the power of 2 in the example 
below). If you connect the input blocks the other way around the result is 2 
to the power of 0.3.

 Logarithm — This processor takes the logarithm of the top input (A) with 
the bottom input (B) as base. The output is Log B(A) (logarithm of 2 to base 
0.3 in the example below). If you connect the input blocks the other way 
around the result is logarithm of 0.3 to base 2.
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 Logistic — A Logistic block has one input, x. When you click the pencil 
button you can set the limit (L), the steepness (k) and the midpoint (x0). The 
output is L/(1+e^(-k(x-x0))). The Logistic processor is used in the custom 
expression ‘Spontaneous laughter’. The S-shaped logistic function helps to 
promote high activation values and suppress low activation values. 
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 Square root — This processor takes the square root of the input value.

 Absolute — This processor takes the absolute value of the input. You can, 
for instance, base your Custom Expression on the Valence and treat positive 
and negative values similarly. An input value of -0.6 (like in the screenshot 
below) results in an output of 0.6 and a Valence intensity of 0.6 also results 
in an output of 0.6.

 Clip — This processor changes the input value into a value that fits in a 
range between a minimum and a maximum value. The example in the 
screenshot below shows part of the definition for Frowning. The input value 
(Sum = the sum of the intensities values of Action Unit 4 and 0.5 x Action 
Unit 7) is >1. The maximum set for the clip range is 1 so the output value is 
1.
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Logical

 Condition — This processor compares input value A (top connector) with 
input value B (bottom connector). It checks either whether A>B, A≥B, A<B, 
A≤B or A=B (depending on what comparison type you choose). The 
condition can either be True of False. In the screen shot below the value of 
Action Unit 43 is compared with the value 0.7 using the comparison 
operator ‘>’. As 0.13 is smaller than 0.7, the condition is False. 
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 And — This processor has multiple Boolean values (True/False) as input and 
a single Boolean value as output. Use this processor, for instance if you 
want two or more conditions to be true for the Custom Expression to be 
active. The screenshot below is part of the definition of the Custom 
Expression ‘Duchenne smile’. For a Duchenne smile (genuine smile) both 
Action Unit 6 and Action Unit 12 must be active. In this example, the 
definition is that both Action Units must have a value greater than 0.2. If 
Condition 1 (for Action Unit 6) AND condition 2 (for Action Unit 12) are 
true, there is a Duchenne smile.

 Or — This processor has multiple Boolean values (True/False) as input and a 
single Boolean value as output. It compares two or more conditions with an 
OR logic. The screenshot below shows part of the definition of the Custom 
Expression ‘Attention’ (binary). The Or processor checks four conditions. If 
one of them is true, the output is True. If all four conditions are false, the 
output is False.
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 Not — This processor has a single Boolean value as input (for instance, a 
condition that is either True or False) and a single Boolean value as output. 
If the input is True, the output is False and vice versa.

 If.. Else.. —. An If.. Else block has three inputs: (1) Condition C (left 
connector); (2) Numerical value A (top connector); (3) Numerical value B 
(bottom connector). The output is A if C is True and B if C is False. The 
screen shot below is part of the definition of the Custom Expression 
‘Duchenne smile’. The output of the If.. Else.. processor is the average 
intensity value of Action Unit 12 and Action Unit 6 if Action Unit 6 AND 
Action Unit 12 are active (that is, have both an intensity value higher than 
0.2). The output is 0.2 if one or both Action Units are not active.

Temporal

The temporal processors are identical to their non-temporal counterparts except for 
the temporal aspect. The temporal processors calculate the (weighted) average/
sum/maximum/minimum over the time (duration) you specify. You can also specify 
the minimum percentage of valid samples required to produce a valid output. You 
can use the temporal processors if your custom expression cannot be determined 
based on a single point in time and requires a history. For the running processors 
you cannot set any parameters.

 Temporal average — This processor calculates the average of its numerical 
input values over the specified time. 

 Temporal weighted average — This processor calculates a weighted 
average of its numerical input values over the specified time. Older results 
weigh less than more recent results. 

 Temporal standard deviation — This processor calculates the standard 
deviation of its numerical input values over the specified time.
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 Temporal first derivative — This processor calculates the rate of change 
over the specified time. The output is (value of the last valid frame - value of 
first valid frame)/duration.

 Temporal sum — This processor calculates the sum of all its numerical 
input values over the specified time.

 Temporal maximum — This processor compares two or more numerical 
input values. The output is the highest value.

 Temporal minimum — This processor compares two or more numerical 
input values. The output is the lowest value.

 Temporal counter — This processor counts the number of times an input 
value crosses a given threshold in a specified direction.

 Running average — This processor calculates the average value over all 
previous valid samples.

 Running maximum — This processor calculates the maximum value of all 
previous valid samples.

 Running minimum — This processor calculates the minimum value of all 
previous valid samples.

 Running counter — This processor counts the total number of times an 
input value crosses a given threshold in a specified direction from the 
beginning of the analysis.

Miscellaneous

 Constant value — Use this processor for instance in combination with a 
Condition to compare the intensity value of an Action Unit with the 
constant value. See ‘Condition’ for an example.

 Unknown — Use this processor to give a custom expression the value 
‘Unknown’. In the screenshot below we defined a custom expression that 
only gives a value if Action Unit 43 has intensity = 1. In the example, the 
intensity of AU43 < 1. That means that the condition is false and that the 
output of the If/else processor is B (Unknown).
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 pi (π) — The number pi (≈ 3.14159) is a mathematical constant, the ratio of 
a circle’s circumference to its diameter.

 e — The number e (Euler’s number, ≈ 2.71828) is a mathematical constant.

Tip: Click on a processor to read the information that comes with it. Each 
processor comes with a description and information on what type of input it can 
have, what the output will be and what parameters you can define. 
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A Custom Expression block in detail

 Color — The color on the left side of the block indicated what type of block 
it is (red for input blocks, orange for processors, purple for Custom 
Expressions and green for the output block).

 Name — The name of the block.

 Value or state — The value of an input block (as defined with the input 
simulator, shown in a blue field) or the output value or state of a processor 
block (shown in a green field).

 Description/parameters button — Click the pencil button to enter the 
parameters and to view a description of the block.

 Connectors — Use the connectors to connect the block to other blocks. 
Input blocks have one output connector. Processors have one or more 
input connectors and one output connector. When you hover with your 
mouse over a connector, you can see what type of input is required and 
how many inputs are allowed (for an input connector) and what type of 
output it has and how many output connections are allowed (for an output 
connector). To make a connection, drag with your mouse from one 
connector to the other. To delete a connection, hover with your mouse over 
it until it becomes green and then click.

Note

A block gets the label ‘skipped’ (in an orange field) if its value or state is not taken 
into account when calculating the output value of the Custom Expression. For 
instance, because one (or more) of its own input or output connections are missing 
or because a connection further down in the definition is missing.
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Working with custom expression blocks
Copy and paste a block

Right-click a block, select Copy and then right-click it again and select Paste to 
duplicate the block.

Delete a block

Click the block and then click Delete on your keyboard or right-click the block and 
select Delete.

Multi-select blocks

 Select multiple blocks to move them together in one of the following two ways:

 Press the Ctrl key on your keyboard and select multiple blocks.

 Drag with your mouse to draw a box around multiple blocks.



315

Input simulator
To check whether you defined your Custom Expression correctly, you can use the 
Input simulator. The Input simulator allows you to fill in values for each input. You 
can also use the slider to specify a value. Each step in the definition will be 
calculated and you can check what the output is. In this way you can assess whether 
you correctly defined your Custom Expression.

The Input simulator indicates whether the Custom Expression is valid. If, for instance 
one of the connections is missing, the Custom Expression is invalid.
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If you use a temporal processor in your definition, FaceReader comes with the 
following note: “Your Custom Expression contains a Temporal processor. During 
input simulation the complete history is assumed to have the same value as entered 
below”. In the screenshot above you can see this note, indicating that the definition 
of the Custom Expression contains a temporal processor. If you, for instance, filled 
in 02.00 seconds as the duration of the history when defining the temporal 
processor, FaceReader assumes that during these 02.00 seconds the Action Units 6, 
12, 25, and 26 had a constant value, that is, the value that you defined in the Input 
simulator.
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Visualize Custom Expressions
Aim

To display Custom Expressions during or after the analysis.

Prerequisites

 Your FaceReader license includes the Action Unit Module or you have Baby 
FaceReader.

 Action Unit analysis is switched on in the Settings.

See 

Custom Expressions Table

Select Custom Expression Table from one of the visualization windows. The table 
shows the intensities of the Custom Expressions that you added to your project. If 
your input is a live video stream or a video file, you will see the intensities change 
over time during the analysis or when you play back the analysis, reflecting the 
changes in custom expressions on the face.

Custom Expressions Line Chart

1. Select the Custom Expressions Line Chart from one of the visualization 
windows (see Manage analysis windows). 

2. Choose which Custom Expressions to display from the Custom 
Expressions list on the toolbar. By default all Custom Expressions are 
selected. 
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Note

To copy, save, or zoom in this window, see Common options in FaceReader’s output
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Export Custom Expressions
Aim

To export the Custom Expressions to a text file or The Observer XT format file. 

Prerequisites

 You have the Action Unit Module or Baby FaceReader.

 You carried out an analysis.

Procedure

1. Choose File > Settings and then click the Data Export tab. 

2. Under Export (Detailed log, ODX, N-Linx and API), select Custom 
expressions and then click OK.

3. Choose File > Export and select one of the options. 

See Export the data in FaceReader’s output
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Custom Expression intensities in The 
Observer XT
If you send FaceReader data to The Observer XT 13 or higher versions using the N-
Linx network communication protocol, Custom Expression intensities are imported 
as external data. You can also manually import Custom Expressions. To be able to 
import Custom Expressions as external data you need the External Data Module of 
The Observer.

See FaceReader with The Observer XT
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The Vital Signs Module

Main topics

 Introduction to the Vital Signs Module

 Analyze heart rate, heart rate variability and breathing rate

 Analysis in phases

 Visualize vital signs
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Introduction to the Vital Signs Module
Vital signs

The Vital Signs Module allows you to measure heart rate, heart rate variability and 
breathing rate. Heart rate and heart rate variability are measured by means of 
remote photoplethysmography (RPPG). Breathing rate is measured by detecting 
upper-body movement associated with respiration.

Remote PPG

Photoplethysmography is a simple and low-cost optical technique that can be used 
to detect blood volume changes in the tissue under the skin. It is based on the 
principle that changes in the blood volume result in changes in the light reflectance 
of the skin.

With each cardiac cycle the heart pumps blood to the periphery. Even though this 
pressure pulse is somewhat damped by the time it reaches the skin, it is enough to 
distend the arteries and arterioles in the subcutaneous tissue. 

PPG is often used non-invasively to make measurements at the skin surface. In 
remote PPG (RPPG), FaceReader can detect the change in blood volume caused by 
the pressure pulse when the face is properly illuminated. The amount of light 
reflected is then measured. When reflectance is plotted against time, each cardiac 
cycle appears as a peak. This information can be converted to heart rate average 
and variability.

For an overview of the accuracy of the estimated heart rate, see Gudi et al. (2020).

References

Photoplethysmography

Reisner, A. T., Shaltis, P. A., McCombie, D. and Asada, H. H. (2008). Utility of the 
Photoplethysmogram in Circulatory Monitoring. Anesthesiology, 108, 950-958. 

http://en.wikipedia.org/wiki/Photoplethysmogram

Remote PPG and FaceReader

Gudi, A.; Bittner, M.; Van Gemert, J. (2020) Real-time webcam heart rate and 
variability estimation with clean ground truth for evaluation. Applied Sciences 
10(23): 8630.

Tasli H. E., Gudi, A., and den Uyl, M. (2014). Integrating Remote PPG in Facial 
Expression Analysis Framework. Proceedings of the 16th International Conference on 
Multimodal Interaction, Istanbul, November 12-16, 2014, 74-75. 
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http://www.vicarvision.nl/pub/RPPG_Facial_Expression_Analysis.pdf

Please cite the original work in your studies when based on FaceReader’s remote 
PPG.

Patent number

The European Patent Office has granted patent EP2960862A1 to Vicarious 
Perception Technologies for the method for stabilizing vital sign measurements 
using parametric facial appearance models via remote sensors (https://
patents.google.com/patent/EP2960862A1/en). 

Vital Signs Module

With FaceReader’s Vital Signs Module, you can analyze heart rate, heart rate 
variability (HRV), and breathing rate of the test participant without additional 
hardware other than a suitable webcam. 

Heart rate variability can be derived from the single heart beats that are used to 
calculate the heart rate. HRV measures the variability between heart beats, which 
can give important insights into the physiology of a person as it reflects changes in 
activation of the autonomic nervous system. With FaceReader, you can obtain the 
timing of individual heart beats (which can be visualized in FaceReader’s heart beat 
log), as well as HRV measures like RMSSD and SDNN. In addition, FaceReader can 
measure a test participant’s respiration rate.

RMSSD

One of the most commonly used measures of heart rate variability is the root mean 
square of successive differences (RMSSD).

The differences in time between single heart beats are called RR intervals or inter-
beat intervals.

RRn = beatn+1 - beatn
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Differences between the RR intervals are called successive differences (SD)

SDn = RRn+1 - RRn

The RMSSD is the root mean square of two successive RR intervals. The unit of 
RMSSD is the same as the time unit chosen in equation 1 (usually it is milliseconds).

          

SDNN

SDNN is the standard deviation of normal to normal R-R intervals. “Normal” means 
that abnormal beats, like ectopic beats (heart beats that originate outside the right 
atrium’s sinoatrial node), have been removed.

Guidelines for an optimal vital signs measurement

Lighting

Make sure that lighting is diffuse. Indirect natural light is preferable, otherwise 
artificial diffused lighting can also be used. Lighting is preferably from a frontal 
direction and there are no strong shadows on the face. Strong specular reflection 
(e.g., bright white spots on the forehead) should be avoided.

See also Camera and accessories

Subject requirements

 Distance between camera and subject: 0.5 - 1 m.

 Ensure that the subject’s full forehead/upper part of the face is clearly 
visible for reliable RPGG measurements. Since RPPG primarily depends on 
the analysis of the upper region of the face, it must be well exposed to the 
camera, and not occluded by hair, a hat, etc.
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 For reliable breathing rate measurements it is crucial that the test 
participant’s shoulders are visible in the camera view/video. Excessive 
movement of e.g., arms in front of the chest will reset the calibration and 
should be avoided. If chest motions are very shallow or if there is no 
breathing detected, a warning will be shown in the Vital Signs window 
informing you that FaceReader “failed to model body pose”.

Camera settings

Remote PPG is intended to work with the cameras supported for FaceReader (see 
Camera and accessories). Do note that for Remote PPG the following cameras are 
unsuitable due to internal video processing: Logitech Brio, Microsoft Lifecam. Below 
you find recommended settings:

 In general, videos should be recorded with the minimum amount of 
compression (e.g., ideal settings are: the YUY2 stream encoded with 
HUFFYUV, FFV1, MJPEG (lossless/low compression ratio), H264/H265 
(lossless/low compression ratio)). If your camera offers different video 
formats, choose the format that gives the highest file size, (for example, 
.avi).

 Frame rate: at least 15 fps; preferred 30 fps. Make sure FaceReader analyzes 
each frame. See Video in Settings

 Face size: at least 100 x 100 pixels, for example:

In a 1280 x 720 video, the face should cover 8-14% of the frame dimensions

In a 800 x 448 video, the face should cover 12-20%of the frame dimensions

Note that most cameras will only allow lossless/low compression recording 
at a lower resolution such as 800 x 448.

 Bits per pixel ratio: at least 0.15 bits/pixel, preferred 1 bit/pixel. The 
BitsPerPixel ratio is calculated as follows: 

For example, a video recorded at 30 fps with a resolution of 640 x 480 pixels 
should have a bit rate of at least 1.382 Mbit/second (preferred 9.216 Mbit/
second).

You can find the frame rate, resolution and bit rate of your video when you 
right-click the video filename in Windows Explorer and select Properties. 
You can find the information on the Details tab.
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 The following camera capture settings are optimal for accurate Remote PPG 
measurement:

- Saturation: High

- Contrast: High

Do note that adjusting these settings to extreme values can result in the 
image being distorted which may cause FaceReader to not find the face. 
Therefore, these settings should be adjusted such that the face appearance 
remains proper.

These camera settings allow for the best possible heart rate detection. 
These settings might impact the visual quality of the video, but will lead to a 
more accurate heart rate estimation.

 For optimal remote PPG measurements the camera should be able to 
capture a frontal view of the subject’s face throughout the session. The 
accuracy of the measurement is related with the head pose. Frontal head 
pose is recommended where abrupt head pose changes can degrade the 
optimal performance. Ensure that the camera is roughly at eye level.
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Recording video with MediaRecorder

To ensure video recording with enough detail for remote PPG, MediaRecorder 6 
(Noldus’ video recording tool) has a setting. In the Output settings window, 
choose ‘FaceReader-RPPG’ from the list. 
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Analyze heart rate, heart rate variability 
and breathing rate
Aim

To switch on heart rate, heart rate variability, and breathing rate analysis. 

Prerequisite

You have the Vital Signs Module. 

Procedure

1. Choose File > Settings > Analysis options. 

2. Under Optional Classifications, select Vital signs. 

Note

The option to analyze vital signs must be switched on, which is by default the case if 
you have the Vital Signs Module. However, when you upgrade a basic FaceReader 
license with the Vital Signs Module, you must switch the option on manually.
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Analysis in phases
Heart rate and breathing rate analysis is carried out in three phases, calibration, 
calculation, and post-processing. 

Calibration

FaceReader requires a 8.5 second calibration period for RPPG measurements in 
which the signal of the skin color is sampled and processed for a reliable 
measurement. During the calibration stage the test participant should look into the 
camera and avoid extensive head movement. 

Calibration is done at the start of analysis and every time the participant’s face is 
found again after it was not found for some time. When the face is found again, the 
Heart rate window shows Calibrating.

FaceReader needs at least 5 minutes to calculate a value for the heart rate 
variability. This default setting was chosen according to standards found in the 
literature. You can change the heart rate variability period in the settings (File > 
Settings > Advanced settings).

The calibration period for breathing rate measurements is 15 seconds. Excessive 
movements of e.g., arms in front of the chest will reset calibration. If chest 
movements are very shallow, or there is no breathing detected, a warning message 
will be shown in the Vital Signs window.

Calculation

To calculate the heart rate and breathing rate, for each time step the pulses/breaths 
over the previous ten seconds are used. Heart rate is expressed in beats per minute 
(bpm) and breathing rate in breaths per minute (bpm).

Post-processing

At the end of analysis, the estimated heart rate, heart rate variability, and breathing 
rate are post-processed to improve the accuracy, also in the initial 8.5/15 seconds 
and every time a new calibration was carried out. Note that after analysis the 
reported heart rate and breathing rate values can differ from those seen during 
analysis. Do not rely on the exact values you see during analysis.
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Visualize vital signs 
Aim

To display the heart rate, heart rate variability and breathing rate during or after the 
analysis.

Prerequisites

 Your FaceReader license includes the Vital Signs Module.

 Vital signs analysis is switched on in the Settings.

See Analyze vital signs.

 You are running an analysis, or viewing the analysis afterwards.

Vital Signs

The Vital Signs window shows the current heart rate of the participant estimated by 
means of remote photoplethysmography. Heart rate is expressed in beats per 
minute (bpm). The Vital Signs window also shows the heart rate variability (RMSSD 
and SDNN) and breathing rate. The window shows confidence indicator bars 
indicating how confident the current measurements are.

See Introduction to the Vital Signs Module 

To view the Vital Signs window

Click the Select window button in one of the analysis windows and select Vital 
Signs and again Vital Signs. 
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If your settings deviate from the recommended settings, a warning will show up in 
the Vital Signs Heart Rate window, informing you that the ratio between the frame 
rate, bit rate and resolution is too low to estimate the vital signs heart rate with high 
accuracy. See Camera settings for the recommended settings.

Vital Signs Line Chart 

The Vital Signs Line Chart shows the heart rate, heart rate variability estimated with 
Remote photoplethysmography, and the respiratory rate plotted against time.

To view the Vital Signs Line chart

Click the Select window button in one of the visualization windows and select Vital 
Signs > Vital Signs Line Chart. 
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From the Vital Signs drop-down list, select what you want to view, Heart Rate, 
Heart Rate Variability (RMSSD), Heart Rate Variability (SDNN) and/or 
Breathing Rate. Please note that in the chart above heart rate variability was not 
selected. When you play back a video, a hairline shows the time in the video. 

At the end of analysis, the estimated heart rate, heart rate variability, and breathing 
rate are post-processed to improve the accuracy, also in the initial 8.5/15 seconds 
and every time a new calibration was carried out. Note that the reported heart rate 
and breathing rate values after analysis can differ from those seen during analysis. 
Do not rely on the exact values you see during analysis. The heart rate, heart rate 
variability, and breathing rate lines in the ‘Vital Signs Line Chart’ have a different 
color before and after post-processing.

Notes

 Click Options and then select Auto Scale Y axis to adjust the Y axis to the 
maximum value.
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Heart Beat Chart

The Heart Beat Chart shows the heart beats on a time line. It gives you an 
impression of the heart rate variability.

Heart rate and heart rate variability are subject to Post-processing. The heart rate 
peaks have a different color before and after post-processing.

To view the Heart Beat Chart

Click the Select window button in one of the visualization windows and select Vital 
Signs > Heart Beat Chart. 
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Export heart rate, heart rate variability 
and breathing rate data
Aim

To export the heart rate, heart rate variability and breathing rate data of your test 
participants to an Excel file or a text file to view them outside FaceReader or to 
import them into The Observer XT. 

Prerequisites

 You have the Vital Signs Module.

 You selected Vital Signs analysis and export in the Settings.

 You carried out an analysis.

Procedure

1. Choose File > Export and select one of the three options. 
See Export the data in FaceReader’s output

2. Browse to the folder in which you want to save the export files and click 
Select.

3. From the Log type drop-down list select the format of your log files, either 
Excel format or text. Choose Text files if you want to import the log files into 
The Observer XT.

4. Select Save detailed log and click OK.
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Export heart beat log
Aim

To export the inter-beat interval data (the time intervals between individual hear 
beats).

Prerequisites

 Your FaceReader license includes the Vital Signs Module.

 Vital signs analysis and export is switched on in the Settings.

See Analyze vital signs 

 You ran a video or camera analysis.

Procedure

1. From the File menu select Export and select one of the three available 
options.

2. Select the folder in which you want to save the log file.

3. Select Save heart beat log.

See Export analysis results in FaceReader’s output.
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Vital signs data in The Observer XT

If you send FaceReader data to The Observer XT 13 or higher versions using the N-
Linx network communication protocol, Vital Signs data are imported as external 
data. You can also manually import Vital Signs data. To be able to import Vital Signs 
data as external data you need the External Data Module of The Observer.

See FaceReader with The Observer XT

Please note that the data in the screen shot below come from a project in which the 
Heart rate variability period was set to one minute (the default is five minutes). 
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The Voice Analysis Module

Main topics

 Introduction to the Voice Analysis Module

 Analyze voice characteristics

 Visualize voice characteristics

 Export voice analysis data
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Introduction to the Voice Analysis 
Module
The Voice Analysis Module enables you to analyze vocal characteristics. FaceReader 
can currently detect the following emotions in a voice: Neutral, Happy, Sad, Angry. 
The software was trained and tested using British and American English data, both 
acted and natural speed. Preliminary tests show potential applicability to other 
languages, particularly those with close linguistic and cultural similarities.

An audio buffer is used to collect approximately one second of data before starting 
the analysis because audio (unlike video) cannot be segmented into discrete 
frames. FaceReader uses a simple Voice Activity Detection (VAD) and analyzes all 
sound above the threshold. If there is noise in the audio signal this will be analyzed 
as well.

There is no preprocessing step to decide if audio is speech, so background noise 
can result in incorrect detections. Using a high-quality microphone and limiting 
background noise is recommended to improve the accuracy of the voice analysis. 
Furthermore, it might be necessary to adjust the microphone’s sensitivity to achieve 
the best results.

Please note that you cannot combine the Voice Analysis Module with Baby 
FaceReader and you cannot analyze emotions in voices in a multi-subject analysis.

Note

The Voice Analysis module employs Voice Activity Detection (VAD) based on a 
Gaussian Mixture Model (GMM) to distinguish between speech and non-speech 
segments. This approach helps ensure that only voiced segments are processed, 
reducing the influence of silence or background noise. While GMM-based VAD is 
generally reliable under typical conditions, it is not immune to mis-classifications, 
particularly in environments with overlapping speech, high levels of ambient noise, 
or non-speech sounds within similar frequency bands. Only if voice is detected, the 
following measures will be calculated and reported by FaceReader.
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Analyze voice characteristics
Aim

To switch on voice analysis. 

Prerequisite

You have the Voice Analysis Module. 

Procedure

1. Choose File > Settings > Analysis options. 

2. Under Optional Classifications, select Voice analysis. 

Note

The option to analyze the voice must be switched on, which is by default if you have 
the Voice Analysis Module. However, when you upgrade a basic FaceReader license 
with the Voice Analysis Module, you must switch the option on manually. 
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Visualize voice characteristics 
Aim

To display the voice characteristics during or after the analysis.

Prerequisites

 Your FaceReader license includes the Voice Analysis Module.

 Voice analysis is switched on in the Settings.

See Analyze voice characteristics

 You are running an analysis, or viewing the analysis afterwards.

Voice Expression Intensity

The Voice Expression Intensity chart displays the intensity of the four basic 
emotions that can be recognized in the voice (Neutral, Happy, Sad and Angry). You 
will see the bars change over time, reflecting the changes in expressions in the 
voice.  

To view the Voice Expression Intensity Chart

Click the Select window button in one of the analysis windows and select Voice 
Analysis and then Voice Expression Intensity Chart. 
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Voice Expression Line Chart

The Voice Expression Line Chart shows the detected emotions over time. There 
are gaps in the line chart if the VAD does not detect voice. This detection method 
cannot be adjusted. If there is noise in the audio signal, the Voice Expression Line 
Chart may show continuous lines even though the participant did not speak all the 
time.

To view the Voice Expression Line Chart

Click the Select window button in one of the analysis windows and select Voice 
Analysis and then Voice Expression Line Chart. 
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There are gaps in the line chart at the time points when the volume was below the 
threshold. 

Voice Valence and Arousal Line Chart 

The Voice Valence indicates whether the emotional state of the subject is positive or 
negative. 'Happy' is the only positive emotion, while 'Sad' and 'Angry' are 
considered to be negative emotions. Valence is calculated by subtracting the 
intensity of the strongest negative emotion from the intensity of 'Happy'.

Arousal is the weighted average of Loudness and Speech rate. See How is Loudness 
calculated? and How is Speech rate calculated?

To view the Voice Valence and Arousal Line Chart

Click the Select window button in one of the analysis windows and select Voice 
Analysis and then Voice Analysis and Arousal Line Chart. 
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There are gaps in the line chart at the time points when the volume was below the 
threshold. 

Voice View

The Voice View shows a two-second audio waveform. The color indicates the 
detected emotions. If a volume threshold is crossed, the two meters on either side 
of the waveform show the volume-independent Loudness and the Speech Rate.

To view the Voice View

Click the Select window button in one of the analysis windows and select Voice 
Analysis and then Voice View. 
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How is Loudness calculated?

Loudness is a custom volume-independent loudness measure. Variations in 
microphone sensitivity and speaker positioning can significantly affect the absolute 
volume of a recording. To address this, the loudness measure is computed using a 
continuously updated, normalized audio signal. For each frame in the video, the 
system analyzes the past second of audio. Within this one-second window, the 
audio is normalized so that its maximum absolute amplitude is 1.0. This ensures 
that the measurement reflects the speaker's vocal dynamics, i.e. how energetically a 
person is speaking within their own dynamic range, rather than the recording 
conditions. After normalization, the RMS (root mean square) value is calculated to 
capture the average energy of the speech in that time frame. Because the signal is 
normalized before computing the RMS, the resulting loudness value is always 
scaled between 0 and 1, where 0 corresponds to silence and 1 represents a 
sustained signal at maximum amplitude.

How is Speech rate calculated?

The speech rate measure estimates how quickly a person is speaking. The 
algorithm detects peaks in the audio signal, typically corresponding to syllables, by 
identifying bursts of vocal energy. These peaks are counted over the same one-
second window used for loudness analysis. The count is then normalized to a value 
between 0 and 1, using an upper bound suitable for capturing various emotional 
states [1,2]. A higher value indicates faster speech, while a lower value reflects 
slower or more deliberate speaking.

1. Arnfield, S., Roach, P., Setter, J., Greasley, P., Horton, D. (1995) Emotional stress and 
speech tempo variation. Proc. ESCA/NATO Workshop on Speech under Stress, 13-
15.
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2. Braun, Angelika & Oba, Reiko. (2007). Speaking Tempo in Emotional Speech - a 
Cross-Cultural Study Using Dubbed Speech.
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Export voice analysis data
Aim

To export the expressions detected in your test participant’s voice to a text file or 
The Observer XT format file. 

Prerequisites

 You have the Voice Analysis Module.

 You carried out an analysis.

Procedure

1. Choose File > Settings and then click the Data Export tab. 

2. Under Export (Detailed log, ODX, N-Linx and API), select Expressions 
from voice and then click OK.
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3. Choose File > Export and select one of the options. 

See Export the data in FaceReader’s output

The export file contains columns for each expression (Neutral from Voice, Happy 
from Voice, Sad from Voice and Angry from Voice), as well as for Valence 
(Valence from Voice), Arousal (Arousal from Voice), Loudness and Speech rate. 
Each expression has a value between 0 and 1, indicating the intensity of the 
expression. '0' means that the expression is not detected in the voice, '1' means that 
it is maximally present. Arousal from Voice, Loudness and Speech rate also have a 
value between 0 and 1. Valence from Voice has a value between +1 and -1. For 
more information see Voice Valence and Arousal Line Chart and Voice View.

The first milliseconds of the log file have ‘Unknown’ as value. This is due to the 
audio buffer which is used to collect approximately one second of data before 
starting the analysis.

Voice expression data in The Observer XT

If you send FaceReader data to The Observer XT 13 or higher versions using the N-
Linx network communication protocol, Voice expression data are imported as 
external data. You can also manually import Voice expression data. To be able to 
import Voice expression data as external data you need the External Data Module of 
The Observer.

See FaceReader with The Observer XT
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The Advanced Research
Module

Main topics

 Introduction to the Advanced Research Module

 Analyze multiple subjects per video

 Track the test participant’s gaze when presenting stimuli
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Introduction to the Advanced Research 
Module
The Advanced Research Module enables you to analyze multiple faces in a video, 
for instance participants in a focus group that were filmed with a single camera. See 
Analyze multiple subjects per video for the steps to follow.

Please note that you cannot use any of the following analyses in a multi-subject 
analysis: Vital Signs analysis, Voice analysis and Consumption Behavior analysis.

With the Advanced Research Module you can also track the gaze of a test 
participant. For gaze tracking you need the Stimulus Presentation Tool. After the 
test you can visualize the stimulus with a gaze overlay. You can also create a 
heatmap showing the hotspots on the stimulus where the participant looked the 
longest. See Track the test participant’s gaze when presenting stimuli. 

Please note that you cannot combine the Advanced Research Module with Baby 
FaceReader.
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Analyze multiple subjects per video
Aim

To analyze facial expressions of multiple faces in a video. 

Prerequisites

You have a pre-recorded video to analyze in FaceReader. It is not possible to 
analyze facial expressions of multiple subjects when you do a camera analysis.

Procedure 

1. On the Multi-subject Sources tab click the Add multi-subject video icon 
or from the Project menu select Multi-Subject Sources > Add Multi-
Subject Video.

2. Optionally, click the Analysis settings button to view or adjust the settings. 
See Settings for the current analysis for more information.
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3. Position the video to where you want to start the analysis. Optionally, 
deselect the Visualize results checkbox to speed up the analysis.

4. Click the Start analysis button. 

The track bar shows the progress of the analysis, the analysis speed (in fps), 
how many minutes:seconds.milliseconds of the video have been analyzed, 
the duration of the video and whether the video has audio.

5. Click the Stop Analysis button to stop the analysis or wait until the video 
has been fully analyzed. FaceReader shows how many participants were 
detected in the video and for how many minutes/seconds each participant 
was detected.
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6. Optional — Select participants to merge them, for instance because a 
participant walks out of the camera view and FaceReader labels him/her as 
a new participant when he/she enters the camera view again.

7. Select the participants that you want to add to your project and click Add 
to project and Yes to confirm your choice. You can add a maximum of 
eight participants. The participants are added to the Participants tab and 
the Multi-Subject Sources tab of the Project Explorer. 

Participants tab

On the Participants tab you can find the individual analyses per participant. When 
your hover with your mouse over the video icon of one of the participants, you will 
see the first face image that could be analyzed. In this way you can identify who is 
participant 1, participant 2, etc.
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Click the magnifying glass button next to one of the analyses to open it. A 
standard analysis view will open. Click the Show framing icon in the 
Analysis Visualization window to view who is participant 1, 2, 3, etc.
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Source: Video from YouTube showing prof. Dick Krueger at the University of 
Minnesota leading a focus group discussion.

On the track bar you can see in what parts of the video the participant face could be 
analyzed. The rest of the data is shown as gaps (shown in white).

If you analyze multiple videos of the same participants, FaceReader will not 
recognize the participants in the second, third etc. video. If you like, you can bring 
the analyses together. Right-click on an analysis in the Project Explorer, click 
Analysis and then Move Analysis To Other Participant. Select the target 
participant and then Yes to confirm the move.

Multi-Subject Sources tab

On the Multi-Subject Sources tab the participants are grouped by source. Double-
click Participants or click the icon next to Participants to get an overview of the 
participants that were detected in the video and added to the project. The overview 
also shows for how many minutes/seconds each participant was detected.
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Click the source button on the Participants tab or the Multi-Subject Sources tab 
to view the Multi-Subject Source window again. Click Exclude/Merge if you want 
to exclude/merge (more) participants.

Please note:

 You cannot calibrate participants in a multi-subject analysis.

 You cannot add analyses to multi-source participants.

 You cannot re-analyze the video.
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Track the test participant’s gaze when 
presenting stimuli
Aim

To assess what details in a stimulus attract the test participant’s attention. 

Prerequisites

 You have installed the Stimulus Presentation Tool.

 You selected Gaze tracking in the Settings > Analysis options.

Procedure 

Define a test in FaceReader and select Perform gaze calibration.

See Define a test and Carry out a test with the Stimulus Presentation Tool under 
Project Analysis.
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Project Analysis

Main topics

 Introduction to Project Analysis

 Important concepts in Project Analysis

 Stimuli and the Stimulus Presentation Tool

 Event markers

 Independent variables

 Project analysis in short

 Data selection

 Visualize your data in a chart

 Calculate statistics and summarize them in a table

 Visualize your stimulus, participant videos and line chart

 Compare data
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Introduction to Project Analysis
In FaceReader you can:

 Annotate Stimuli and events, to compare different parts of the analysis.

 Automatically present Stimuli to the test participant and synchronize them 
with FaceReader data (for this purpose use the The Stimulus Presentation 
Tool). Alternatively, manually present Stimuli to test participants and keep 
track which analysis parts correspond with the moments the Stimuli were 
shown.

In the Project Analysis section you can:

 Create and compare groups of participants. 

 Calculate mean intensities of facial expressions (and other parameters) of 
single participants, for participant groups, or when Stimuli were shown. If 
you have the Action Unit Module you can also calculate statistics for Action 
Units and Custom Expressions. If you have the Vital Signs Module you can 
calculate statistics for heart rate, heart rate variability, and breathing rate. If 
you have the Voice Analysis Module you can calculate statistics for 
expressions in the voice, loudness and speech rate.

 Calculate relative statistics using baseline correction. 

For example, calculate the expression intensities of test participants when 
they watched a certain commercial relative to the expression intensities 
when they were watching a neutral Stimulus. You can mark the time during 
which the test participants watched the commercial with a Stimulus. 

Note

Project Analysis was not designed for image analyses. Therefore, if your project only 
contains image analyses, you cannot carry out group analyses.
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Important concepts in Project Analysis
Independent variables

Independent variables

Independent Variables are factors that remain constant throughout an analysis, but 
can vary per participant. By default, each project contains the independent variables 
Age and Gender of the participant. These can be estimated by FaceReader, from the 
analyzed images. Alternatively, you can enter the values of these variables manually. 

You can define more independent variables. Examples of independent variables are 
the native language of the test participant, or whether the participant has previous 
experience with the product under investigation.

Independent variables can be used to compare participant groups.

See Independent variables

Stimuli and Event markers

You can mark episodes that you are especially interested in. This can be, for 
example, a time fragment during which the test participant watches a certain 
commercial. Or it can be the time a participant is allowed to drink or eat a certain 
product you are interested in. 

Stimuli

Use Stimuli to mark the parts of the analyses you are especially interested in. Stimuli 
are, for instance, the new commercials the test participants will watch or the pages 
of your newly developed website they will view. These time fragments have a fixed 
duration. 

You can use a video fragment as Stimulus source, for example a video with the 
commercial. You can score a Stimulus manually during or after carrying out the 
analysis. But if you use The Stimulus Presentation Tool, any Stimulus included in the 
test is automatically recorded by FaceReader, so you do not need to score it 
manually. 

See Stimuli and the Stimulus Presentation Tool

You can analyze the facial expressions over the time the Stimulus occurred and 
visualize the test participants face together with the Stimulus video. If you have the 
Action Unit Module you can also analyze Action Units and Custom Expressions. If 
you have the Vital Signs Module you can analyze heart rate, heart rate variability, 
and breathing rate.
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Event markers

With Event markers you can mark time fragments in the analysis, just like with 
Stimuli. In contrast to Stimuli, Event markers have no fixed duration and are not 
linked to a video. With Event markers you can, for example, mark episodes where 
something unexpected occurs, like a visitor entering the room, or mark events that 
have no fixed duration, like drinking a fruit juice. You score an Event marker 
manually and score it again, or score another one to set the stop time of the 
marker. 

See Event markers

Stimuli and Event markers in The Observer XT

Stimuli and Event markers can be exported into the detailed log. If you use 
FaceReader together with the annotation software The Observer XT, the Stimuli and 
events are imported into The Observer XT as state events. These can then be used 
to select the time fragments for further analysis. 

See FaceReader with The Observer XT 

The Stimulus Presentation Tool

With the Stimulus Presentation Tool you can automatically present Stimuli to test 
participants. You do not have to score Stimuli manually. You can organize the 
Stimuli in Tests (see below). The Stimuli and analysis are automatically synchronized. 

See The Stimulus Presentation Tool

Tests

In a test you define which Stimuli to present to test participants and in which order. 
Tests are carried out with the Stimulus Presentation Tool. When you carry out a test, 
a participant and analysis is automatically added to the project. The Stimulus 
Presentation Tool displays the Stimuli during the test while FaceReader records and/
or analyzes the participant’s face.

See Define a test

Calibration versus baseline correction

Instead of participant calibration, or continuous calibration, you can define a 
Neutral stimulus. Score this Stimulus when the test participant watches a neutral set 
of images or a neutral video fragment. In the analysis, calculate the facial 
expressions during the experimental Stimulus relative to the facial expressions 
during the neutral Stimulus. 
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Stimuli and the Stimulus Presentation 
Tool

Main topics

 Define Stimuli

 Score Stimuli

 The Stimulus Presentation Tool

 Carry out a test with the Stimulus Presentation Tool

 Define a test

 Specify connection settings for the Stimulus Presentation tool

 Run a test

 Computer settings for a two computer setup with Stimulus Presentation 
Tool

 Create exceptions in Windows Firewall for Stimulus Presentation Tool

 Synchronize computers with a network time protocol
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Define Stimuli
Aim

To define the Stimuli to show to test participants and, to score them manually, the 
associated key codes. 

Prerequisites

 Your FaceReader license includes the Project Analysis Module.

 You have Stimuli with a fixed duration, for example video fragments.

Procedure 

1. Choose Project > Stimulus > Add Stimulus or click the Add Stimulus 
button on the bottom-left pane.

2. In the window that opens, enter the Stimulus name, for instance, 
‘Commercial 1’.
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3. Under Trigger key, enter a keyboard key for this Stimulus. If you score the 
Stimuli manually, press this key when the Stimulus (commercial 1 in this 
example) starts.

4. Under Color, optionally change the color for the Stimulus and click OK. This 
color will be used throughout the program for this Stimulus.

5. Select to present either a video, or an image as Stimulus, or no external 
Stimulus. 

If your Stimulus is a video

1. Select the video, for instance, the video with the six commercials which your 
test participants will watch.

2. Enter the Start time in video (in hours:minutes:seconds with two decimals). 
In our example this is the start time of Commercial 1. If this commercial 
starts half a minute after the start of the video, enter 00:00:30.00. Leave 
00:00:00.00 if the video starts with this Stimulus.

3. Enter the Duration (in hours:minutes:seconds.milliseconds). In our example 
this is the duration of Commercial 1. 
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If the entire video file is a Stimulus, do not edit Duration.

If your Stimulus is an image

1. Select the image, for example a screen capture of a web page, or a 
wrapping of a chocolate bar. 

2. Enter the Duration (in hours:minutes:stimulusseconds.milliseconds).

If your Stimulus is not a video or image 

To score an event manually, for example a Stimulus by an external program other 
than the Stimulus Presentation Tool, or a phase in a test:

1. Select No Media. 

2. Enter the Duration (in hours:minutes.seconds.milliseconds).

Note

To delete or edit a Stimulus, open the Stimuli tab at the bottom of the Project 
Explorer. Right-click the Stimulus you want to delete or edit, and select the option 
you require.
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Score Stimuli
Aim

To mark the time the Stimulus was shown to the test participant. 

Prerequisites

 Your license includes the Project Analysis Module.

 You defined Stimuli. 

See Define Stimuli

 You have a video or camera analysis.

Procedure

To score a Stimulus during an analysis

 Automatically — Use The Stimulus Presentation Tool

 Manually — Press the trigger key that is associated with your Stimulus. 

If you have the Timeline window open, a bar appears with the same length as the 
Stimulus duration that you chose when you created the Stimulus. You can press the 
Stimulus trigger key for each time the Stimulus starts. 
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To score a Stimulus after an analysis

Open the Timeline window and scroll the video to the position where the Stimulus 
starts. Then press the Stimulus trigger key. A question appears whether you want to 
score the Stimulus at that point. Choose Yes.

Notes

 Multiple instances of the same Stimulus may not overlap. Therefore, do not 
start a Stimulus when the previous instance of this Stimulus has not ended.

 Do not score a Stimulus when the remaining video time is shorter than the 
Stimulus duration. If you do so, opening the Scored Stimulus window 
automatically moves the Stimulus start time to the latest possible moment 
in that video. 

 Scored Stimuli appear in the Project Explorer as dots above the analysis bar. 
Expand the Analysis and Scored Stimuli items to view the scored Stimuli.

 To copy scored Stimuli to other participants or analyses, unfold the analysis 
and double-click Scored Stimuli. Click the Stimulus you want to copy. Click 
Scored Stimuli at the top of the window that opens, and choose one of the 
options under Copy To.
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 To make sure the analysis is not interrupted, FaceReader does not give a 
warning during the analysis if you score overlapping Stimuli or score a 
Stimulus that continues after the end of the analysis. Instead, an error mark 
will appear in the Project Explorer and you must correct the scored Stimuli 
after the analysis is finished.

To do so, double-click Scored Stimuli or one of the lines. Alternatively, right-click 
Scored Stimuli, then select Edit Analysis, and then Edit Scored Stimuli & Event 
Markers. The Scored Stimuli window opens. The time periods in which Stimuli of 
the same type are overlapping are marked in red. 
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Move the Stimuli to their correct position, so that they are no longer overlapping. 
To delete a scored Stimulus, click the Delete Scored Marker button.
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The Stimulus Presentation Tool
What is the Stimulus Presentation Tool?

FaceReader is often used to analyze how a subject responds to one or more Stimuli 
in form of video, for example video commercials. Synchronizing the display of a 
Stimulus with the trigger of the corresponding Stimulus marker in FaceReader is 
essential. 

With FaceReader and the Stimulus Presentation Tool, you can:

 Define the Stimuli to be presented, organized in a test (see below).

 Present the Stimuli while FaceReader analyzes the test participant’s face.

 Automatically synchronize FaceReader data with Stimulus trigger markers.

 Track the test participant’s gaze with the Advanced Research Module.

Tests

A test is a collection of video Stimuli being presented to a test participant. You can 
store one or more tests in your FaceReader project. The Stimulus Presentation Tool 
displays the Stimuli during the test while FaceReader records and/or analyzes the 
participant’s face.

Furthermore:

 A test includes independent variables, like Gender, Age, or any other 
variable of interest defined in the project.

 Presentation of Stimuli can be randomized.

Software you need

 FaceReader with the Project Analysis Module.

 The Stimulus Presentation Tool.

 The Advanced Research Module if you want to track the test participant’s 
gaze.

 Recommended for two-PC configurations: a Network Time Protocol tool to 
synchronize computers.

See Synchronize computers with a network time protocol



190

To install the Stimulus Presentation Tool

1. Download the installation file Stimulus Presentation Tool 5 Setup.exe 
from the MyNoldus portal (my.noldus.com) and run it. 

2. Follow the instructions on the screen. 

By default, the Stimulus Presentation Tool is installed in the following location:

C:\Program Files\Noldus\Stimulus Presentation Tool 5.

To upgrade the Stimulus Presentation Tool

If you upgraded FaceReader from version 6, 7, 8 or 9 and have Stimulus 
Presentation Tool version 1, 2, 3 or 4, there is no need to uninstall the previous 
version. However, version 1 works only with FaceReader 6, version 2 only with 
FaceReader 7, version 3 only with FaceReader 8 and version 4 only with FaceReader 
9. 

Computer configurations

One computer

In this configuration, the test participant uses a computer (for example the Noldus 
Portable Observation Lab) where both FaceReader and the Stimulus Presentation 
Tool are installed. 

Two computers

In this configuration, the computer of the test participant has the Stimulus 
Presentation Tool installed and running. On the test leader computer, FaceReader is 
installed and running. The two computers are connected through a network.
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To allow proper communication between the FaceReader PC and the test 
participant’s PC, follow the procedure in Computer settings for a two computer 
setup with Stimulus Presentation Tool first. 
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Carry out a test with the Stimulus 
Presentation Tool
Aim

To carry out a test with the Stimulus Presentation Tool so that the Stimuli are shown 
to the test participants and the test participant’s face is analyzed.

Prerequisites

 Your FaceReader license includes the Project Analysis Module

 You installed the Stimulus Presentation Tool. 

See To install the Stimulus Presentation Tool

 You have defined one or more Stimuli.

See Define Stimuli

 You have opened the FaceReader project that contains those Stimuli.

 Optionally, the Advanced Research Module if you want to track the test 
participant’s gaze.

Procedure

Carry out the following steps:

1. Define a test

2. Specify connection settings for the Stimulus Presentation tool

3. Run a test
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Define a test
Aim

To define the Stimuli to show to the test participants and the order they should be 
presented.

Prerequisites

 Your FaceReader license includes the Project Analysis Module.

 You have defined one or more Stimuli.

See Define Stimuli

 You have opened the FaceReader project that contains those Stimuli.

Procedure

1. In FaceReader, choose Project > Tests > Add Test, or on the bottom-left 
pane, click the Test tab and click the Add Test button.

2. Give a Name to the test (default: Test 1, Test 2,...).
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3. Select the Default camera you want to use. In the Select Camera window, 
choose the options that apply and click OK.

4. Add Stimuli.

From the Select Stimuli list, select the first Stimulus video you want to add, 
and click the Add button. Repeat this step for the next Stimulus.

5. The Stimuli appear under Stimuli Order.

6. Specify the independent variables for the test.

Under Independent Variable Usage, click an independent variable and 
choose how you want to determine the value for a participant.
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- Automatic (only for Gender and Age) — FaceReader enters the values 
automatically for each participant, based on the analysis.

- Entered by Participant — The participant is asked to enter the value of 
this variable at the start of the test.

Instead of asking a participant to fill in a value for an independent variable, 
you can ask him/her any type of question. When defining the independent 
variable/question you must define either a Numerical or Nominal value/
answers. In a consumer test you can ask, for instance, what the participant 
had for breakfast and define the following Nominal answers: cereal, bread, 
pancakes, hot meal and coffee only.

A variable/question can have a maximum number of 50 characters. 

- Leave blank — To leave the value blank and edit it later.

- [value or category] — Specify one of the values available; note that the 
value you specify here will be assigned to all analyses and participants who 
take part in that test. Use this option for example to compare data between 
tests which differ by that variable.

7. Under Options, choose the additional options that apply:

- Stimulus display size - Default value is 60%. Change the value to 100% to 
display the stimulus full-screen.

- Minimum pause between stimuli - Define the length of the pause 
between stimuli (in hours:minutes:seconds.milliseconds). The default value 
is 3 seconds. Please note that the pause can be longer than the value you 
set if FaceReader needs more time to load the stimulus.

- Randomize stimulus order to present the Stimuli in a random order.

- Perform gaze calibration — This enables FaceReader to track the gaze of 
the test participant.

- Let Participants enter their name at the start of the test.

8. Click OK.

Notes

 Video formats accepted by FaceReader: QuickTime (mov), MP4, VOB (from 
camcorders), H.264 DivX, MPEG-4 DivX, MPEG-1, MPEG-2, DV-AVI.

 Once the Stimuli are listed under Stimuli Order, you cannot change their 
order. To put them in a specific order, delete the Stimuli and re-add them in 
that order.
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 To add Stimuli that are not in the list, close the Add New Test window, then 
add the Stimuli you need (see Define Stimuli), then on the bottom-left pane 
click the Test tab and double-click the test to the re-open the test window, 
and complete step 4.

 To add independent variables, close the Add New Test window, then add 
the independent variables (see Define Independent Variables). Next, on the 
bottom-left pane click the Test tab and double-click the test to the re-open 
the test window, and complete step 6.

 To delete a Stimulus from the test, under Stimuli Order click the Delete 
button for that Stimulus. 

 To edit an existing test, double-click the test name on the bottom-left pane 
(Test tab).

 To delete a test, on the bottom-left pane (Test tab) right-click the test name 
and select Delete Test.
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Specify connection settings for the 
Stimulus Presentation tool
Aim

To specify the connection settings in FaceReader so that it can communicate with 
the Stimulus Presentation Tool. 

Prerequisites

 Your FaceReader license includes the Project Analysis Module.

 You installed the Stimulus Presentation Tool.

See To install the Stimulus Presentation Tool

 If you run a test in a two-PC configuration, the two computers are 
connected, and the appropriate settings were made.

See Computer settings for a two computer setup with Stimulus 
Presentation Tool

Procedure 

1. In FaceReader, choose File > Settings > Data Export.

2. Under External Communication (API and Stimulus Presentation Tool), 
select Enable External Control.
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Note

Make sure the External Connection Port number is the same as that in the 
Stimulus Presentation Tool. By default, this is 9090. If you prefer, you can enter 
another port number. Enter this number also in the Stimulus Presentation Tool.

See Specify the connection settings in the Stimulus Presentation Tool so that it can 
communicate with FaceReader
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Run a test
Aim

To display the Stimuli to the test participants and to carry out the analysis. 

Prerequisites

 Your FaceReader license includes the Project Analysis Module.

 You installed the Stimulus Presentation Tool.

See To install the Stimulus Presentation Tool

 You have defined at least one test in your FaceReader project.

See Define a test

 If you run a test in a two-PC configuration, the two computers are 
connected, and the appropriate settings were made.

See Computer settings for a two computer setup with Stimulus 
Presentation Tool

 Optionally, the Advanced Research Module to track the test participant’s 
gaze.

Procedure 

1. On the test leader’s PC, open the FaceReader project. 

2. On the participant PC, start Stimulus Presentation Tool. 

3. Specify the connection settings in the Stimulus Presentation Tool so that it 
can communicate with FaceReader

In the Connect to FaceReader window, under FaceReader IP/Host enter 
the IP address of the computer with FaceReader. In a One computer setup, 
leave the default address 127.0.0.1. This is identified as the same PC.

Under FaceReader Port leave 9090 or enter the number entered in 
FaceReader in step 1.

When necessary, change the Temporary storage path of the participant PC 
where data are stored during the test.
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When ready, click Connect.

4. In the Select Test window, choose a test from the Available Tests list, then 
click Start.

If the test you require is not listed, in FaceReader open the project that 
contains that test. Next, in the Stimulus Presentation Tool click the Refresh 
button.
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5. Let the participant sit in front of the computer.

6. In the Welcome window, let the participant enter 

- His/her name (optional; see step 7 in Define a test).

- The values of the independent variables (optional, see step 6 in Define a 
test). 

7. When ready, ask the participant to click Start.

The Start button is available when the participant has entered the values of 
all required independent variables.

8. If you selected Perform gaze calibration when you defined the test, a 
message appears informing the participant that calibration will start when 
they click. The participant should look at the dots that appear on the screen 
and hover over them with their mouse.

9. After a couple of seconds the first Stimulus is displayed.

10. At the end of the test a message Thanks for Participating appears. The 
participant and analysis are added automatically in FaceReader.
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Notes

Before the test

 To go from Select Test to Connect to FaceReader, click the arrow at the 
bottom-left corner of the Stimulus Presentation Tool window.

 To go from the Welcome window back to Select Test, click anywhere on 
the window, then press Alt+Home, then click Connect.

During the test

 During the test, FaceReader shows the message Test in Progress. To 
change the views in FaceReader, click OK and select the windows you 
require. Do not change settings.

 Analysis is done automatically during the test. Do not click the Start/Stop 
analysis button during the test.

 Between presentation of two Stimuli, a message “Get ready” is shown for a 
number of seconds. 

 After the test participant has clicked Start in the Welcome window (step 7), 
and before the first Stimulus is presented, a new FaceReader analysis is 
created and started in the background on the FaceReader PC. 

 When a stimulus starts, the Stimulus Presentation Tool sends the 
information to FaceReader, which scores the start of the Stimulus.

 To switch the Stimulus Presentation Tool window to full screen, press F11. 
Press F11 again to resume the original window size.

 To stop the test before the end of the last Stimulus, in FaceReader click the 
Stop analysis button or in the Stimulus Presentation Tool click anywhere on 
the window, then press Alt+Home. The analysis and participant are marked 
with an error icon.

After the test

 To start the test for the next participant, click the arrow at the bottom-right 
corner of the Stimulus Presentation Tool window.
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 To choose another test, click anywhere on the Stimulus Presentation Tool 
window, then press Alt+Home, then click Connect.

 To close the Stimulus Presentation Tool, click the Close button.

 You can view the stimuli in the Stimulus View window, next to the face of 
the participant and, for instance, the Expression Intensity chart with his/
her facial expressions. If you selected Perform gaze calibration when you 
defined the test and selected Gaze tracking in the Settings, you can also 
see the gaze tracking data.

General

 You can connect FaceReader with one Stimulus Presentation Tool at a time.

 When the Stimulus Presentation Tool is connected to FaceReader, this is 
displayed in the upper-right corner of the FaceReader window.
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Computer settings for a two computer 
setup with Stimulus Presentation Tool
Aim

To allow communication between the computers through Windows FireWall and to 
synchronize the computers in order to synchronize the Stimuli and analysis. 

Prerequisite

You use the Stimulus Presentation Tool on another computer than the one with 
FaceReader.

Procedure

You must carry out the following steps:

 Create exceptions in Windows Firewall for Stimulus Presentation Tool

 Synchronize computers with a network time protocol
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Create exceptions in Windows Firewall for 
Stimulus Presentation Tool
Aim

To allow traffic in Windows FireWall for port 9090, or the port you choose if 9090 is 
not available.

See Computer configurations

Prerequisite

You use the Stimulus Presentation Tool on another computer than the one with 
FaceReader.

Procedure

1. In the Windows’ Search field, type firewall, and under the results click 
Windows Firewall. 

2. Turn on the firewall for all networks, then click OK.

3. Click Advanced Settings.

4. On the left panel of the Windows Firewall and Advanced Security 
window, click Inbound Rules and on the right panel under Actions choose 
New Rule.

5. In the New Inbound Rule Wizard, on the Rule Type page, choose Port, 
then click Next>.

6. Select Specific local ports and enter 9090 (or the port chosen, if different), 
then click Next>.

7. On the Action page select Allow the connection, then click Next>.

8. On the Profile page choose the network the rule applies to, then click 
Next>.

9. On the Name page, enter a Name (for example Port9090). Then click 
Finish.
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10. On the left panel of the Windows Firewall and Advanced Security 
window, click Outbound Rules and on the right panel under Actions 
choose New Rule. Repeat the procedure to complete the Outbound Rule. 
Make sure you choose the same options as for the Inbound Rule.

11. Repeat all steps above for the other PC.
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Synchronize computers with a network 
time protocol
Aim

To synchronize face analysis with stimulus presentation. The clocks of the test 
participant PC and the FaceReader PC must be exactly the same. We recommend to 
set the two clocks to the same time using a Network Time Protocol (NTP) server. 
Noldus has tested the Stimulus Presentation Tool with NetTime version 3.14.

Prerequisite

You use the Stimulus Presentation Tool on another computer than the one with 
FaceReader.

Procedure

The following steps are needed on both PCs:

1. Install NetTime

2. Adjust the NetTime Settings

3. Create exceptions for NetTime in Windows Firewall

4. Before the start of a test with Stimulus Presentation Tool, synchronize the 
two PCs. You can also choose to do this automatically at regular intervals 
(minimum 15 minutes).

See Synchronize the test PC to the FaceReader PC

Install NetTime

Do the following on both FaceReader and test PCs:

1. Browse to http://www.timesynctool.com, and download the latest version 
of NetTimeSetup.exe.

2. Run the installation file. During installation, select Install as Service 
(Recommended).

Adjust the NetTime Settings

1. Click the arrow in the lower-right corner of your screen to open the system 
tray. 
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2. Click the Network Time Synchronization icon.

3. Click Settings. 

4. Under Hostname or IP Address:
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- For the FaceReader PC — Leave the Time Servers names as shown in the 
next table.

- For the test PC — In the first Time Servers field, enter the name of the 
FaceReader PC, and delete all other external Time Servers. See the following 
table.

To find the name of a PC, right-click My Computer and choose Properties.

FaceReader PC Test PC

Time Servers 0.nettime.pool.ntp.org [FaceReader PC’s name]

1.nettime.pool.ntp.org [empty]

2.nettime.pool.ntp.org [empty]

3.nettime.pool.ntp.org [empty]

Update Interval 15 minutes 60 seconds
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5. Choose SNTP as Protocol and 123 as Port.

6. Next to Update Interval enter (see also the table above):

- For the FaceReader PC — 15 minutes.

- For the test PC — 60 seconds.

7. For the FaceReader PC only — Select Allow other computers to sync to 
this computer.

8. For both PCs —

- Select Show NetTime icon in the system tray at login and Start 
NetTime service at bootup.

- De-select Demote Servers after [ ] failures.

- Next to If time adjustment greater than, select 10 milliseconds, then 
Adjust System Time.

9. Click OK. When a warning appears about Update Intervals being lower than 
10 minutes (on the test PC), click No.

Create exceptions for NetTime in Windows Firewall

To prevent that syncing fails because of the Firewall, create exceptions on both PCs 
as follows.

1. In the Windows’ Search field, type firewall, and under the results click 
Windows Defender Firewall.

2. Turn on the firewall for all networks, then click OK.

3. Click Advanced Settings.

4. Inbound Rule

- On the left panel of the Windows Defender Firewall and Advanced 
Security window, click Inbound Rules and on the right panel under 
Actions choose New Rule.

- In the New Inbound Rule Wizard, on the Rule Type page, choose 
Program, then click Next>.

- On the Program page, select This Program path, click Browse and select 
the file

C:\ProgramFiles (x86)\NetTime\NetTimeService.exe. 

- Then click Open and Next>.

- On the Action page select Allow the connection, then click Next>.
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- On the Profile page select all options Domain, Private, and Public. Then 
click Next>.

- On the Name page, enter a Name (for example NetTime Service). Then 
click Finish.

5. Outbound Rule

-On the left panel of the Windows Defender Firewall and Advanced 
Security window, click Outbound Rules and on the right panel under 
Actions choose New Rule.

-Repeat the step 4 above to complete the Outbound Rule. Make sure you 
choose the same options as for the Inbound Rule.

6. Repeat all steps above for the other PC.

Note

If you followed all procedures for establishing Firewall exceptions (Create 
exceptions in Windows Firewall for Stimulus Presentation Tool and Create 
exceptions for NetTime in Windows Firewall), each computer should have two 
Inbound Rules and two Outbound Rules:

 One for the port (for communication between FaceReader and Stimulus 
Presentation Tool)

 One for NetTime Service.

Synchronize the test PC to the FaceReader PC

1. Always start the test PC after starting the FaceReader PC. This ensures that 
the test PC always finds its time server. 

2. On the test PC, click the arrow in the lower-right corner of your screen to 
open the system tray. 
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3. Click the Network Time Synchronization icon.

4. Make sure that the first item under Server Name is the name of the 
FaceReader PC. If this is not the case, click Settings and enter the 
FaceReader PC’s name for the first time server.

See Adjust the NetTime Settings

5. Click the Update Now button. 

The Offset and Lag are updated. Please note that you may get an error if the test 
PC is in another network.
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Offset is the estimated difference in time between the clocks that 
cumulated up to the time of the update. This is the accuracy of 
synchronization of the Stimulus Presentation Tool with FaceReader. A 
positive value means that the FaceReader PC clock is faster than the test PC.

Lag (also known as delay) is the traveling time of time packets from the 
client to the server and from the server back to the client. The shorter this 
lag, the more accurate the estimate of the offset between clocks.

6. You are now ready to start the test with the Stimulus Presentation Tool.

See Run a test

Notes

 After clicking Update Now, always make sure that on the Network Time 
window the Status cell for the FaceReader PC says Good. 

 To change the order of the servers in the NetTime Options window, copy 
and paste the name of one cell to the other.

 Click Update Now every time you start a test to keep the time offset 
between FaceReader and Stimulus Presentation Tool as low as possible.

 For more information:

https://en.wikipedia.org/wiki/Network_Time_Protocol

http://www.timesynctool.com
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Event markers
Event markers are used to indicate that, for instance, the participant was distracted 
or was trying food product A. With Event markers, you can mark the parts of the 
analyses you are especially interested in and that were not defined as Stimuli 
beforehand. In contrast to Stimuli, Event markers have no fixed duration. In 
FaceReader you can compare the analyses over these time periods with other data.

Main topics

 Define Event markers

 Score Event markers
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Define Event markers
Aim

To specify the markers and their associated key codes. 

Prerequisite

Your FaceReader license includes the Project Analysis Module.

Procedure

1. Choose Project > Event Marker and then Add Event Marker. 

2. In the Name field, enter the Event marker name, for instance, Food product 
A.

3. Click the button on the right of the Trigger Key field and enter the key for 
this marker. This is the key on your keyboard that you press when the event 
(In this example Test participant takes food product A) starts.

4. Select a color for the marker and click OK. This color will be used 
throughout the program for the Event marker.

Notes

To delete or edit an Event marker:

1. Open the Event Markers tab at the bottom of the Project Explorer. 
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2. Right-click the Event marker you want to delete or edit and select the 
option you require.
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Score Event markers
Aim

To mark episodes other than the time Stimuli were presented. 

Prerequisites

 Your FaceReader license includes the Project Analysis Module.

 You have a video or camera analysis.

 You defined Event markers. 

Procedure

To score during an analysis

1. Press the trigger key that is associated with your Event marker. If you have 
the Timeline window open, a bar appears in the line Event markers. 

2. Press the same trigger key to stop the Event, or press another key to start 
another event. 

To score after an analysis

1. Open the Timeline Window and scroll the video to the position where the 
event starts. 

2. Press the Event marker trigger key. A question appears whether you want to 
score the Event marker at that point. Choose Yes. 

3. Scroll the video to the position where the Event marker should stop

4. Press the same trigger key to stop the event, or press another key to stop 
the event and start another event. 

Notes

 Scored Event markers appear as dots below the analysis in the project 
explorer. 
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 To edit a scored Event marker, unfold the analysis and double-click Scored 
Event markers. In the window that opens, edit the markers by dragging 
them to the correct position. 

 To copy a scored Event marker to other participants or analyses, unfold the 
analysis and double-click Scored Event Markers (see picture above). Click 
the Event marker you want to copy. Click Scored Event Markers at the top 
of the window, and choose one of the options under Copy To.
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Independent variables
Independent variables are factors that can vary but are constant per participant and 
can, potentially, affect the analysis results. Examples are the nationality of the 
participant, or the previous experience with a product or commercial. Independent 
Variables can be used to compare participant groups, for example to compare 
groups of males and females, or to make groups with and without previous 
experience with the product.

By default, each project contains the independent variables Age and Gender of the 
participant. These cannot be deleted. Their values can be estimated by FaceReader, 
from the analyzed images. Alternatively, you can enter the values manually. 

Independent Variables must be scored for each participant. Participants for which 
one or more Independent Variables have not been scored are left out of the 
analysis. 

Main topics

 Define Independent Variables

 Score Independent Variables 
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Define Independent Variables
Aim

To define factors that can vary but are constant per participant and can, potentially, 
affect the analysis results. 

Prerequisite

Your FaceReader license includes the Project Analysis Module. 

Define independent variables

1. Choose Project > Independent Variables > Add Independent Variable. 

2. Give a name to the variable, for example Experience level.

3. Choose one of the following:

Numerical – Numerical variable values can have decimals and can also be 
negative.

Nominal – Enter the independent variables categories in the Categories 
field. Click the Plus button to add the category. Define at least two 
categories for each independent variable. 
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Notes

 To delete or edit an independent variable, open the Independent Variables 
tab at the bottom of the Project Explorer. 

Right-click the independent variable you want to delete or edit and select 
the option you require. 
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Score Independent Variables
Aim

To enter a value for each Independent Variable.

Prerequisites

 Your FaceReader license includes the Project Analysis Module. 

 You defined independent variables.

Procedure

1. Expand the Participant item in the Project Explorer.

2. Double-click Independent Variables. 

3. Click the pencil button next to the Independent Variable.

4. Select the category. In the example below, this would mean defining the 
native language of each participant.
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Note

The Independent Variables item in the Project Explorer displays a warning icon if the 
values have not been scored yet for a participant. Open the participant item and 
double-click Independent Variables. Then fill in the values. 
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Project analysis in short
Aim

 Visualize or tabulate the data that you have acquired and calculate the 
average intensities of the facial expressions and other parameters for your 
participant groups.

 Compare participant groups and run a t-test to test for significant 
differences.

 Play back your stimulus video together with a video of the participant’s face 
and a Line Chart with the facial expressions and other parameters.

 Create heatmaps on your stimuli showing the hotspots that attracted your 
test participants’ attention. 

 Calculate correlations between data sets and visualize data sets side by side 
or in a correlation graph.

Prerequisites

 Your license includes the Project Analysis Module.

 Your project includes one or more video analyses or camera analyses.

Procedure

1. Open the Project Analysis: from the Project menu select Open Project 
Analysis or click the Open project analysis icon above the Participants 
list.
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Default FaceReader shows a Line Chart with the average intensities of the 
facial expressions of all your test participants. See Line Chart for more 
information about this type of chart. FaceReader also shows the face video 
of your first test participant. If your project contains stimuli FaceReader will 
show the first stimulus video/image.

If your stimulus is a video — Play the stimulus video and the face video 
together with the Line Chart. See Visualize your stimulus, participant videos 
and line chart for more details.

2. Click one of the tiles for the option of your choice:

 Quick Layouts — This option allows you to pick from a couple of charts to 
give you a first impression of the data. See Quick Layouts for more 
information.

 Pie chart, Bar chart, Box plot, Line chart or Circumplex model — Select 
one of the options to visualize your data. Circumplex Model is only 
available if you scored stimuli or event markers in your project. See 
Visualize your data in a chart for more information.

 Heatmap — To create a heatmap on one of the stimuli.

 Table — To calculate statistics on the analyzed facial expressions and other 
parameters of all participants, participant groups or single participants. See 
Calculate statistics and summarize them in a table for more information.

 Stimulus — To add your stimulus videos to the visualization. You can play 
back your stimulus videos together (synchronized) with a Line chart with 
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the facial expressions and other parameters. See Visualize your stimulus, 
participant videos and line chart for more information.

 Participant — To add your participant face video to the visualization. You 
can play back your participant videos together (synchronized) with the 
stimulus video and a Line chart with the facial expressions and other 
parameters. See Visualize your stimulus, participant videos and line chart 
for more information.

 Compare — To compare two or more data sets in a chart or table and carry 
out a t-test to test for significant differences. See Compare data for more 
information.

3. Select the data you want to include in your analysis. See Data selection for 
more information. Your chart/table will appear.

Click Save Layout to save the chart/tables you made so you can use them again. 
Enter a Layout name and click OK.

Click Load Layout to open the charts/tables/videos that you saved in your layout.

Click Clear Layout to delete all the charts/tables/videos.
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Data selection 
Aim

 Select what parameters to analyze

 Select what stimuli/event markers to analyze

 Select absolute or relative values for your parameters

 Select how to aggregate data over time and over test participants

 Select participants

Prerequisites

 Your license includes the Project Analysis Module.

 Your project contains video or camera analyses.

Procedure

1. Open the Project Analysis section (see Project analysis in short).

2. Select the chart or table of your choice. The Data selection window opens.
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Select what parameters to analyze

The first section lists the parameters that will be included in your chart or table. 
Click select to see all the variables that are available and make a selection. The 
parameters in gray are the ones that are selected. 

Notes

 It is not possible to select Valence or Arousal when you make a Pie Chart.

 You cannot select any parameters when you make a Circumplex Model 
because this chart always shows a combination of Valence and Arousal.
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Select what stimuli/event markers to analyze

The Stimulus or Event Marker section lists the stimuli and event markers that were 
scored in the project. Click a stimulus or event marker to select it and to visualize/
tabulate the data during this stimulus/event marker. If you do not make a selection 
the whole observation period is taken into account.
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Advanced options for data analysis
Aim

 To select whether you want to visualize/tabulate absolute or relative values 
of your parameters

 To select how to aggregate data over time.

 To select how to aggregate data over test participants.

Prerequisites

 Your license includes the Project Analysis Module.

 Your project contains video or camera analyses.

Procedure

1. Open the Project Analysis section (see Project analysis in short).

2. Select the chart or table of your choice. The Data selection window opens.

3. Click select next to Advanced Options to open the Advanced Options 
window and click the options you want to use:

Select absolute or relative values for your parameters

Select one of the options under Baseline Correction to visualize/tabulate either the 
absolute values or relative values of your parameters.

Baseline Correction is not available when you make a Pie Chart. You can only 
visualize absolute values as relative values can be negative.

 None (default) — With this option selected the absolute intensities of the 
selected data will be visualized/tabulated.
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The bar chart in the example below shows the mean absolute intensities of 
the facial expressions that the test participants showed during Commercial 
1. 

 All Other Measurements — To visualize/tabulate the selected data during 
a stimulus relative to all other time fragments. Use this option to calculate 
in which way the facial expressions, for example, during watching a certain 
commercial differ from the expressions while the participants were not 
watching it. 

The bar chart in the example below shows the mean intensities of the facial 
expressions of the test participants during Commercial 1 relative to the 
facial expressions that they showed during the rest of the test. The chart 
shows that the test participants were happier during Commercial 1 than 
during the rest of the test.
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 Other Stimuli Or Event Markers — The selected data during a stimulus/
event marker relative to the expression intensities during another stimulus/
event marker. When you select this option, choose what stimuli or event 
markers to use as the baseline. With this option you can for example correct 
the facial expressions of test participants when they watched a certain 
commercial for the expressions while watching a neutral scene. 
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The bar chart in the example below shows the mean intensities of the test 
participants during Commercial 1 relative to the facial expressions that they 
showed during a Neutral stimulus. The charts shows that the test 
participants were happier during Commercial 1 than during the Neutral 
stimulus.

 Interval before stimulus/event marker — The selected data during a 
Stimulus relative to the expressions just before the stimulus or event. With 
this option you can measure the effect of a stimulus on the participant’s 
mood, by looking at the changes induced by the stimulus. Enter the 
duration of the interval before the stimulus or event marker in the Interval 
field. 
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The bar chart in the example below shows the mean intensities of the facial 
expressions of the test participants during Commercial 1 relative to the facial 
expressions that they showed during the 5-second interval before Commercial 1. 
The chart shows that the test participants were happier during Commercial 1 than 
during the 5-second interval before Commercial 1.

Select how to aggregate data over time and over test 
participants

Select one of the options under Temporal Aggregation to select how the values 
per test participant are aggregated over time. If you choose Activation Period 
FaceReader counts the percentage of frames which have an activation higher than 
the threshold. The default threshold is 0.2. That means that the value for ‘Happy’ is, 
for instance, 60% if the intensity of ‘Happy’ is 0.2 or higher in 60% of the frames.

Notes:

 Temporal aggregation is not available when you make a Circumplex Model 
or Line Chart because these chart types are based on temporal data.

 You can select multiple temporal aggregation methods when you make a 
table.
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Select one of the options under Participant Aggregation to select how the values 
of the different participants are aggregated. 

Note:

Participant Aggregation is not available when you make a Box Plot because a Box 
Plot by definition shows a number of participant aggregation values (Q1, Q2, Q3). 
See Box Plot for more information.

How baseline correction and aggregation is performed

Suppose you have three participants with one analysis each and you scored the 
same Stimulus for all three participants. You selected All Other Measurements as 
Baseline Correction in the Advanced Options and Mean for both Temporal 
Aggregation and Participant Aggregation. As an example, calculation of the 
relative mean value of Happy during the Stimulus is done in the following way:

Participant 1 (P1) — (mean intensity Happy P1 within Stimulus interval) - (mean 
intensity Happy P1 outside Stimulus interval) = A

Participant 2 (P2) — (mean intensity Happy P2 within Stimulus interval) - (mean 
intensity Happy P2 outside Stimulus interval) = B

Participant 3 (P3)— (mean intensity Happy P3 within Stimulus interval) - (mean 
intensity Happy P2 outside Stimulus interval) = C

Relative Mean value of Happy = (A + B + C)/ 3
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Select participants
Aim

To select which participants to include in your analysis. You can make a selection 
based on name, analysis number or the values of one or more independent 
variables.

Prerequisites

 Your project includes the Project Analysis Module.

 Your project contains video or camera analyses.

Procedure

1. Open the Project Analysis section.

2. Select what chart/table you want to create.

3. Under Filter your participants click Adjust Filter to make a selection 
based on:

 Participant — Select the participants that you want to include in your 
analysis.

 Analysis — Select the analyses that you want to include in your charts/
table. For instance, select ‘Analysis 2’ if these are the analyses of test day 2 
on which the respondents tested ‘Ice cream 2’.
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 Participant - Analysis — Select the participant/analysis combinations that 
you want to include in your charts/table. For instance, select the first three 
analyses of test participant 1-10 if these are the analyses of test day 1, 2 and 
3 on which these participants tested razor blade X.

 Age, Gender and other independent variables — Age and gender are the 
independent variables that can be estimated by FaceReader, from the 
analyzed images. You can, for instance, first select all male respondents and 
make a bar chart of their facial expressions during Stimulus 1 and then 
select all female subjects and make a similar chart. You can also make a 
selection based on the independent variables that you defined yourself like 
socioeconomic status of the test participants or whether the participant had 
previous experience with the product under investigation. 



238

4. Click Update to add the filter to your selection. In the lower left corner of 
the filter window the number of participants that match your filter are 
shown.

Add condition

For numerical variables like age or number of years of experience with the product, 
you can add a condition and select, for instance, all the test participants older than 
40.

5. Click Add to add the condition to the list of values to choose from.
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6. Click Update to add the filter to your selection.

Remove a filter

To remove a filter from your selection, click the button next to it.

Change your selection

Click Adjust Filter to open the window to filter your participants.

The blue dots indicate what independent variables have been used to make a 
selection. Change your selection and click Update to add the new filter to your 
selection.
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Save your selection

To save your selection criteria, click Save Filter and enter a name for your filter.

Load an existing filter

To open a filter that you have saved previously.
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Quick Layouts
Aim

Visualize your data in a number of charts to get a quick first impression of your 
results.

Prerequisites

 Your FaceReader license includes the Project Analysis Module.

 Your project includes one or more video or camera analyses.

Procedure

1. Open the Project Analysis section and click Quick Layouts.

2. Select the data you want to include in your analysis. See Data selection for 
more information. 

3. Select which Quick Layout you prefer. Click OK when you are ready. 

- Stimulus, participant video and Line Chart, see Visualize your stimulus, 
participant videos and line chart.

- Stimulus, Line Chart, Bar chart, Circumplex Model and Pie chart.
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- Stimulus and Line Chart.

- Pie chart, Box Plot and Table. See also Calculate statistics and summarize 
them in a table.

By default FaceReader shows a Line chart and the face video of the first 
participant. If you selected a stimulus, FaceReader will also show the (first) 
stimulus video/image.

If your stimulus is a video — Play the stimulus video together with the Line 
Chart. See Visualize your stimulus, participant videos and line chart for 
more details.
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Visualize your data in a chart
Aim

To visualize your data in a Pie Chart, Box Plot, Bar Chart, Circumplex Model or Line 
Chart.

Prerequisites

 Your FaceReader license includes the Project Analysis Module.

 Your project includes one or more video or camera analyses.

Procedure

1. Open the Project Analysis section and click either Pie chart, Box Plot, Bar 
Chart, Circumplex Model or Line Chart.

2. Select the data you want to include in your analysis. See Data selection for 
more information. Click OK when you are ready. FaceReader will show the 
chart.
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Click on the colored circles below the chart to exclude or re-include the 
corresponding data from/into the chart.

Each chart has a toolbar with the following information/icons:

 Edit selection — Click this button to open the Data selection window and 
change your selection. Click OK when you are ready.

 Adjust caption — Click this button to change or reset the chart’s caption.

 Display data — Click this button to view a table containing the data on 
which the chart is based, per participant and aggregated over participants. 
The table also shows the number of frames in the participant video or 
camera stream that was taken into account. If the chart is a Line chart or 
Circumplex Model the table shows the data per sample point aggregated 
over participants.

The table in the example below comes from the ‘FaceReader sample project 
- Two stimuli’ and shows the mean intensities of the facial expressions 
Neutral and Happy per test participant and (in the last row) the mean 
intensities over test participants during the time that the test participants 
watched the ‘Twins eating’ stimulus.

Click the Save button to save the table, either in *.txt format or in *.xlsx 
format.



245

 Save data — To save the data, either in *.txt format or in *.xlsx format. This 
results in the same output as when you click the Save button under Display 
data.

 Copy as image — To copy the chart to the clipboard.

 Save as image — To save the chart in one of the following formats: *.png, 
*.jpg, *.bmp, *.gif or *.tif.

 Increase/Decrease Size — To increase or decrease the chart’s width.

 Close — To close the chart.

Use the four-arrow cursor to move your chart to another position in the layout.
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Pie chart

A Pie Chart shows for each parameter that you selected the proportion of the 
analysis time it was the dominant one (for facial expressions) or it was active (for 
Action Units) aggregated over the participants that you selected. In the above Pie 
Chart ‘Happy’ was the dominant facial expression for 41% of the analyzed time and 
‘Neutral’ for 37% of the time. When you move over the chart with your mouse 
pointer you can also see the percentages for the other facial expressions. For 
instance, ‘Sad’ was the dominant facial expression for 0.158 (= 15.8%) of the 
analyzed time.
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Box Plot

A Box Plot shows the minimum value (the lowest data point of the error bar), Q1 
(first quartile) and Q3 (third quartile) (the borders of the box) and the median (Q2) 
for each parameter that you selected. When you move over the plot with your 
mouse pointer, you can see the values for Q1, Q2 and Q3.
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Notes

 A quartile is the percentage of participants that shows this or a lower 
expression intensity. So if the first quartile (Q1, or 25th quartile) of the facial 
expression Happy is 0.3, this means that 25 percent of the participants has 
an intensity of Happy of maximally 0.3. 

 The individual participants represent the samples. Hence, if you have five 
participants with three analyses each, the box plots are based on five 
samples. 

 The quartiles are calculated with N + 1 Basis interpolation, which is also 
used in the statistical program SPSS. If the sample size is lower than 3, the 
first quartile (25th quartile) is the same as the minimum and the third 
quartile (75th quartile) is the same as the maximum value, which is also the 
same as in SPSS. 



249

Bar chart

A Bar Chart shows the values of the parameters you selected, aggregated over your 
selected participants and aggregated over time. When you move over the chart 
with your mouse pointer you can see the value for each parameter.
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Circumplex Model
A Circumplex Model describes emotions in the form of a heatmap in a two-
dimensional circular space, containing arousal on the vertical axis and valence on 
the horizontal axis. The center of the circle represents a neutral valence and a 
medium level of arousal. The Circumplex Model is based on the data of the 
participants that you selected. 

The Circumplex Model is only available if you scored stimuli or event markers in 
your project. 

The chart below shows the Circumplex Model for the five test participants in the 
‘FaceReader sample project - Two stimuli’. The data that are taken into account are 
those of the time period when the test participants were watching the ‘Twins eating’ 
stimulus. You can visualize another Circumplex Model, select the ‘Frying insects’ 
stimulus and compare the two plots.

The color of the heatmap is based on the percentage of time the affect that was 
most present occurred. This percentage of time (37% in the plot below) is set as the 
maximum and is colored red.

The Circumplex Model in FaceReader is based on the model described by Russel 
(1980).
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Line Chart
A Line chart shows the values of your parameters over time, aggregated over the 
test participants you selected. The Line Chart below shows the custom expressions 
of the five test participants in the ‘FaceReader sample project - Two stimuli’. The 
data that are taken into account are those of the time period when the test 
participants were watching the ‘Twins eating’ stimulus. 

You can visualize a Line Chart together with the stimulus/event marker and one or 
more participant videos. If the stimulus is a video, you can play it back and a hairline 
in the Line Chart shows the position in the video.

Please note that a warning will appear if you select analyses of different length. This 
may happen in a project in which no stimuli were presented to the test participants. 
The Line chart will show data up to the duration of the shortest analysis.

 

A Line Chart has a number of two icons in the toolbar:
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 Zoom out and Zoom in — To zoom out and in on the timeline.

And the Y axis icon to access:

 Auto range — To display a scale with a minimum and maximum value that 
fit your data.

 Full range — To display a scale with a minimum of -1.00 and a maximum of 
+1.00. Use this scale to compare multiple charts, for instance, one chart for 
your female subjects and one for your male subjects.

 MIN and MAX — To set the minimum and maximum Y-value. 
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Heatmap
A heatmap shows the hotspots of the test participant’s gaze overlay on a stimulus, 
indicating where the test participant looked the longest. On the time axis you can 
define an interval for which you want to see the heatmap. 
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Calculate statistics and summarize 
them in a table
Aim

To calculate statistics on the analyzed facial expressions and other parameters of all 
participants, participant groups or single participants. 

Prerequisites

 Your FaceReader license includes the Project Analysis Module.

 Your project includes one or more video or camera analyses.

Procedure

1. Open the Project Analysis section and click Table.

2. Select the data you want to include in your analysis. See Data selection for 
more information. Click OK when you are ready. FaceReader will show a 
table with the results. 

A table has the same information/icon in the toolbar as a chart. See Visualize your 
data in a chart for more information.
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Visualize your stimulus, participant videos 
and line chart
Aim

To display the stimulus video to play it back together with the recorded video of the 
test participant’s face and a Line Chart with the data.

Prerequisites

 Your license includes the Project Analysis Module.

 Your project contains video or camera analyses and one or more stimuli.

Procedure

1. Open the Project Analysis section and click Stimulus. 

2. Select the stimulus that you want to display and click OK. The stimulus 
video will open.
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Not all videos supported by FaceReader can directly be shown in the Project 
Analysis Module. They might require conversion first:

3. Click Participant and select the appropriate participant and analysis to 
display the corresponding video. Then click OK. The participant video will 
open next to the stimulus video.
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The participant video window contains three icons, one to switch the sound on and 
off, one to display the video full screen and one to move the video from the video 
window and display it as a picture-in-picture.

The participant video displayed above is from the ‘FaceReader sample project - Two 
stimuli’. In this project the test participants watched two stimulus videos, ‘Twins 
Eating’ and ‘Frying insects’.

You can display a Line Chart together with the stimulus video and the participant 
video and play back the videos in sync. A hairline in the Line Chart shows the 
position in the videos.
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Compare data
Aim

To compare two or more data sets in a chart or table and carry out a t-test to test 
for significant differences.

Prerequisites

 Your license includes the Project Analysis Module.

 Your project contains video or camera analyses.

Procedure

Select data

1. Open the Project Analysis section and click Compare.

2. Click Add Data Selection.

3. If your project contains stimuli or events markers — Select a stimulus/event 
marker to compare data sets for this stimulus/event marker only.

4. Click Adjust Filter to choose what participants you want to include in the 
selection. You can base your selection on participant name, analysis name, 
participant/analysis combination, gender or age. Select, for instance, all the 
male subjects in your project. Click Update to add the filter to your 
selection. See Select participants for more information.
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5. Click OK. The Participant Filter is added to the Selection window. You can 
see how many test participants have been selected.

6. Click Add Data Selection to select a second data selection.

7. Click Adjust Filter and select the second set of data. Select, for instance, all 
female subjects in your project. Click Update and then OK.

8. Repeat steps 6 and 7 to add more data sets to the comparison in case you 
have more than two participant groups.
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9. Select whether you want to compare the two data sets in a Bar Chart, 
Table, Correlation Table or Line Chart or visualize Insights.

10. Select the parameters you want to visualize/tabulate. Then click OK. 

11. Select the advanced options of your choice. Then click OK. See Advanced 
options for data analysis for more information.

Tip: You can change the color of the selected data. Click on the colored bar in 
front of the data set and pick the color you like.

Add all participants as a separate selection

Select this option to compare the data of all the participants in your project.

1. Open the Project Analysis section and click Compare.

2. Click Add all participants as a separate selection. A list with all the 
participants in your project will appear as a separate data selection.
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3. Select whether you want to compare the data sets in a Bar Chart, Table, 
Correlation Table or Line Chart or visualize Insights.

4. Select the parameters you want to visualize/tabulate. Then click OK. 

5. Select the advanced options of your choice. Then click OK. See Advanced 
options for data analysis for more information.

Adjust your selection

 Edit selection — Click the pencil icon to change your selection.

 Adjust caption — To give the selected data a more logical or shorter name.
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 Remove data selection 

Compare data in a bar chart

1. Select two or more data sets following the steps in Compare data.

2. Click Bar Chart and select the parameters you want to visualize in your 
chart.

3. Select what Temporal Aggregation method and Participant Aggregation 
method you want to use and click OK. Your Bar Chart appears. 

4. Hover with your mouse over a filter icon to see what data have been 
selected. 

The Bar Chart in the example below shows the mean intensities of the four negative 
facial expressions (Sad, Angry, Scared and Disgusted) for two groups of test 
participants (Male and Female subjects). 
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Compare data in a table and carry out a t-test

1. Select two or more data sets following the steps in Compare data.

2. Click Table and select the parameters you want to include in your test.

3. Set a P-value threshold to carry out a two-tailed t-test. The default value 
for the threshold is 10%. 

4. Select what Temporal Aggregation method you want to use and click OK. 

Your table appears with the mean values and standard deviation for the 
parameters that you have selected in step 2. Each row in the table shows 
the results for one of the data sets that you have selected in step 1.

5. Click one of the rows to test for significant differences. Colored cells 
indicate significant differences. When you move with your mouse pointer 
over a colored cells you can see the exact P-value.
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The table in the example below shows the mean intensities and standard deviations 
of four facial expressions of two groups of test participants, Male (upper row) and 
Female (lower row). The colored cell indicates that the two groups show a 
significant difference in the intensity of Happy.

Note on standard deviations

Each participant is a replicate. So if you have one participant with three analyses, the 
standard deviations will be zero, because the sample size is one. If you have three 
participants with two analyses each, the standard deviations will be based on three 
samples. 

IMPORTANT Please note that the appropriate statistical test depends on your data. 
Your data may not be normally distributed, which means that you need a non 
parametric test instead of a t-test. Also corrections like Bonferroni on the P-values 
may be needed for multiple comparisons. Consult your statistician for advice. 

Compare data in a line chart

1. Select two or more data sets following the steps in Compare data.

2. Click Line Chart and select the parameters you want to include in your test.

3. Select what Comparison Type you prefer: either Side By Side or 
Synchrony.

4. Select what Baseline correction method and what Temporal Aggregation 
method you want to use and click OK. 

Side by side

If you choose the option Side By Side the absolute intensities of the facial 
expressions are plotted over time. Hover with your mouse over a filter icon to see 
what data have been selected. The example in the screenshot below comes from 
the FaceReader 10 - Sample project - Two stimuli. The data of the participants older 
than 40 (n=2) are shown as continuous lines and the data of the participants 
younger than 40 (n=3) as dotted lines. The graph shows that a few seconds after 
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the start of the ‘Frying insects’ stimulus the younger participants had a higher 
valence than the older participants and it remained higher until the end of the 
stimulus. The reason was that the female participants found the stimulus so 
disgusting that they started to laugh.

Synchrony

If you choose Synchrony a correlation chart will be shown with a sliding window of 
10 seconds. The screenshot below again shows the data of the FaceReader 10 - 
Sample Project - Two stimuli during the ‘Frying insects’ stimulus. The graph shows 
the correlation between the valence of the older participants (n=2) and the valence 
of the younger participants (n=3). The correlation varies quite a lot with a peak at 
the start of the stimulus and a smaller peak around 15 seconds after the start of the 
stimulus.

How is the correlation calculated?

FaceReader calculates a Pearson correlation coefficient. Its value ranges from -1 to 
1. 1 indicates a perfect positive linear relationship, -1 indicates a perfect negative 
linear relationship. 0 indicates no linear relationship at all.



266

Compare data in a correlation table

1. Select two or more data sets following the steps in Compare data.

2. Click Correlation Table and select the parameters you want to include in 
your test.

3. Select what Baseline correction method and what Temporal Aggregation 
method you want to use and click OK. 

The Correlation Table appears with for each parameter (facial expression, Valence, 
Arousal, etc.) the correlation between the two data sets. When you hover with your 
mouse over the filter icons you can see what data have been selected.

See How is the correlation calculated? for more details.
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Compare data and visualize insights

1. Select two or more data sets following the steps in Compare data.

2. Select Insights and select the parameters you want to visualize in your 
chart.

3. Set a P-value threshold to carry out a two-tailed t-test. The default value 
for the threshold is 10%. 

4. Select what Temporal Aggregation method you want to use and click OK. 

Bar charts will appear for all the parameters that show significant 
differences. 

5. Move with your mouse pointer over a filter icon to see what data have been 
selected. 
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The bar chart in the example below shows the insight when comparing Male and 
Female test participants during Stimulus 1. A P-value threshold of 10% was used. 
FaceReader shows bar charts for the parameters that are significantly different, in 
this case Surprised. The data selection also included Happy but the two groups did 
not show any significant differences for this facial expression. 
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Settings

Main topics

 Settings in detail

 General settings

 Default Analysis Settings

 Analysis options

 Data Export

 Visualization

 Advanced options
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Settings in detail
These topics list the settings that you can make in FaceReader. Each topic refers to 
one tab in the Settings window. 

See also Choose settings

To access settings for all future analyses

Choose File > Settings. 

Choose the option you require. These settings will be used for all new analyses, 
including the one currently open if that has not been analyzed yet.

For many options, additional information is available as tool tips, as shown in the 
figure below. The settings you specify this way apply to all future analyses.

To reset to Default

Click the Reset to Default button to undo the changes you made in the settings 
and go back to the default settings.

Notes

 Clicking Reset to Default resets all tabs to the default settings, not only the 
tab that is currently open. 

 Clicking Reset to Default will make General the default face model. If you 
are in the middle of a project in which you used another face model, make 
sure that you re-select the face model you used. This way you do not mix 
data obtained with different face models.
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General settings
In the General settings you can view your license info and select the default location 
where FaceReader saves its projects.

License

Your license number

Shows the license number of the hardware key currently plugged in or the license 
number connected to your software activation key. This license determines the 
software modules that you can use. 

See also: 

 Modules in Introduction
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 FaceReader trial version in Installation

Project Explorer

Open analysis on creation

The analysis immediately opens once it is created. Default: selected.

Show participant preview image

If enabled you will see a preview image of each participant by hovering over the 
video icon in the Participant Explorer. Default: selected.

Project Information

Custom expression folder

The default folder where newly-defined and imported custom expressions are 
saved. Click the button next to it to select another location.

Default: C:\Users\<your username>\Documents\Noldus\FaceReader 10 9\Custom 
Expressions.

Default project folder

The default location where the projects are stored. Click the button next to it to 
select another location.

Default: C:\Users\<your username>\Documents\Noldus\FaceReader 10 9\Projects.
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Default Analysis Settings

Active Face Model

Face model

Choose the model that will be used by FaceReader for finding, modeling and 
classifying faces. Note that for a specific analysis you can use another model. If you 
have Baby FaceReader there is only one face model available (‘Baby’). 

See Settings for the current analysis in Analyze facial expressions

You can choose between the following models:

 General (default) — This model has been trained on a very diverse 
selection of images. The model works well under most circumstances for 
most people.

 Baby — Select this model if you work with babies or infants between the 
age of 6 months and 2 years. If you have a regular FaceReader license, the 
baby face model is not available.

 EastAsian — Select this model to analyze East Asian faces, for instance, 
Chinese or Japanese faces.
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Calibration

Continuous calibration

With this option selected, FaceReader continuously calibrates during an analysis. 

See Continuous calibration in Analyze facial expressions

Classification

Smoothen classifications

With this option selected (default), classification values are transformed to obtain a 
smooth output signal. FaceReader smoothens the classification values taking the 
duration between frames into account. When there is a large time gap between 
frames, FaceReader will consider the facial expressions detected in those frames as 
less correlated then when there is a small time gap and thus adapts the strength of 
the smoothing. 

When this option is not selected, FaceReader gives the raw output data.

If you are analyzing a set of images, this option has no effect.

Rotation

Image rotation 

If you have images that are rotated, select one of the options from the drop-down 
list to make sure the faces are upright.

 None (default).

 90º CW (clockwise).

 180º CW.

 270º CW.

Video

Sample rate

This option applies when you perform video analysis. 

By default, Every frame is selected. This means that all video frames are analyzed. 
To speed up the analysis, change the sample rate to analyze Every 2nd frame or 
Every 3rd frame.
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Under normal circumstances, analyzing 10 -15 frames per second is sufficient for an 
accurate analysis. This means that if your video contains 30 frames per second or 
more, you can safely decrease the sample rate of FaceReader without loss of 
accuracy and make the analysis two to three times faster.

For camera analysis — Video is sampled at 15 frames per second, also when your 
camera is set to a higher frame rate, and independent of what you choose under 
Sample rate. 
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Analysis options

Batch analysis 

Skip already analyzed frames

When you have selected this option, video fragments that were already analyzed 
will be skipped in batch analysis.

IMPORTANT  Make sure you deselect this option when you carry out a camera 
analysis while simultaneously recording video and want to re-analyze these videos 
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offline. Otherwise FaceReader will not analyze the frames that were already 
analyzed in the camera analysis. 

Camera Analysis

Maximum Camera Analysis Duration

Enter the maximum duration for analyses carried out with a live camera image.

 Default: 1 hour.

 Maximum: 2 hours.

Optional classifications

Action units

With this option selected, FaceReader classifies Action Units. This option is only 
available when you have the Action Unit Module. 

See The Action Unit Module

Consumption behavior

With this option selected, FaceReader analyzes whether the test participant is taking 
a bite or a sip (‘Intake event’) or is Chewing.

See The Consumption Behavior Module

Contempt

Select this option to classify Contempt, which is an expression in which one corner 
of the lips is tightened and slightly raised. 

Treat Contempt as an Emotional State 

Select this option to add Contempt to the expression states in the State log and 
Timeline. This makes contempt mutually exclusive with the other expressions. 

Gaze tracking

With this option selected, FaceReader classifies whether the test participant looks 
left, forward or right, while taking the head orientation into account. The output is 
one of nine gaze directions: Left, Left-Up. Left-Down, Right, Right-Up, Right-Down, 
Up, Down and Forward. In addition, the gaze angle can be logged and visualized 
(Horizontal gaze angle and Vertical gaze angle).

See Show Global Gaze Direction in FaceReader’s output
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Vital signs

With this option selected, FaceReader estimates the participant’s current heart rate 
and heart rate variability by means of Photoplethysmography and respiratory 
(breathing) rate. This option is only available if your license includes the Vital Signs 
Module.

See The Vital Signs Module

Voice analysis

Select this option to analyze vocal characteristics and determine whether there is 
happiness, sadness or anger audible in the voice or whether it is neutral.
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Data Export

External communication (API and Stimulus Presentation Tool)

External communication is needed when you use the Stimulus Presentation Tool. 
Also, with FaceReader, an Application Programming Interface (API) is included. This 
API allows you to analyze images or videos with FaceReader on one computer and 
send the logged data to an application on another computer. Our support 
department (see Help desk for contact information) can supply you with a detailed 
description of how to use the API functionality. They can also give you an example 
of an application that can receive FaceReader data.

Enable external control (API) 

Select this option when you want to use the Stimulus Presentation Tool and when 
you want to use the API functionality.

Default: Not selected.
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External connection port

Specify the port through which the external application or the Stimulus 
Presentation Tool can connect to FaceReader. External applications can also receive 
the logged data through this port. 

Default: 9090.

Please note that if you use The Observer XT 13 or higher versions with FaceReader 7 
or higher, you do not use this setting, but connect with the Noldus network 
communication protocol N-Linx instead. 

See External Communication (N-Linx)

Export with a fixed interval (5 frames per second)

If this option is selected, an update to the Detailed log will be made every 200 
milliseconds. If your computer cannot process the incoming images fast enough, 
frames will be skipped and a record with MISSING will be added to the Detailed log.

Default: Not selected.

External Communication (N-Linx)

N-Linx is a network communication protocol that enables data transfer between 
Noldus software. Use N-Linx if you have The Observer XT 13 or higher versions, and 
want FaceReader to start and stop analyzing together with an observation in The 
Observer XT. The FaceReader data are imported automatically into the observation 
and synchronized with the manual annotations. 

If you do not use N-Linx, or if you have an older version of The Observer XT, you 
must export the FaceReader data and import them into The Observer XT manually. 
Data import with N-Linx is easier and faster and ensures synchronization. For this 
functionality to work, your license for The Observer XT must include the External 
Data Module.

Enable N-Linx

Select this option to start and stop FaceReader analysis together with an 
observation in The Observer XT and to import the data automatically in the 
observation. 

N-Linx server address

Enter the IP address, or full computer name, of the computer with N-Linx Server. 

If connection with N-linx Server is established the text N-Linx connected appears 
in the upper right corner of your FaceReader window. 
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See also the Reference Manual - N-Linx. You can download it from the download 
section of the Noldus website. 

https://my.noldus.com

Export (Detailed log, ODX, N-Linx and API)

By default, the detailed export file contains the classification output values for the 
six basic emotions, and the neutral state. Contempt is added if you selected it as 
optional classification in the Analysis options tab. Select one of the options below 
to add extra information to the log file.

IMPORTANT  Please note that if your observations are long, writing a lot of extra 
information to the log can make your log files very large and can make the analysis 
slower.

Action units

This option is only available if your FaceReader license includes the Action Unit 
Module. With this option selected, extra columns with the Action Units are added to 
the log file. Values are between A (trace) and E (max). This option is only available 
when you have the Action Unit Module. 

See Action Units in the log files in The Action Unit Module

Export action units as continuous values

With this option selected, the Action Unit categories A-E are exported as numerical 
values between 0 and 1. 

See Action Units in the log files in The Action Unit Module

With this option selected, the Action Unit intensities can be imported into The 
Observer XT as external data.

See Import the detailed logs as external data in FaceReader with The Observer XT

Export the unilateral action unit intensities

If you select this option, the Detailed log file will have three columns for each 
unilateral Action Unit, one for the intensity of the Action Unit on the right side of 
the face, one for the left side and one combined which is the maximum of the left 
and right values.
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Consumption behavior

This option is only available if your FaceReader license includes the Consumption 
Behavior Module. With this option selected, FaceReader adds three columns to the 
Detailed log file, ‘Intake event’, ‘Chewing’ and ‘Chew motion’ with for each analyzed 
frame ‘Yes’ or ‘No’ to indicate whether the behavior was active or not. 

Custom expressions

This option is only available if your FaceReader license includes the Action 
Unit Module. Selecting this option, adds a column to the Detailed log file for 
each custom expression showing its intensity for each analyzed frame.

Facial states

With this option selected, 5 extra columns are added to the Detailed log: Mouth 
(open or closed), Left-Eye (open or closed), Right-Eye (open or closed), Left-
Eyebrow (raised, neutral or lowered) and Right-Eyebrow (raised, neutral or 
lowered).

See Facial States in FaceReader’s output

Gaze data

With this option selected, two extra columns are added to the Detailed log: Gaze 
Direction and Gaze Type. The gaze direction can either be Left, Left-Up, Left-
Down, Right, Right-Up, Right-Down, Up, Down and Forward. The gaze type is either 
Fixation, Saccade or Unknown. This option is only available if Gaze tracking is 
selected in the Analysis Options.

Gaze angles

With this option selected two extra columns are added to the Detailed log: 
Horizontal gaze angle and Vertical gaze angle. The horizontal and vertical gaze 
angles are 0 degrees when the test participant looks straight ahead.

Head orientation

With this option selected, three extra columns are added to the Detailed log: Pitch, 
Yaw and Roll (in degrees).

See Reporting Display in FaceReader’s output

Head position

With this option selected three extra columns are added to the Detailed log: 
Horizontal position, Vertical position and Depth position with the head position 
angles in millimeters relative to the camera.
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Vital signs

This option is only available if your FaceReader license includes the Vital Signs 
Module. With this option selected, eight extra columns (Heart Rate, Heart Rate 
Variability (RMSSD), Heart Rate Variability (SDNN), Heart Rate Warnings, 
Heart rate confidence, Breathing Rate, Breathing Rate Warnings and Breathing 
rate confidence) are added to the Detailed log. 

The Heart Rate Warnings and Breathing Rate Warnings columns may contain the 
following warnings: 

 FIND_FAILED/FIT_FAILED — If no face is found or the face cannot be 
modeled (e.g. because the quality of the video is poor)

 MISSING — If you work live (using a camera) and your computer cannot 
process the incoming images fast enough, frames will be skipped

 Framerate, bitrate, resolution ratio too low — If your camera settings 
deviate from the recommended settings. See The Vital Signs Module for 
more information about the recommended settings for heart rate, heart 
rate variability, and breathing rate measurement.

The Heart rate confidence values and Breathing rate confidence values are 
values between 0 and 1, indicating the quality of the heart rate/breathing rate 
measurements.

Valence and Arousal

If you select this option the valence and arousal are added to the log file. 

See Valence and Arousal Line Chart and in FaceReader’s output.

Expressions from voice

This option is only available if your FaceReader license includes the Voice Analysis 
Module. With this option selected seven extra columns are added to the Detailed 
log: Neutral from Voice, Happy from Voice, Sad from Voice, Angry from Voice, 
Valence from Voice, Arousal from Voice, Loudness and Speech rate. Voice 
Analysis in the Analysis Options must be enabled.

Export (Detailed log and API)

Consumption behavior statistics

This option is only available if your FaceReader license includes the Consumption 
Behavior Module. Select this option to add the variables Intake count and Chew 
motion count to the Detailed log.
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Gaze fixation index and location

This option is only available if your FaceReader license includes the Advanced 
Research Module. Select this option to add three columns to the Detailed log file: 
Gaze Location X, Gaze Location Y and Fixation Index. Gaze Location X and Gaze 
Location Y are the x,y coordinates of the test participant’s gaze point on the screen. 
The X,Y-coordinates are in pixels relative to the upper left corner of the screen. The 
Fixation Index is the total number of fixations up until that point in time.

2D Landmarks

With this option selected the X-Y-coordinates of the dots around the eyes, nose 
and mouth of the mesh are added to the log file. The log file has 134 numbers in 
the column Landmarks. The first two numbers are the X- and Y-coordinates of 
landmark 0, the third and fourth are the coordinates of landmark 1 etc.

 

The following landmarks are present in the detailed log: 

 0-9 – left eyebrow 

 10-19 – right eyebrow 

 20-21 – corners left eye 

 22-23 – corners right eye 

 24-26 – nose 
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 27-66 – mouth 

The X,Y-coordinates are in pixels relative to the upper left corner of the image. 

Please contact Technical Support if you want to know the position of the landmark 
points in the face. They can send you a photo of a face with the 67 landmark point 
positions. They can also provide you with a photo of all the 468 landmark point 
positions in the face.

See Show Mesh in FaceReader’s output

Log complete set of 3D landmarks

Select this option if you want to include the X,Y, Z coordinates of all the (468) 
landmark points in the Detailed log.

Please note that the 3D landmarks are not in pixels but in millimeters relative to the 
camera.

To project the 3D landmark points on the camera or video images you need the 
camera matrix

C=

fx, 0, cx

0, fy, cy

0, 0, 1

if

w = image width in pixels

h = image height in pixels

then:

fx = 1.2 * Max(w,h)

fy = 1.2 * Max(w,h)

cx = w/2

cy = h/2

Then each 3D world coordinate (xw, yw, zw) can be projected to an image 
coordinate (xm, ym) by

xm = (xw * fx)/zw + cx

ym = (yw * fy)/zw + cy



349

Export (Detailed log only)

Subject characteristics

With this option selected, three extra columns are added to the Detailed log: 
Gender (male/female), Age (an estimation of the test person's age) and Glasses 
(Yes/No).

See Circumplex Model of Affect in FaceReader’s output

Participant name and analysis index

The name of the participant and the name of the analysis.

Model quality

The model quality is indicated by a value between 0 and 1.

See one of the following:

 Step 3 in Manual procedure image analysis 

 Step 3 in Manual procedure video and camera analysis in Analyze facial 
expressions 

Empty Data

Choose how the following values are exported to the export files:

 Log value when the face could not be found – The term when FaceReader 
cannot find a face

Default: FIND-FAILED. 

 Log value when the model fit failed – The term when FaceReader finds a 
face but cannot create a model of it.

Default: FIT-FAILED. 

 Log value for when an item is unknown – The term when FaceReader finds a 
face and can create a model, but cannot determine the facial expression. 

Default: UNKNOWN 
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Visualization

Camera

Automatically clear results after 1 minute (for demonstration only)

Select this option when giving a demonstration, to make sure that FaceReader can 
run for a long time.

Default: Not selected.

Video

Repeat video (for demonstrations only)

This option is for demonstration purposes only. If you select this option your video 
is played continuously.

Default: Not selected.
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Advanced options

Face Modeling

Minimum model quality

The minimum model quality required for a model to be valid.

Accepted values: 0 (low quality) - 1 (high quality).

Default value: 0.5 (this is the hatched line that you see in the middle of the Model 
quality bar).
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Gaze tracking

Angular speed threshold

This threshold is used to distinguish between saccades (faster than the threshold) 
and fixations (slower than the threshold).

Head Orientation

The test person should stand or sit and look frontally into the camera, an angle of 
30° (in both directions, yaw and pitch) is accepted by default. If the angle is bigger 
than this threshold, the face model will be rejected. You can increase or decrease 
the thresholds to accept face models of lower/higher quality, respectively. 

 Maximum allowed pitch angle — If the pitch angle is higher than this 
threshold, the face model will be rejected.

Default value: 30 degrees.

 Maximum allowed yaw angle — If the yaw angle is higher than this 
threshold, the face model will be rejected.

Default value: 30 degrees.

 Minimum allowed pitch angle — If the pitch angle is lower than this 
threshold, the face model will be rejected.

Default value: -30 degrees.

 Minimum allowed yaw angle — If the yaw angle is lower than this 
threshold, the face model will be rejected.

Default value: -30 degrees.
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Heart rate

Heart rate variability period

The minimum time that is needed to calculate heart rate variability.

Accepted values: 1-60 minutes. Default: 5 minutes.   

See also Calibration in The Vital Signs Module. 

Size of Interest

You can set the Size of Interest by clicking the up and down arrows for the 
Minimum face fraction and/or the Maximum face fraction.

Minimum face fraction 

Minimum fraction of the face surface relative to the entire image surface. 

Accepted values: 0.01 - 1. Default: 0.11.

Maximum face fraction 

Maximum fraction of the face surface relative to the entire image surface.

Accepted values: 0.01 - 1. Default: 0.80.
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FaceReader in combination
with FaceReader Online

Main topics

 What is FaceReader Online?

 Import your FaceReader Online project into FaceReader

 Create a FaceReader Online trial account
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What is FaceReader Online?
FaceReader Online is our facial expression analysis service that runs online on a 
cloud server and does not need any on-site installation. This means that you can 
test appreciation or impact on-site while participants can stay at home, allowing 
you to incorporate a much larger number of participants and saving them the effort 
of coming to the lab at the same time. If you like, you can define questions in 
FaceReader Online or integrate FaceReader Online into your own survey software, 
such as Qualtrics. You can view a screen recording with the test participant’s gaze 
overlay in FaceReader Online’s Recording Results.

You can import data from your FaceReader Online projects directly into FaceReader 
and analyze the data using all the analysis functions that are available in 
FaceReader. 
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Import your FaceReader Online 
project into FaceReader

1. Use one of the following two options:
- In the FaceReader Start window click Import project or

- From the File menu select Import FaceReader Online Project.

2. Sign in to your FaceReader Online account. A webpage on the FaceReader 
Online website opens showing an overview of all your Active, Completed 
and Closed projects.

3. The status of your FaceReader Online projects is either:

- Not Yet Created: you do not have a project file yet.

- New Results Available: invitees participated in your FaceReader Online 
test after you created the previous project file. The data of these 
participants are not in the project file yet.

- Up To Date: your project file contains the data of all the subjects who 
participated in your test sofar.

4. Click the Generate project file icon to create a project file or add new 
results or recordings to your existing project file.
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5. Select whether you want to include recordings in your project file and click 
Generate. The project file status changes to Generating and you can 
follow the progress of the file generation.

When the project file is ready, the project file status will change to Up To 
Date.

6. Click the Import project file icon
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7. Select where you want to save your FaceReader project. Optionally, enter a 
new name for your project and click OK.

You are now ready to: 

 Open the analyses, view the data per test participant and make charts — 
See FaceReader’s output. If you selected to show your participants’ 
recordings when you created the FaceReader Online project and you 
included your recordings when you imported the project in FaceReader, you 
can visualize the test participant’s face next to the Stimulus View and, for 
instance, the participant’s Expression Intensity chart. See Stimulus View 
in FaceReader’s output for more information. If you selected to Include 
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gaze tracking when you defined your FaceReader Online experiment, the 
Stimulus View window shows the participant’s gaze overlay.

 Export the data of each participant in a State log or Detailed log file — See 
FaceReader’s output.

 If you selected to include your recordings when you imported the project 
— Re-analyze the videos, for instance, to select the EastAsian face model 
instead of the General model or to calibrate and then run a new analysis.

 In the Project Analysis section — Visualize your data in charts and calculate 
statistics over all participants or per participant group (for instance, male 
and female participants or different age groups). 

Create a FaceReader Online trial account

If you are new to FaceReader Online and want to try it out you can create a trial 
account. In the FaceReader Start window select Create account under FaceReader 
Online and follow the steps on your screen. Click Learn more in the Start window 
to open the FaceReader Online page on the Noldus website.
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FaceReader with The
Observer XT

Main topics

 FaceReader in combination with The Observer XT

 Control FaceReader with The Observer XT using N-Linx

 Import FaceReader videos only

 Import multiple FaceReader analyses into the same observation

 How FaceReader data are imported into The Observer XT

 Visualize FaceReader data in The Observer XT

 The Observer XT sample projects with FaceReader data
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FaceReader in combination with The 
Observer XT
Integrating FaceReader data with other data may give you a more complete picture 
of the phenomena that you are studying. For instance, when testing your newly 
developed website, it may be interesting to know what emotions it evokes, but it 
may be even more intriguing to see at what part of the web site your test person is 
looking when his facial expressions are classified as 'happy' or 'surprised'. Manually 
logging the test person's verbal reactions or measuring his physiological responses 
makes the picture complete. For the integration of all these data, you can use The 
Observer XT. 

You can let FaceReader record a video of the test participant’s face and import 
FaceReader's log files together with the video into The Observer XT. You can then 
visualize the test person's facial expressions together with your observational data 
and calculate statistics. The procedure for co-acquiring and importing FaceReader 
data depends on whether you observe live or offline. If you observe live, the 
procedure depends on the version of The Observer XT. 

IMPORTANT  Make sure that FaceReader elements that are imported into The 
Observer XT do not already exist in the Coding Scheme of The Observer XT. 
Otherwise the FaceReader data will be assigned to the element that was already 
present in the Coding Scheme and your Observer data will be incorrect. Please be 
especially aware to not use the element names Unknown, or Neutral in the Coding 
Scheme of The Observer XT, since these names are used for the facial expressions. 

Which option applies to you?

 Observe live in The Observer XT with the External Data Module

 Observe live in The Observer without the External Data Module

 Observe offline in The Observer XT

Observe live in The Observer XT with the External Data Module

The Observer XT 13.0 and higher versions make use of the Noldus network 
communication protocol N-Linx to control FaceReader. 

For details on N-Linx, see the Reference Manual - N-Linx. You can download it from 
the download section of the Noldus website. 

https://my.noldus.com

To use this functionality, you need the External Data Module (EDM) of The Observer 
XT. 
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For the detailed procedure, see Control FaceReader with The Observer XT using N-
Linx

Observe live in The Observer without the External Data Module

If you do not have The External Data Module (EDM), you can set up The Observer 
XT to start and stop FaceReader analysis together with an observation. See Add a 
Custom External Device in The Observer XT Help for the procedure. 

Observe offline in The Observer XT

When you carry out offline observations in The Observer XT, you start and stop 
FaceReader analysis manually. Also you must export the data from FaceReader and 
import them together with the videos into The Observer XT manually.
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Control FaceReader with The Observer 
XT using N-Linx
Aim

To automatically analyze facial expressions with FaceReader together with an 
observation in The Observer XT, import the FaceReader data and videos and 
synchronize them automatically with the event log. 

Background 

The communication between FaceReader and The Observer XT makes use of the 
Noldus network communication protocol N-Linx. 

For details on N-Linx, see the Reference Manual - N-Linx. You can download it from 
the download section of the Noldus website. 

https://my.noldus.com

Prerequisites

 You have a license for The Observer XT 14.1 or higher that includes the 
External Data Module. To see if you have this module, open The Observer 
XT and choose Help > About The Observer XT > License info. 

 N-Linx Server is installed on a computer in the network.

 Both FaceReader and The Observer XT are open. 
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 You created a project in The Observer XT and FaceReader. These projects 
are open.

 Your FaceReader project does not contain image analyses. You cannot mix 
image analyses with camera analyses in FaceReader. 

 You selected a default camera in FaceReader. 

 IMPORTANT  The Coding Scheme in The Observer XT does not contain 
element names that are also used in FaceReader, like Neutral, Unknown, or 
Happy. 

 FaceReader, The Observer XT and N-Linx Server run on computers that are 
part of the same network. 

Procedure

1. If FaceReader, The Observer XT, and N-Linx Server are not all installed on 
the same computer, make sure that traffic through the N-Linx port is not 
blocked by Windows Firewall. Create exceptions in Windows Firewall for the 
N-Linx port on all computers with FaceReader, The Observer XT, and N-Linx 
Server. 
See Create exceptions for the N-Linx port in Windows Firewall

2. If FaceReader and The Observer are installed on different computers and 
you want to import the FaceReader videos automatically in The Observer 
XT, make sure that The Observer XT can access the FaceReader videos.

See Make sure The Observer XT can access the FaceReader video files

3. Set up FaceReader to work with The Observer XT

4. Set up The Observer XT to work with FaceReader

5. Carry out your observation in The Observer XT and co-acquire data with 
FaceReader.

See Observe in The Observer XT and analyze in FaceReader

Note

Check on the download section of the Noldus website if an update of this 
procedure is available. For example in case of an update of The Observer XT or N-
Linx. 

https://my.noldus.com
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Create exceptions for the N-Linx port in 
Windows Firewall
Aim

To make sure traffic through the port that is used by N-Linx is not blocked by 
Windows Firewall. 

Prerequisite

FaceReader, The Observer XT and N-Linx Server are not all installed on the same 
computer. If they are all installed on the same computer, skip this topic.

Procedure

Follow this procedure for all computers with FaceReader, The Observer XT, and N-
Linx Server.

1. Open the Control Panel and select Windows Defender Firewall.

2. On the left side of the window, click Advanced Settings.

3. Click Inbound Rule and click New Rule in the Actions pane. 

4. In the New Inbound Rule Wizard Window that opens, select Port and click 
Next. 

5. Select TCP and enter 5672 in the Specific local ports field and click Next.    

6. Click Allow the connection and click Next.

7. Select to which network the rule applies and click Next.

8. Give the rule a name, for example N-Linx connection and click Finish. 
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9. Check in the Inbound Rules windows that this rule is set to Enabled.

10. Click Outbound Rule and click New Rule in the Actions pane. 

11. Repeat steps 4-9 for the outbound rule. 

12. Close all Control Panel windows. 
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Make sure The Observer XT can access 
the FaceReader video files
Aim

To make sure The Observer XT can access that videos FaceReader records. The 
videos are not copied to The Observer XT. The Observer XT creates a link to the 
FaceReader videos. 

Procedure

Carry out the following steps:

1. Share the folder where FaceReader stores its video files.
IMPORTANT Since the FaceReader videos are stored in the subfolder 
Recorded Videos in the project folder, this procedure has to be carried out 
for every new FaceReader project. If a project has only a few videos it may 
be easier to import the video files manually into The Observer XT. 

2. Switch off password protected sharing on the FaceReader computer

3. Map the shared folder with FaceReader video files

Share the folder where FaceReader stores its video files

1. Right-click the folder where the video files are going to be stored, which is 
by default C:\Users\<your username>\Documents\Noldus\FaceReader 10 
\Projects\[Project name]\Recorded Videos
and select Give access to and then Advanced Sharing Settings. 
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2. Change the sharing options for all your network profiles (‘Private’, ‘Guest or 
Public’ and ‘Domain’): select the option Turn on file and printer sharing 
for all your profiles.

3. Under ‘All Networks’ select the option Turn on sharing so anyone with 
network access can read and write files in the Public folders. Then click 
Save Changes.

Switch off password protected sharing on the FaceReader 
computer

This procedure is needed to make sure that the folder where FaceReader stores its 
videos files can be accessed without a password by the computer with The Observer 
XT. 

The procedure differs for a Windows workgroup or a domain. To see whether the 
FaceReader computer is in a workgroup or a domain, open the Control Panel and 
choose System and then Advanced System Settings and click the Computer 
Name tab. The type of network is listed under Computer name, domain, and 
workgroup settings.
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Procedure for workgroup

1. Follow the procedure in Share the folder where FaceReader stores its video 
files to open the Advanced sharing settings. 

2. Under Password protected sharing, select the option Turn off password 
protected sharing. 

IMPORTANT  If you do not see this option, most likely your computer is in a 
domain, not a workgroup. Carry out the procedure for domain below. 

Procedure for domain

1. Press the Windows key + R.

2. Type lusrmgr.msc and press OK.

3. Open the Users folder and double-click Guest.

4. Deselect Account is disabled and click OK and close the lusrmgr window. 

5. Press the Windows key + R.

6. Type gpedit.msc and press OK. 

7. Open Computer Configuration\Windows Settings\Security Settings\Local 
Policies\User Rights Assignment and double-click Deny access to this 
computer from the network.  

8. Click Guest and then choose Remove > OK.

9. Close the Local Group Policy Editor window. 

Map the shared folder with FaceReader video files

Carry out this procedure on both computers. 

1. Open File Explorer and then This PC. 

2. Click Computer and then click the Map network drive icon. 
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3. Choose a name for the drive and browse to the shared folder. 

IMPORTANT  Make sure you select the same drive letter on both computers. 

4. Click Finish.

Notes

 When you now start the computer with The Observer XT you need to enter 
the login details for the computer with FaceReader. 

 Make sure the computer with FaceReader videos is switched on when you 
open your project in The Observer XT. Otherwise The Observer XT will not 
be able to open the videos.
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Set up FaceReader to work with The 
Observer XT
Procedure

1. Choose File > Set Default camera, choose your camera and select the 
option Record. 

2. Choose File > Settings > Data Export. 

3. Under External Communication (N-Linx), select Enable N-Linx. 

4. If FaceReader and N-Linx Server run on the same computer, leave the 
default address localhost in the N-Linx server address field. If the 
programs run on different computers, enter the IP address or computer 
name of the computer with N-Linx Server. To find that name, open the 
Control Panel and choose System. 

5. In the N-Linx server port field, leave the default port 5672. Ask your 
system administrator for assistance if this port is in use by another 
program. 

6. Under Export (Detailed Log, ODX, N-Linx and API), choose which data to 
send to The Observer XT.
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Set up The Observer XT to work with 
FaceReader
Prerequisites

 FaceReader is open.

 You followed the steps in Set up FaceReader to work with The Observer XT

Procedure

1. In The Observer XT, open your project and choose File > Preferences > N-
Linx Settings. 

2. Select Use N-Linx server to connect with other applications. 

3. In the Services address field, enter the name of the computer with N-Linx 
Server. Enter localhost if N-Linx Server and The Observer XT run on the 
same computer. 

4. In the Services port field, leave the default port 5672. Ask your system 
administrator for assistance if this port is used by another program.

5. Click Test connection. If connection with N-Linx Server is found, the Status 
will change to Connected. If not, enter the correct settings and click Test 
connection again.

6. Click OK.

7. Choose Setup > Project Setup. 

8. Select Live Observation. The Devices window now opens. If not, click the 
Devices button. 
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9. Double-click the line FaceReader -[computer name] 

10. If you have multiple instances of FaceReader connected to The Observer XT, 
enter a unique name in the Identify device as field. This name will be 
added as Subject to the Coding Scheme. 

If you leave the Identify device as field empty, no subject will be added.

11. Select the FaceReader settings for your experiment. 
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For an explanation of the settings, see:

Smoothen classifications – Classification

Continuous calibration – Procedure 

To use Participant calibration (see Create a participant calibration), select 
that option manually in FaceReader.

Face model – Active Face Model

Image rotation – Rotation   

12. Click OK and select the checkbox in front of the line FaceReader -
[computer name].
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Observe in The Observer XT and analyze 
in FaceReader
Procedure

1. Check the following:
That your camera is connected to the PC, that it is turned on, and selected 
as default camera in FaceReader. 

That FaceReader is open and the upper right corner shows the text N-Linx-
connected.

That you selected the data to export in FaceReader.

IMPORTANT  Select only the data you really need. Data files can become very 
large when you select many export options. This slows down data import 
into The Observer XT. 

2. Let the test participant take place at the test computer and check that the 
FaceReader webcam has a proper view of the face.

See Camera and accessories in Installation

3. Create a new observation in The Observer XT. A new participant is created 
in FaceReader with a camera analysis. 

4. Start the observation in The Observer XT. Dependent on the settings in The 
Observer XT, the Independent Variables list appears. This list contains the 
independent variables you created in The Observer XT together with the 
FaceReader independent variables Age, Gender and ParticipantID. When 
you enter the values of the user defined independent variables, the 
observation and FaceReader analysis start. 

See Independent Variables how FaceReader independent variables are 
imported into The Observer XT.

5. Score data in The Observer XT. FaceReader automatically analyzes the 
camera images and creates a video file.

6. Stop the observation. 

Classification in FaceReader is automatically stopped. The FaceReader data 
and videos are automatically imported into the observation. The Expression 
states are imported as behaviors and the values of the detailed log are 
imported as external data. 
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Notes

 If your license for The Observer XT does not include the External Data 
Module, you must set up The Observer XT to start and stop FaceReader 
analysis together with an observation. 

See Add a Custom External Device in The Observer XT Help for the 
procedure. 

IMPORTANT  Importing FaceReader data adds FaceReader elements to the 
coding scheme. However, these elements cannot be scored manually in a 
new observation in The Observer XT.

 When you enter a name in the Identify device as field in step 10 of Set up 
The Observer XT to work with FaceReader, this name is added as a subject 
to the Coding Scheme. When you now manually score events, The Observer 
XT expects that for each event you first score a subject and then a behavior. 
Define a subject in the Coding Scheme. Then choose Setup > Project 
Settings > Scoring Options and select Auto-record subject. You now 
have to score the subject only once at the start of the test.
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Offline observations

Aim

To manually import FaceReader data and videos into The Observer XT. 

Procedure

Carry out the following steps

1. Export FaceReader log files

2. Import the FaceReader data and videos into The Observer XT

3. Synchronize data sets. See Carry out an observation/Synchronize data 
sets in The Observer XT Help.
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Export FaceReader log files
In FaceReader, choose File > Export > [one of the options], to export the data for a 
single analysis, single participant, or entire project.

Under Export to text files (.txt) choose Save Detailed log. The Detailed log file 
contains the intensities of the facial expressions per sample and other data that you 
have selected under Settings > Data Export.

IMPORTANT  Select Include file header and Include column headers. If you do not 
select both check boxes, import into The Observer XT fails. 

Under Export to The Observer XT (.odx), choose Save The Observer XT log. Do 
not select the Include detailed values checkbox. Select Save all analyses to single 
The Observer XT log to export one log file with the data of all the participants in 
the project. The Observer XT log file lists the dominant facial expressions during the 
tests.
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See also Export analysis results in FaceReader’s output.

Then:

 Import the FaceReader data and videos into The Observer XT  
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Import the FaceReader data and videos 
into The Observer XT
Procedure

Carry out the following steps:

 Import the Observer XT log files plus videos into The Observer XT.

 Import the detailed logs as external data

Import the Observer XT log files plus videos into The Observer 
XT

1. Start The Observer XT, open the appropriate project or create a new one. 
Choose File > Import > Observational Data. 

2. In the Files of type field, select The Observer XT (*.odx) from the list.

3. Browse to your Observer log file and open it. The log files are by default in 
the folder:

C:\Users\<your username>\Documents\Noldus\FaceReader 
10\Projects\[project name]\Logs.
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This imports the FaceReader analysis together with the video of the test 
participant’s face.

Import the detailed logs as external data

To import FaceReader data as external data, your license for The Observer XT must 
include the External Data Module. To see if you have this module, open The 
Observer XT and choose Help > About The Observer XT > License info. 
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On the FaceReader > Drivers & Tools section of our MyNoldus portal 
(my.noldus.com) you will find an import profile to import Detailed log files. Follow 
the steps below to copy the import profile to your computer:

1. Make sure The Observer XT is not running.

2. Download the Import Profile from the MyNoldus portal.

3. Copy the import profile FaceReader 10 Detailed log as external data.eip to 
the default directory for import profiles:

C:\ProgramData\Noldus\Common\Profiles.

The ProgramData folder is a hidden folder. To view this folder, browse to 
C:\ and from the View drop-down list select Show and then Hidden items.
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You are now ready to import your log files into The Observer XT. To do so:

1. Choose File > Import > External Data. 

2. In the Files of type field, select FaceReader 10 Detailed log as external 
data (*.txt) from the drop-down list.

3. Browse to the location on your computer where you stored your log file. 
The default location is:

C:\Users\<your username>\Documents\Noldus\FaceReader 
10\Projects\[project name]\Logs.

4. Select the observation into which you want to import the log file.

5. If a message appears that missing values are found, choose Import and 
Ignore > OK. 
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6. Select the appropriate log file and click Open. The data are imported into 
The Observer XT.

If you have additional modules and selected additional data when you exported the 
Detailed log data (like Action Units or Expressions from voice), you need to make a 
new import profile. See External Data in The Observer XT Help how to do so, or 
contact Noldus Support. 

What’s next

Synchronize the data sets. See Carry out an observation/Synchronize data sets in 
The Observer XT Help.
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Notes 

 IMPORTANT  Importing FaceReader data adds FaceReader elements to the 
coding scheme. However, these elements cannot be scored in a new 
observation in The Observer XT. Make sure the FaceReader elements do not 
already exist in the coding scheme of The Observer XT.

 If you only import FaceReader data as external data into The Observer XT, 
the videos are not imported. Continue with Import FaceReader videos only

 If you import FaceReader data as .odx file into The Observer XT, the 
FaceReader independent variables and videos are also imported.

 If you Import the detailed logs as external data, they are imported as 
continuous values. 

 You can calculate statistics like, e.g., the mean and maximum classification 
value for each of the facial expressions in The Observer XT. For more 
information see Calculate Statistics in The Observer XT Help.
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Import FaceReader videos only
Aim

To import the videos of the test participants’ faces into the observation in The 
Observer XT after you carried out the analysis. 

Prerequisite

One of the following is true:

 You observe offline in The Observer XT.

 You control FaceReader with The Observer XT 14.0 or lower.

 You do not import FaceReader analyses as .odx files manually. When you 
import the .odx output of FaceReader analyses into The Observer XT, the 
FaceReader videos are also imported, so you can skip this topic. 

Procedure

1. Open your observation in The Observer XT. 

2. Click the Import video button on the toolbar.

3. Select your video file and click OK. 

4. Synchronize the video file with the observation and imported FaceReader 
data. See Carry out an observation/Synchronize data sets in The 
Observer XT Help. 
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Import multiple FaceReader analyses 
into the same observation
Aim

To import analyses of different test participants from the same experiment into the 
same observation of The Observer XT. You are, for example, interested in the 
interaction between a doctor and a patient. You want to import the analysis results 
of both the doctor and the patient into the same observation in The Observer XT. 

Prerequisites

 You are interested in the interaction between two or more test participants. 
For example, a doctor and a patient, a teacher and a pupil, or a parent and a 
child. You want to import their analyses together into the same observation 
of The Observer XT. 

 You exported the FaceReader data as .odx files. 

See Export analysis results

Procedure

To be able to import multiple analyses into the same observation of The Observer 
XT, the exported FaceReader data must be converted. Conversion adds a Subject to 
the data. Conversion is done with the Subject labeler. 

To install the Subject labeler

1. Download the installation file from the Drivers & Tools section of the MyN-
oldus portal (my.noldus.com).

2. Double-click the file Subject Labeler Setup.exe 

3. Choose Standard as installation type and choose Next. 

4. Accept the terms in the End-user license agreement and click Install. 

To convert the export files

1. Open the Subject Labeler.

2. Browse to the folder that contains the FaceReader export files. 

The .odx files found in this folder are listed in the ODX files field. The 
Subject column shows whether a Subject is present in the export file or not. 
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3. Select the files to add the first Subject to. For example, the analyses of the 
doctors. 

4. In the Subject name field, enter a name to add as Subject to the files, for 
example Doctor.

5. Click Label. 

This adds the Subject name to the .odx file and the file name. 

6. Repeat all steps for the other Subject, for example the analyses of the 
Patients. 

To import the converted file into The Observer XT

1. Open the observation. 

2. Click the Import data button on the toolbar and choose Import 
Observational Data. 
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3. Browse to the converted file and select it. Then click Open. 

4. If the question appears Do you want to import new coding scheme 
elements, click Yes, import new coding scheme elements. 

5. A message appears that import is successful. Click Close. 

Notes

 If an ODX file contains Subjects, it cannot be converted. FaceReader export 
files do not contain Subjects. However, The Observer XT export files may 
have Subjects.

 After conversion, the file appears in the ODX files field of the ODX 
converter. The Status column shows that this file contains a Subject and 
cannot be converted anymore. 

 Importing multiple analyses into the same observation adds each 
FaceReader independent variable as a separate variable to the Independent 
Variables list of The Observer XT. Although the coding scheme contains 
Subjects, the independent variables have scope Observation. 
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 See Set up your project/ Create Coding Scheme/ Subjects in The 
Observer XT Help for more information on Subjects. 
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How FaceReader data are imported 
into The Observer XT
See Visualize FaceReader data in The Observer XT for a full overview of how 
FaceReader data appear in The Observer XT. 

Event data

FaceReader event data are imported into The Observer XT as separate event logs 
within the observations. This is the case for the following FaceReader data: 

 State Expression Values

 Facial States

 Stimuli

 Event markers

 Action Units (with the Action Unit Module, if you exported them to an odx 
file)

 Consumption Behavior events (Intake event, Chewing and Chew motion, 
with the Consumption Behavior Module)

 Gaze direction

Continuous data

Continuous data are imported into The Observer XT at a sample rate of 5 frames 
per second. Your license for The Observer XT must include the External Data 
Module. The following data can be imported as continuous data:

 Facial expression intensity values.

 Valence.

 Arousal.

 Head orientation (Pitch, Yaw, Roll).

 Head position (Horizontal, Vertical and Depth position).

 Gaze angle (Vertical and Horizontal gaze angle).

 Action Units (with the Action Unit Module, if you selected ‘Export action 
units as continuous values’ in the Settings and exported them in a Detailed 
log file).

 Heart rate, heart rate variability, and respiratory (breathing) rate (if your 
FaceReader license includes the Vital Signs Module).
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 Custom Expressions (if your FaceReader license includes the Action Unit 
Module).

 Expressions from voice (including Valence from voice, Arousal from voice, 
Loudness and Speech rate, with the Voice Analysis Module).

Note

See Set up FaceReader to work with The Observer XT how to select the data to 
export from FaceReader and to import in The Observer XT.

Independent Variables

The FaceReader independent variables Age, Gender and ParticipantID are imported 
into The Observer XT together with the FaceReader data. The values for Age and 
Gender are estimated by FaceReader and the ParticipantID is the participant 
number automatically assigned by FaceReader. If the independent variables are not 
present yet in The Observer XT, they will be added to the Independent Variables 
list. If you created them as User defined variables in the Independent Variables 
list of The Observer XT (with the exact variable names as mentioned above) and no 
values are filled in yet before observation start, the FaceReader values are imported 
into the list after the end of the observation. If you already entered values in The 
Observer XT before observation start, these values are maintained. FaceReader does 
not overwrite the Independent Variable values in The Observer XT. 

To enter the independent variable values in The Observer XT instead of importing 
the FaceReader values, create user defined independent variables Age, Gender and 
ParticipantID in The Observer XT. Make sure the names match exactly. Choose to 
enter the independent variables before starting the observation (Choose Setup > 
Project Settings > Observation Settings and choose Before Observation from 
the Edit Independent Variables list).   

To import FaceReader independent variable values in the Independent Variables list 
of The Observer XT, the variable name must exactly match the FaceReader variable 
name. FaceReader contains by default the independent variables Age, Gender and 
ParticipantID. If you, for example, have an Independent Variable age in The 
Observer XT (lower case a instead of upper case), or Participant ID (with a space), a 
new Independent Variable Age or ParticipantID will be added to the Independent 
Variables list when you import the FaceReader data. 

Notes

Duplicate elements

IMPORTANT  Elements that are imported as events into The Observer should not 
already exist in the Coding Scheme of The Observer XT with the exact same name. 
As an example, you may have a mutually exclusive behavior group that contains the 
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behavior Neutral, or Unknown. If you import FaceReader emotional expressions into 
The Observer XT, the expressions Neutral, or Unknown will then be scored for the 
behavior group that was already present in the Coding Scheme and will not be 
present in the imported event log State Expression Values. Therefore both the 
event log with the manual annotations and the event log State Expression Values 
will be incorrect. 

Sample rate

FaceReader data are imported into The Observer XT with a sample rate of 5 frames 
per second. This is to limit the amount of data that is transferred to The Observer 
XT. FaceReader itself samples with the camera frame rate and converts the data to a 
sample rate of 15 frames per second after the analysis is finished. Therefore, the 
data in The Observer XT may differ slightly from the analysis results in FaceReader. 

See Camera frame rate and samples in FaceReader in Set up your project

Vital signs

If your FaceReader license includes the Vital Signs Module, FaceReader can estimate 
the test participants’ heart rate, heart rate variability, and respiratory (breathing) 
rate. These data can be imported real-time in The Observer XT.

In FaceReader, the first 15 seconds of the analysis is used for calibration and the 
heart rate and breathing rate data are post-processed after the analysis is finished. 
The Observer XT imports the heart rate and breathing rate data real-time. 
Therefore, the heart rate and breathing rate data of the first ten seconds that are 
imported into The Observer XT contain data that are not yet calibrated. The data 
that are imported are not post-processed and will differ from the FaceReader data. 
Since post-processing is used to re-calculate the data, based on the calibration, the 
data in FaceReader itself are more reliable. 

Whereas for heart rate the first 8.5 seconds of an analysis are post-processed after 
the analysis is finished, for breathing rate this is 15 seconds and for heart rate 
variability this is the first 5 minutes (or even longer).

See Vital Signs Module 

Event log duration

 There will be a slight delay between the moment you start an observation in 
The Observer XT and the moment FaceReader starts analyzing. Since the 
end of all event logs is determined by the end of the observation, the 
FaceReader event log will have a shorter duration than The Observer XT 
event log in the analysis. This is caused by the offset between the event 
logs. 

 The observation in The Observer XT ends when you click the stop 
observation button. However, the FaceReader analysis will stop when you 
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confirm to the message in The Observer XT Are you sure you want to stop 
the observation? Therefore the FaceReader event log will be longer than 
The Observer XT event log. However the event log duration in the analysis 
is determined by the end of the observation (see the previous bullet).
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Visualize FaceReader data in The 
Observer XT
State Expression values

State Expression values are imported into the observation as a separate event log. 
When you open the coding scheme, you will see that a behavioral group Dominant 
Expressions has been added with the six basic expressions, Contempt 
(optionally), the Neutral state plus Unknown and Not Analyzed as behaviors. 
Unknown is the expression that is logged when FaceReader cannot find or model 
the face. See the figure below for a visualization of imported State log values. 

Event Markers and Stimuli

Event Markers and Stimuli are imported as separate event logs into the observation. 
They are added to the Coding Scheme as behavior groups Event Markers and 
Stimuli. See the figure below for an example of a visualization of imported Event 
Markers and Stimuli. 
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Facial States and Global Gaze Direction 

If you imported Facial States or Global Gaze Direction in The Observer XT, the new 
observation contains an extra Event log: Facial States. The behavioral group Facial 
States has been added to the coding scheme containing the states as State Events 
with modifiers. For example the State Left eye has the modifiers Open and Closed. 

Consumption Behavior data

If you imported a Detailed log file with Consumption Behavior events in The 
Observer XT, the new observation contains an extra Event log: Consumption 
Behavior. The behavioral group Consumption Behavior has been added to the 
coding scheme containing the states as State Events. 
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Continuous data

Continuous data are shown as a continuous graphs when you use FaceReader and 
The Observer XT 13 or higher versions with N-Linx, or imported the detailed log as 
external data into The Observer XT. Your license for The Observer XT must include 
the External Data Module.  
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Action Unit Intensities as continuous data

This option is only available if your FaceReader license includes the Action Unit 
Module. In addition to this, you chose to export Action Units as continuous values 
in the Data export tab of the FaceReader Settings window (File > Settings).   

You imported the detailed log into The Observer XT as external data. The Action 
Unit intensities are displayed as continuous graphs.  

Action Units as observational data

This option is only available if you have the Action Unit Module in FaceReader. If 
you imported the detailed log as odx file, or used FaceReader and The Observer XT 
with N-Linx, the Action Units are imported as a separate event log in the 
observation. The Coding Scheme contains a behavior group Action Units with the 
modifier group Activation intensity that contains the intensities A to E. See the 
figure below for an example of a visualization. Click the + sign next to an Action 
Unit to visualize its intensity values (A, B,...).
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Custom Expression intensities as continuous data

This option is only available if your FaceReader license includes the Action Unit 
Module. You imported the detailed log into The Observer XT as external data (either 
via the N-Linx protocol or manually). The Custom Expression intensities are 
displayed as continuous graphs. 
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Expressions from voice intensities as continuous data

This option is only available if your FaceReader license includes the Voice Analysis 
Module. You imported a detailed log file into The Observer XT (either via the N-Linx 
protocol or manually). The Expressions from voice are displayed as continuous 
graphs, one for each expression and graphs for Valence from voice, Arousal from 
voice, Loudness and Speech rate.
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Data selection and statistical analysis

You can use the imported data for data selection and statistical analysis. For 
example to select the time period over which Stimulus 1 was scored and to analyze 
the facial expressions over this time period. For more information on Data selection 
and statistical analysis, see The Observer XT Help.
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The Observer XT sample projects with 
FaceReader data
On the MyNoldus portal of the Noldus website (my.noldus.com) under The 
Observer XT > Downloads > Sample projects, you can find two sample projects with 
FaceReader data for The Observer XT.

Child FaceReader

In this sample project the facial expressions of a child playing an online game are 
recorded in a media file and analyzed with FaceReader. Simultaneously, the Noldus 
screen capture device is used to create a media file of the monitor. With an Event 
marker the time intervals during which the child looks away were marked in 
Facereader. FaceReader data, with Action Units, Stimuli and Event markers, and 
video files were imported into The Observer XT. 

For a full description of this sample project you can download the PDF file 
“Description of sample projects of The Observer XT - psychology usability 
ergonomics” from The Observer XT section of the Noldus website. You need to 
register and login to be able to download this file. 

https://my.noldus.com

FaceReader & The Observer 

In this sample project two test participants test the taste of three fruit juices. The 
time periods after the test participants drank each fruit juice were marked with 
Event markers. Each participant has been videotaped with two cameras, a webcam 
(for analysis in FaceReader) and a camcorder (to see what cup the participant takes). 
The FaceReader log files (Observer log and Detailed log), with Action Units, Stimuli 
and Event markers, have been imported into The Observer XT. The test participants’ 
behavior has been manually scored.

In the Data profile Intervals by fruit juices, the time intervals after the participants 
drank each fruit juice were separated using the imported FaceReader Event markers 
Fruit juice 1, Fruit juice 2 and Fruit juice 3, respectively.

Under Behavior Analysis, you can find the archived Behavior Analysis State 
Expression Values per fruit juice, with an accompanying chart. For this Behavior 
analysis the data profile ‘Intervals by fruit juices’ was used. 
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Video files

You can download the associated media files from the MyNoldus portal. Before 
opening the sample projects, make sure to copy the media files to the default 
Video files folder of The Observer XT:

C:\Users\Public\Public Documents\Noldus\The Observer XT\Video Files.
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The Consumption Behavior
Module

Main topics

 Introduction to the Consumption Behavior Module

 Analyze Consumption Behavior

 Visualize Consumption Behavior
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Introduction to the Consumption 
Behavior Module
The Consumption Behavior Module allows you to analyze the behaviors Intake 
event, Chewing and Chew motion.

Intake event is taking a bite or sip. Chew motion is one movement of the jaws to 
chew the food in the mouth. Chewing is the state from the first chew motion (after 
taking a bite) till the last chew motion (before swallowing the food).

Please note that you cannot combine the Consumption Behavior Module with Baby 
FaceReader and you cannot analyze consumption behavior in a multi-subject 
analysis.

Guidelines

To make sure that analysis of consumption behavior goes well, it is important that 
not only the face but also the test participant’s hands are visible in the camera view. 
Currently, FaceReader can only detect hands and no cutlery, hence, the hands 
entering the face region is important for FaceReader to detect eating behavior. 
Wiping the mouth can yield a false positive intake event.

To detect drinking behavior, FaceReader uses images of cups, not straws. Hence, it is 
important not to use straws in your experiments.
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Analyze Consumption Behavior
Aim

To switch on Consumption Behavior analysis. 

Prerequisite

 You have the regular version of FaceReader with the Consumption Behavior 
Module. 

 From the participant, both the face and the hands are visible. 

 You followed the Guidelines for good analysis. 

Procedure

1. Choose File > Settings > Analysis options. 
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2. Under Optional Classifications, select Consumption behavior.
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Visualize Consumption Behavior 
Aim

To display the Consumption Behavior during or after the analysis.

Prerequisites

 You have the regular version of FaceReader and your license includes the 
Consumption Behavior Module.

 Consumption Behavior analysis is switched on in the Settings.

See Analyze Consumption Behavior

Consumption Behavior on the Timeline

1. Click the Select window button in one of the visualization windows and 
select Timeline. The Timeline window opens. The Timeline gives an over-
view of the Facial Expressions States, and Optional classifications on a time-
line.

2. From the Consumption Behavior drop-down list, select what behaviors 
you want to view.

You can play back through the timeline together with playing back the analyzed 
video.
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Consumption Behavior Statistics

1. Click the Select window button in one of the visualization windows and 
select Consumer Behavior and then Consumption Behavior Statistics. 
The table displays the number of intake events (bites and sips) and chew 
motions. The Current column displays the numbers up to the current 
moment in the analysis. During the analysis, the Total column displays the 
numbers up to the current moment in the analysis. After the analysis, the 
Total column displays the numbers in the entire analysis. 
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Export Consumption Behavior events
Aim

To export the Consumption Behavior events (Intake event, Chewing, Chew motion) 
to a text file, Excel file or The Observer XT format file. 

Prerequisites

 Your FaceReader license includes the Consumption Behavior Module.

 Consumption Behavior analysis is switched on in the Settings.

See Analyze Consumption Behavior

Procedure

1. Choose File > Settings and then click the Data Export tab. 

2. Under Export (Detailed log, ODX, N-Linx and API), select Consumption 
behavior. 
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If you like, you can export the Consumption behavior events together with 
the Consumption behavior statistics (Intake count and Chew motion count) in 
one log file. In that case under Export (Detailed log and API), also select 
Consumption behavior statistics. See Export Consumption Behavior 
statistics.

3. Choose File > Export and select one of the three options. 

See Export the data in FaceReader’s output

4. Choose the folder in which to save your log files and click Select Folder.

5. From the Log type drop-down list select the format of your log files, either 
Excel format or text.

6. Select Save detailed log or Save The Observer XT log if you want to open 
your log files in The Observer XT. Then click OK.

The log files contain three columns (in addition to the columns with the intensities 
of the facial expressions) with the Consumption behavior events (‘Intake event’, 
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‘Chew motion’ and ‘Chewing’) and for each exported sample ‘Yes’ or ‘No’ to indicate 
whether the behavior was active or not. 
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Export Consumption Behavior statistics
Aim

To export the Consumption Behavior statistics (Intake count and Chew motion 
count) to a text file or Excel file. 

Prerequisites

 Your FaceReader license includes the Consumption Behavior Module.

 Consumption Behavior analysis is switched on in the Settings.

See Analyze Consumption Behavior

Procedure

1. Choose File > Settings and then click the Data Export tab. 

2. Under Export (Detailed log and API), select Consumption behavior 
statistics. 

If you like, you can export the Consumption behavior statistics together with 
the Consumption behavior events (Intake event, Chewing and Chew motion) 
in one log file. In that case under Export (Detailed log, ODX, N-Linx and 
API) also select Consumption behavior. See Export Consumption Behavior 
events.
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3. Choose File > Export and select one of the three options. 

See Export the data in FaceReader’s output

4. Choose the folder in which to save your log files and click Select Folder.

5. From the Log type drop-down list select the format of your log files, either 
Excel format or text. Choose Text files if you want to import the log files into 
The Observer XT.

6. Select Save detailed log and click OK.

The log files contain two column (in addition to the columns with the intensities of 
the facial expressions) with the Consumption behavior statistics (‘Intake count’ and 
‘Chew motion count’) with for each analyzed frame the total number of intake/chew 
motion events up until that point in time.
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Consumption behavior data in The Observer XT

Consumption behavior events

If you send FaceReader data to The Observer XT 13 or higher versions using the N-
Linx network communication protocol or export the Consumption behavior events 
as *.odx data and import them into The Observer, they are imported as event log 
data. A new behavioral group (Consumption Behavior) is added to the coding 
scheme.

 Consumption behavior statistics

You can also import the Consumption behavior statistics into The Observer XT, 
either automatically using the N-Linx protocol or manually by importing your 
Detailed log files as external data.
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Video and image formats

Main topics

 Supported video formats

 Other video formats

 Unsupported video formats

 Video length, duration and number of samples

 Supported Image formats
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Supported video formats
FaceReader supports the following video formats:

Container Code Name/Encoder

mpg mpg1 MPEG-1 Part 2

mpg mpg2 MPEG-2

mpg H264 H.264/ MPEG-4

mpg H265 H.265/ MPEG-4

vob (DVD) mpg2 MPEG-2

mp4 mp4v MPEG-4 Video

mov mp4v MPEG-4 Quicktime

avi XVID XviD ISO MPEG-4

avi XVID XviD 1.1.0 Final

avi

avi

DIB (_RGB)

DIV3

BI_RGB Raw Bitmap

DivX 3 Low-Motion

avi DIV5 DivX 5.x/6.x

avi DIVX DivX 4

avi dvsd DVC/DV Video

avi DX50 DivX 6.0.0

avi DX50 DivX 5.x

avi CRAM Microsoft Video 1

avi cvid Cinepak

avi IV32 Indeo 3.x

avi MJPG Motion JPEG

avi MP42 S-MPEG 4 version 2

avi WMV3 WMP v9 (VC-1 Simple/Main)

asf (.wmv) WMV1 WMP v7

asf (.wmv) WMV2 WMP v8
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Notes

 The container is not the same as the file extension. Different containers can 
have the same file extension. 

 If you are not sure what the format of your video files is, you can use a 
program like GSpot to find this out.To download GSpot (free of charge):

http://www.headbands.com/gspot 

Video file extensions in Project wizard 

The following video file extensions can be used in combination with the project 
wizard:

 .mpg

 .mpeg

 .avi

 .wmv

 .mov

 .asf

 .3gp

 .vob

 .mp4

 .mkv

 .flv

asf (.wmv) WMV3 WMP v9 (VC-1 Simple/Main)

asf MP43 S-Mpeg 4 version 3

3gp s263 ITU H.263 video (3GPP)

Container Code Name/Encoder
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Other video formats
For a number of other formats, codecs are included, but these formats have not 
been tested. We can, therefore, not guarantee that they work.

* Not all profiles are supported.

Container Code Name/Encoder

avi DIV1, DIV2, mp41, MPG4, MPG3 Divx (1,2,3)

avi DIV4, DIV6, col1,col0,3ivd DivX 4, 5, 6, 3ivx D4, MPEG-4

avi h261 H.261

avi h262 H.262

avi h263 H.263/H.263i

avi h264, s264, AVC1, DAVC, H264, 
X264, VSSH

avi IV31 Indeo Video 3

avi mp4s, m4s2, fmp4, 3iv2, smp4 MPEG-4 Part 2 (AVP), Xvid

avi SVQ 1 Sorenson 1 (Quicktime)

avi SVQ 3 Sorenson 3 (Quicktime)

avi VP31, VP30, VP3 On2 VP3

avi VP50, VP5, VP51 On2 VP5

avi VP60, VP61, VP62,   VP6F, VP6A On2 VP6 (used by FLV)

flv FSV1 Flash Screen Video

mpg mp2v, mpg2, vcr2,  hdv1, hdv2, 
hdv3,  mx*n, mx*p

MPEG-2 Part 2

mpg mpeg, mp1v, PIM1 MPEG-1 Part 2

rm RV10, RV13, RV20 Real Video 1.0, 1.3, 2.0

wmv wmv1, wmv2 WMV 1/2 (7/8)

wmv wmv3, wvc1, wmva WMV 3/WMV-9/VC-1*
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Unsupported video formats
The following codecs are not included and installing them yourself will not work:

Container Code Name/Encoder

avi IV50, IV51 Indeo 5.x

avi tscc TechSmith Screen Capture

avi IV41 Indeo 4.x

avi I263 H.263

avi cvid(_RGB) BI_RGB Raw Bitmap

avi (_RGB) BI_RGB Raw Bitmap (8bit)

mp4 avc1 MPEG-4 AVC

mov 3IV1 3ivx (MPEG-4 based)

mov svq3 Unknown

mov avc1 MPEG-4 AVC
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Video length, duration and number of 
samples
For some video formats, FaceReader may have a slightly different calculation of the 
video length, duration, or number of samples than other video programs, like, for 
example, Windows Media Player. This is the case in the following cases:

The frame information in the video is incorrect – Somehow the information on 
video duration, number of video frames and video frame rate do not agree. If this is 
the case, FaceReader calculates the frame rate from the number of frames and the 
duration of the video file. This may slightly differ from how other programs 
calculate this information. 

The video frame rate varies – If this is the case, FaceReader calculates the average 
frame rate over the entire video. 

If the way FaceReader calculates the video information leads to analysis problems, 
convert the videos with a converter based on FFMPEG. For example, use WinFF. 

http://winff.org/html_new/
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Supported Image formats
The minimum dimensions of your images should be about 640 x 480 pixels (120 x 
120 minimally for the face area, 200 x 200 is recommended). For FaceReader to 
work at a reasonable speed, the maximum dimensions should not be greater than 
about 2000 x 2000 pixels.

FaceReader supports the following image formats:

 JPG

 BMP

 GIF

 TIF

 PNG

Animated GIFs are not supported, FaceReader uses the first frame of the animated 
GIF.

Image file extensions in Project Wizard 

The following image file formats can be used in combination with the project 
wizard:

 .bmp

 .jpg

 .jpeg

 .jpe

 .jfif

 .png

 .gif

 .tiff

 .tif
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Keyboard shortcuts
Keyboard shortcuts allow you to activate the functions in FaceReader that are on the 
menu. With keyboard shortcuts you can use FaceReader without taking your hands 
off the keyboard. Using keyboard shortcuts can help in the prevention of repetitive 
strain injury.

General

Participant menu

Ctrl+O Open Project

Ctrl+Q Close Project

Ctrl+S Save Project

Ctrl+Shift+S Save Project As

Alt+F4 Exit

Ctrl+Shift+P Add Participant

Ctrl+Shift+V Add video analysis

Ctrl+Shift+C Add camera analysis

Ctrl+Shift+I Add image analysis
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Technical support

FaceReader Help

To open FaceReader Help, press F1 or choose Help > Help. There is also a shortcut 
to FaceReader Help on the desktop and in the Start menu of the computer with 
FaceReader. Use the Search function to find information on the topic you are 
looking for.

Help menu

FaceReader's Help menu contains the following options:

 Help – Opens the FaceReader Help. 

 Noldus Online 
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- FaceReader Home Page — Links to the FaceReader section on the 
Noldus website.

- Check for Updates — Brings you to the MyNoldus section on the Noldus 
website. Create a new account or log into your existing account. Under 
Downloads click on Software and documentation and check whether 
there are updates available.

- Contact Help Desk — Brings you to the MyNoldus section on the Noldus 
website. Create a new account or log into your existing account. Under Get 
support you will find the contact details of the help desk in your region, 
you can view the status of your current support cases or submit a new 
support case.

- Customer Support Center — Brings you to the MyNoldus section on the 
Noldus website. Create a new account or log into your existing account. On 
your MyNoldus page you can find the licenses and NoldusCare contracts 
associated with your account, you can download the latest version of the 
software, manuals and sample projects, contact Support or request a Sales 
visit.

- Report an Issue — You are forwarded to an online form where you can 
report your issue. Noldus Support will contact you after they received the 
form.

 FaceReader Online — This is a link to the FaceReader Online section on the 
Noldus website.

 FaceReader SDK — This brings you to the FaceReader SDK portal. You can 
fill out an SDK (software development kit) request form.

 License

- Deactivate — This option is available if you activated FaceReader with a 
software license key. See Deactivate your FaceReader license for the 
procedure to follow.

- Upgrade — Clicking this option opens the Upgrade Key dialog box. The 
dialog box contains your license number. It opens automatically when you 
start FaceReader for the first time after installation and FaceReader detects 
that you have a hardware key for an earlier version. See Upgrade the 
license.

 About – Choose this option to see details of exactly which version of 
FaceReader you are using, the serial number of your software and what 
modules have been enabled.
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Help desk

If you have any problems, questions, remarks or comments, please let us 
know. From the Help menu select Noldus Online and then Contact Help 
Desk or browse to https://my.noldus.com. This brings you to the MyNoldus 
section on the Noldus website. Create a new account or log into your 
existing account. Under Get support you will find the contact details of the 
help desk in your region, you can view the status of your current support 
cases or submit a new support case.

We offer 24 hour support via several help desks in different time zones. 

Check the FaceReader Online Help before contacting our support department. 
Press F1 to open it, then use the search function to find the topic you are having 
problems with.

Before you contact Technical Support, please have the version number and license 
number of your copy of FaceReader available. To find these numbers, choose Help 
> About.

In order to provide adequate support, it is possible that we request you to supply us 
with video recordings made by your organization. Since May 25th 2018 the new 
GDPR rules apply to all people in the EEA (EU + Norway, Iceland and Liechtenstein). 
For this reason we need your signed consent that you agree with the fact that you 
have given us permission to use these video recordings. Please be aware that the 
persons who are recognizable in the videos also have to give consent that the 
videos are sent to Noldus Information Technology BV and our technology partners, 
and that it is your responsibility to arrange this consent. More information 
regarding our Privacy policy can be found at: 

https://www.noldus.com/legal/privacy-policy

NoldusCare

Your FaceReader license includes one year NoldusCare. NoldusCare extends the 
standard service you are entitled to and provides peace of mind at reasonable cost. 
Please look on our web site for more information. We also recommend a training 
upon installation of FaceReader.

noldus.com/nolduscare


